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Introduction

Trnseport and the Trnseport Suite of Software

Trnseport is the American Association of State Highway and Transportation Officials
(AASHTO) information system for managing transportation programs. Info Tech, Inc.,
developed Trnseport in 1982 to help state highway agencies and attorneys general with highway
construction bid collusion and anti-trust investigative efforts. Since then, InfoTech has added
significant additional capabilities to provide operational and management information support
for State Departments of Transportation and other construction contract activities. Activities
include management-level decision support; project cost estimate and proposal preparation, bid
letting and award management, and construction contract management. In October 1985,
AASHTO purchased Trnseport for licensing to all member agencies to share in the continued
development and use of Trnseport software.

There are presently nine Trnseport software modules. Florida DOT is using six of these
modules. Their relationships to each other are shown in Figure 1 on the next page. The ones in
use by the Department are:

Trnseport BAMS/DSS (Decision Support System) provides a complete historical database of
construction contract information, a set of analysis models, and the capability for ad hoc query
and analysis. Using the SAS system’s integrated graphics and statistical presentation capability,
the BAMS/DSS module provides a fully integrated management decision support system for
highway agencies. The Trnseport BAMS/DSS applications include executive information
requests, summary reports for management, bid management and monitoring analyses, market
analyses and cost indices, project planning, project cost estimation, and legislative presentation.

Trnseport CES (Cost Estimation System) provides Department estimators the means by which
to produce various types of Job estimates such as parametric, cost-based, and bid-based
estimates. Predefined and ad hoc formulas can be incorporated in the estimating process, and
users can assign funding and program information to CES Jobs. The Trnseport CES module can
work in combination with the BAMS/DSS module to produce accurate, historically based
estimates. It can also work in conjunction with the PES module, sending and receiving project
and proposal data that aids in the production of Job estimates.

Trnseport PES (Proposal and Estimates System) provides Department design, contract
administration, and estimating staff with a computerized tool to help with project definitions,
funding specifications, project cost estimation, contract proposal creation, and bid letting
packaging. The detail cost estimate for the Plans, Specifications and Estimate (P S & E) package
and bidding proposal are two key outputs of the PES module. Integrating the PES and
BAMS/DSS modules provides automated estimation capabilities with sophisticated statistical
analyses of historical bid information.
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Trnseport LAS (Letting and Award System) provides bid letting personnel with automated tools
to manage the plan and proposal holders lists, bid data entry, bid tabulation and low-bid analysis,
and contract award processing. Besides processing the letting activity, one of the key functions
performed by the LAS module is vendor file management, including vendor qualification,
affiliation, and Disadvantaged Business Enterprise/\WWomen’s Business Enterprise (DBE/WBE)
information.

Trnseport Expedite (Electronic Bidding System) is designed to work with the PES and LAS
modules to streamline the bidding process. The Department uses information form PES to create
and distribute electronic proposal or amendment files to prospective bidders. The bidders then
input and submit their item bids in a secure, machine-readable format. The Department checks
the electronic bids for validity and data errors and then produces a file suitable for loading into
LAS.

Bid Express is used in conjunction with Trnseport Expedite. Expedite software is used in bid
preparation. Expedite is used to electronically prepare and check bids; then submit them over the
Internet using Expedite to connect to Bid Express. Bid Express is a storage site that holds the
bids until the bid date, when it is transferred to the Department.

Trnseport SiteManager is a comprehensive construction management system that encompasses
the complete construction management process, from contract award through finalization.
SiteManager accommodates all levels of construction personnel supporting activities such as
construction administration, field record keeping, contract record maintenance, contractor
payment processing, materials management, and civil rights monitoring.

~__”| PES »| LAS > DSS
) gy '| SiteMgr 4’[
Project Bid Letting _ Bidding
Development Bid Analysis | Construction Patterns
Award Subcontractors Vendor Activity
. Payments i
Bid Express y Pricing
Behavior
Electronic i
Bid Transfer Bid History
Contract
- History
r— Expedite
CES
Electronic Bid
Engineers Estimate Preparation
< A 4
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Software Relationships

Trnseport software can be tailored to the Department’s needs. To efficiently install and support
the software in varied environments, Trnseport has modular design concepts and programming
tools that operate with the least amount of modification.

Trnseport manages data through a series of header records that link to one another. There are
three controlling entities in the PES and LAS modules of Trnseport. These are headers called
Project, Proposal, and Letting. Figure 2 illustrates that a Letting Header may have one or more
Proposal Headers attached to it, and a Proposal Header may have one or more Project Headers,
as well as addenda, attached. The figure also shows that within a project, categories are the first
order detail to a project, and Items are subordinate to categories. Keep these relationships in

mind when using PES.

Letting-01

l

Proposal-A

Proposal-B, etc.

Project 01

A 4

Project 02, etc.

A\ 4

Addendum 01-01, etc.

Category A

Pay Items

v

Category B, etc.

Pay Items

Figure 2
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Common Windows Terms and Navigation Methods

pro Trns-port PES

File Edit Wiew LUkilities ‘\Window Help < Menu Bar
[1=BaE | B | Y8 | « ~omme § «—  TolBa
sk Projeees Project List Window
 Project Number
12345615201 M BROVARD COUNTY == TEMPLATE =
13901 0000ut DITCHES DITCHCLEA
19061445201 MiA TOLLPLAZA  Minimize and
19061455201 MNiA, REPLACE 5 Maximize Window
19061485201 M SAINGRASS
18070814301 i SURPLUS PROPERTY
18070815202 M, SURPLUS PROPERTY Click X to close
18073515201 M, MIRCOVAYE SYSTEM the Window
18073715201 i ROOF REPLACEMENT!
18073815211 iy DRAINAGE IMPROVEMENT
18073815214 . DRAINAGE IMPROVEMENT
18073815215 iy A DRAINAGE IMPROVEMENT
18073815216 i o DRAINAGE IMPROVEMENT o
1ENTAR AT i DRAINAGE IMPROVEMENT
ooy e e e s
. A b0 alder ange
R . Tabbed Folder View ADA MODIFICA _
19075515203 R DA MoDIFICs  Menu from Right
19075815205 (417 Categary Lis PERIGDIC STF Click
18075815206 i PERIODIC STF.. ...
19076015202 . SAFETY IMPROVEMENTS
19076015205 na | SAFETY IMPROVEMENTS
19077315202 nn | SIGNING IMPROVEMENTS
19077315203 i A e e ke o SIGNING IMPROVEMENTS
18077315205 MIA T — SIGNING IMPROVEMENTS
18077415202 i PERIODIC MAINT
I« | v
|Fieady

Menu Bar — the Menu Bar contains a list of options. For example, Click File and the list of
options include Save, Save As, Print, Open, Close, etc.

Tool Bar - the Tool Bar contains buttons that invoke tools that are specific to the window that is
currently active.

This button will produce the Project List Window. B
This button will produce the Proposal List Window. E
This button will produce the Lettings List Window. £
This button will produce the Vendor List Window. %

Select (from a menu, tool bar, or list window), means to move the cursor to the option to be
highlighted and click the left mouse button once. If the option has an arrow to the right of it,
another selection menu will automatically appear. Click the choice.

In this manual, notations such as File > Reference Tables > Item List indicate the order of
selections from the Menu Bar or the Right Mouse Button Menu.

Click Refers to clicking once with the left mouse button.

Rclick (right click) - Refers to clicking once with the right mouse button. The action will open
a menu.
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DbIClick (double click) - Refers to clicking twice in quick succession with the left mouse
button.

Close (the X in the upper right hand corner of a window) — To close a window, click the X that is
in the upper right hand corner of the window. If you have been editing what is in the window,
you will usually be prompted to either save or close without saving. Choose appropriately. If
you choose not to save, all of the changes will be lost.

Minimize (the minus sign in the upper right hand corner of the window) — When this button is
clicked, the window will be minimized and deactivated. It will appear at the bottom of the
screen. Re-activate the window by clicking on the minimized icon on the bottom of the screen.

Maximize (the button with a square in it on the upper right hand corner of the window) - This
button also minimizes and maximizes, but it does not de-activate the window, it merely changes
the size of the window.

Check Box — A box that represents a Boolean value (on or off, yes or no). If an X or a check is
in the box, then the value is On or Yes. If there is nothing in the box the value is Off or No.

List Box — A drop down box that presents the valid values for a field. The choices presented
usually are from a code table stored within the system. Click an arrow to view the list of
choices, and choose a value from the list.

Common Trnseport Terms and Definitions

Batch - A term that refers to a process being submitted and executed in the background without
intervention by the user. Reports are an example of processes that execute in batch mode. This
also means that a process goes into a queue along with other processes and therefore may have to
wait its turn to run so the results may not be immediately available.

Bidder - A vendor who bids on a proposal

Category — A grouping of items on a project. For maintenance projects, these would be the task
activity numbers.

Contractor - Any entity that does business with the Department. This is synonymous with the
term vendor.

Control Group — The assigning of control groups controls who can see which projects and
proposals in PES and LAS. A control group can be assigned three places. These are users,
projects, and proposals. Please see Appendix B to this manual.

Drill-Down Menus - This term refers to menus that appear when a right click is done on a
selected record. As the term implies, every time a right click and select is done, a lower level
menu or screen appears.

Estimate - A cost estimate for a project. PES can produce three different ones. They are the
Preliminary Detailed Estimate, the Proposal Estimate, and the Final Detailed Estimate.

Filter - A function provided in Trnseport to help limit the list of records appearing on the
screen.

Generic Fields - In Trnseport this refers to fields that are not used within the core Trnseport
software for any processing, but which are available for the user to enter data into and then use in
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reporting. Should the user wish to customize the Trnseport software, these fields would be
available to them.

Item - The smallest unit of work on a project. It is the same as the Department’s term Pay Item.

Item List (item Reference Table) — This is synonymous with the Department's Master Pay item
List or File and contains all of the items that are open for use in each item year.

PES Worksheet — This is a screen provided in spreadsheet format that allows for the entry and
maintenance of items for a project.

Planholder — This is a vendor that has received a proposal package. The planholder can be valid
for bidding or not.

Procedurally Required Fields — These fields are deemed very important by the Department and
therefore should be entered even though the system will not force them to be entered. An
example of this is the Control Group field (this field controls who is allowed to view the record
in question).

Project - This is synonymous with the Department’s financial project.
Proposal - A grouping of one or more projects that is advertised for contract.

Site — A proposal site is an entity which can represent different locations or portions of a project
to which time can be assigned. There must be a site 00 record for each project. This will contain
the time allowed for the entire project.

System Required Fields — These are fields that are required by the Trnseport software. They
must always be entered.

Tabbed Folders -This refers to a screen where associated records that belong to a key record are
presented in a folder like form. A tabbed folder screen looks much like a filing cabinet with
different file folders. Each tab presents records in a spreadsheet form. Many of the same types
of records may be edited at the same time. All associated records are saved when the tabbed
folder screen is closed. For example, the tabbed folder for a project has a tab for general project
information, a tab for categories belonging to that project, a tab for funding for the project, etc.

See Appendix A for a more complete listing of a glossary of terms used in Trnseport.

Document Availability.
This and other Trnseport documents are available at the following URL.:

http://www.dot.state.fl.us/construction/trnsport/Maint%20Sm%20Users/trng manual/
Main%20Menu.pdf

Or you may access them from the Trnseport web site.
e Click User Guides.

. PES, CES, LAS, SiteManager User Guides
e Click Trnseport Document Menu. Trnsport Document Menu (in poF Format, get the newest POF
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Getting Started

Logon to Citrix MetaFrame

Trnseport is supported through the Citrix Secure Gateway. The applications execute on a Citrix
MetaFrame server.

Access to the Citrix MetaFrame server is via the Internet when away from the Department, or the
Intranet when accessing it from within the Department. Either way, access will then be through
the Citrix MetaFrame XP Website.

Prior to attempting a log in, the Application Security Coordinator will have assigned a UserlD
and password for access to the proper Citrix MetaFrame Group.

From your browser, enter:

https://fdotnfuse.dot.state.fl.us/Citrix/MetaframeXP/default/login.asp?ClientDetection=0n.

The Citrix Login screen will _||g|_|
Open Qe - ) - %] 7] 70 ‘ ) search "¢ Favorites {‘f| o= - 3
For quick access to Citrix, Web Intorface for CiTRIX” -
create a shortcut for the MetaFrame' Presentation Server H
desktop. From the Login —— @ Melcorme
Screen, Please log in
B I To log in to MetfaFrame Preaenta_tmn Server, enter the
° RCI iCk tO Open the Passwor rd: | credentials required, and then click Ln.g In.
Mouse Button Menu. pomen Coneact yaor hal dosk at Systam scmimetietar.

M Message Center

e Click Create Shortcut ———— —
as seen below. hewor versions of the Ciix saftware. Although the

layout is different, the page will continue to function as
before.

3 | Your session with the Web server has expired,
“<¢’ vou have been logged out,

Back.
Farward

Save Backaround &s...
Sk a5 Backgraund
Copy Backgraund

Set as Deskbop Ikem, ..

a

2] Dene [T [ [& 83 tocal intranet

Microsoft Internet Explorer : ﬂ ThlS message bOX

Select Al & shartcut to the current page will be placed on vour deskkop. W| I I appear

Paste

Caneel

Creake Shorbout

Add to Favarites.., .

Wigw Source

Encoding 3

Prink

Refresh e Click ok, and this icon will be on
Properties the deSktop.
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At the Login screen,

e Enter UserlD,

e Password, and

e Domain.

Login (7).
Usermame: Iaprojmgr
Password: I,.“““
Domain: Icol

Remember that passwords expire every 65 days.

The first time you log in, and as Citrix software is upgraded, you will receive a prompt to install
Citrix software. Respond yes and follow the installation prompts.

Logon to Trnseport

At the Citrix Application
Portal, see the Trnseport
Applications available.

The screen at right shows the
applications available to a
typical user.

To gain access to other
Trnseport applications, see the
Application Security
Coordinator

Set up Citrix Printers

e Click the Printer
Configuration Icon to
set up the regular
printers to work with
Citrix MetaFrame.

53

Printer
Configuration

e Click each printer

A Metalrame Presentation Server - Microsolt Internet Explorer

Fle E Vew Favores Toos  Hep i
Qe - ) - 6] (2] (| seweh Jprmntes ) | ( = B 3
Aoddress, [ 5] retps: [Vobriuse ot stabe 1.1 CRres MetaFeome et ot ed st s

Web Interface for
MetaFrame® Presentation Server

Applications

E‘i & m ) Welcome

Aom MetaFrame Presentation Server Applications
‘Welcome to your personalized view of MetaFrame Presentation Server applications.
ey bax Far the ap 3t y Click an
L4 & "
Expedits Accessiblity  CES yo
Options ease contact your help desk
R T #
el Message Center
LAS Mouse PES
Propertias
a Attention: This web site has been upgraded to the newer versions of the Citiix
software, Altheugh the layout is diffarent, the page will continus 1o function as betora.
rinter SitoManager  Sitenanager
onfigurat Help

Log off

#% c0-kn971wc - ICA Client Printer Configuration

Printer Wew Help

Bl x| 2]z =]

Type Port Skakus |

b HP Laserdet 4 LPT1: Connected
@Client'l,co—kng. .. HP LaserJet 5000 Series PS Burns_35W1674  Disconnected
@Client'l,co—kng. .. HP Color LaserJet 3500 PS5 Burns_35W167E Disconnected
@Client'l,co—kng. .. HP Color LaserJet 4500 LPT1: Disconnected
@Client'l,co—kng. .. HP Color LaserJet 4500 Burns_35W'1674  Disconnected
@CIient‘l,co—an. .. HP Color LaserJet 4500 Burns_35W167E Disconnected

needed, so that the status shows as "connected".
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Logon to PES

The Security Coordinator will have established the system access and security authority. From
time to time, for training or other testing events, you may be granted access to the test
environment. At those times, the Trnseport Coordinator or the Office of Information Systems
(OIS) staff will control the security and access. In general, you will only have access to the

production environment.

e Click the PES Icon to open PES.

The screen at left will
appear.

Enter User Information

User ID: ||

Password: I

OK I Cancel

BOSHTO Trns port, the A03HTO Trns-port logo, PES,
and the PES logo are registered trademarks of the
Brierican bzzociation of State Highway and
Transportation Officials.

Fortions Copoyright & 1937-2004 805HTO,
Portion= Copyright © 1334-2004 Irfo Tech, Inc.

Help |

PES

Enter User ID.

Tab to and enter
the Password.

Click ok, as
seen at right.

Enter User Information

User ID: IAPROJIH'IGR

Password: I******|

OK I Cancel

BOSHTO Trns port, the A03HTO Trns-port logo, PES,
and the PES logo are registered trademarks of the
Brierican bzzociation of State Highway and
Transportation Officials.

Fortions Copoyright & 1937-2004 805HTO,
Portion= Copyright © 1334-2004 Irfo Tech, Inc.

Help |

A blank Trnseport PES screen will appear. To
access the Project List window,

e Click the Project button. =

iz Trns-port PES
File Edit Yew Utlites ‘Window Help

[1eras

To access the Proposal List window,

e Click the Proposal button. E

Field Help

As you enter data, and have questions
about a particular field, the field help may
be very useful. To access the field help in
Trnseport PES,

Project 19288917203

Ganeral |c:wrmas| Categories | Funding | Payadiust | Breskaowns | Warksheet | Atiachments

| pagul " pagel

e Rclick in the field of interest to see
the Mouse Button Menu.

e Click Field Help.

Froposal ID: E¥F33-RU
P ltem Year: [0

Project Number: 19288017203
A Prolectie[
Fedistals Froject bo- s
Dirscriglion [ IGHTING MANTENANCE

[ROUTINE WAINTEMANCE CONTRACTS
Locationc|MP 117 T 200
Or Unit SysterncE CESJobNumber
e Press the H key on the keyboard to o oot e —
R . . R Baginaing mnm_mW Dismee[iE W
display field information. o 1
Ending Station [ Plolzclﬂpa:ll—m
eastol tnan L O
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i Field Help

Field Label: Proj. Work Type
Field Name: pwrktyp Length: 4
Default Value: Hone

An information screen similar to the one e e

seen here will appear Verifications:
PP ' {@CODE(PWRKTYP) AND @NONBLANK |

Description:

Used in the Generate Bid-Based Prices process and printed on some reports. ;l
‘Walues entered here must be in the PVWRKTYP code table to be legal. Each

. agency is free to specify the codes that are meaningful to it. This field is used by
Chan ging passwo rds the BAMS/DSS Price Estimation Methods (BRPEMETH) model. <

When accessing PES the first time, change
the temporary password assigned by the

Security Coordinator. e Trns- port PES
Ele Edit Yiew | Utiities Window Help

To change the password, 1B o :

Generake Support Request, .,

e Click Utilities > Change Password from PR
the MenU Bal' Download File

Upload File

The Change Password window will appear. Cop 2 Hitery Pl

Syskem Management

e Enter the User Id.

e Enter the current password in the Old
Password field.

e Tab to the New Password field and type a
o password. User ID: IKNQHWC

It must be at least 6 characters and no more than 13. old P B rever
] asswurd.l
Use a mixture of letters and numbers.
New Password: I"""’"‘

e Tab to the Re-enter Password field and Re-onter Password: [
retype the new password.
e Click ok to save this password. ok | cancel | hew |

Change passwords in accordance with Department policy.

Data Security

To protect the integrity of Trnseport data, take general precautions to safeguard data both from
unauthorized access, as well as accidental loss.

PES does not have a time-out feature, whereby the software and hence access to the data are
automatically locked. When leaving the PC for an extended period do a normal close of all open
windows and close PES. In this way, unauthorized access is not possible.

Data protection during a power outage is also a concern. When using tabbed folder windows in
PES, there is a risk of having a project or proposal become “locked” if there is a power loss. In
this situation, the database retains information to the effect that you had a project open, and will
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continue to deny access to users who may need to make changes to the project or proposal. To
safe guard against this, avoid keeping multiple tabbed folders open for extended periods.

A Windows General Protection Fault (GPF) error will result in the same effect on folders as a
power loss. Any opened tabbed folders will remain locked until those folders are reopened on
the same PC that was involved in the GPF incident or the power loss.

Security

In PES, each UserID is assigned one or more roles that have a set of functions (called security
tokens) assigned to them. These roles are assigned users by District or Central Office Security
Administrators and control what the user may do in the system. In addition, each user is
assigned a control group that controls which projects and proposals the user is allowed to see.
Each project and proposal in the system is also assigned a control group so the user will be
presented only with projects or proposal that “match” his personal control group. A project can
be “passed” from one user to another by changing the control group.

Example Control Groups

Type of User Control Group

District Estimator ?D03* ? is a positional wildcard.

Production Designer CDO0O3R312 * is a wildcard for all remaining positions.
Maintenance Designer MDO03 Y302

Consultant CD??T123

District Contracts Administration Office ?7L03*

Project Control Group Users who can see Project

A CDO03 District Estimator

B CD03z123 District Estimator, Consultant

C CDO3R312 District Estimator, Prod Designer

D CLO3 District Contracts

E MDO03 District Estimator, Maintenance Proj Mgr
F MLO3 District Contracts

G MDO03Y302 District Estimator, Maintenance Designer

Confidentiality

In PES, the estimated price for an item appears on the same screens as the item number and its
quantity. This results in some conflicts over the issue of confidentiality. Whoever can see the
project can also see the estimate. There is currently no way to separate the estimated prices from
the items and quantities. If the prices need to be kept confidential, then the control group that is
assigned to that proposal and project must remain in the Estimators control group. If the
estimated prices are not confidential at the time, the control group can be set to the Designers
control group.
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The proposal and project can be passed back and forth as necessary until the prices do become

confidential.

Once the proposal has been advertised the Control Group on the project MUST be left as the
Contract Administrators control group unless an addendum needs to be processed. Otherwise, an
Estimator could change the proposal and project detail and the change would not be reflected in
LAS. Any changes that need to be made after advertisement must be made through the

Addendum process.

It will be up to each District Office to establish procedures with regard to who has what control
groups and when the projects and proposals need to be passed back and forth.

Code and Reference Tables

Code tables and reference tables exist to provide valid values for information stored about
projects and proposals. A code table generally consists of only two elements, a code value, and a
code description. Reference tables include more information than just the code value and the
description. When a code table supports a field on a record, a list box will appear on the screen
that allows the user to choose from the list of valid values. List boxes may be accessed by
Clicking on the down arrow like this one, ll or like this one. |

To see the code tables and reference tables in Trnseport, from the Menu Bar

e Click File > Reference Tables as seen at
right.

The next window shows a choice of Code Table
Lists and several reference tables.

The Trnseport Coordinator or OIS will maintain
code and reference tables, except for the Item List.
Users can view all of the Code Tables and the item
List.

To see the Item List reference table in Trnseport,
from the Menu Bar

e Click File > Reference Tables > Item List.

The selection Item List is an example of a reference
table. This table is synonymous with the Master Pay
Item List. It contains all of the valid items for each
item year (Pay ltem Year).

Authorized persons in the Central Estimates Office
and Central Maintenance Office maintain this Item
List table.

pre Trns-port PES

File Edit Yiew Utlites ‘wWindow Help
Open Bid Letting Lisk
Open Proposal List
Crpen Prime Project Lisk
Cpen Project Lisk
Close

District Office List
Fund List
Ikem List
Material Lisk
wendor List
Import 3 Code Table List
Price Index List
Special Provisions List

Bun Process...
Process Status
Print Setup. ..

Expork

Exit

pre Trns:port PES
File Edit Wiew Ublities ‘window Help

Open Bid Letting List
Open Propaosal List
Open Prime Project List
Open Project List
Glase

Diskrict OFfice List

Run Process...
Process Status
Prink Setup...

M List
‘endor List

Import »  Code Table List
Export Price Index Lisk
Special Provisions List

Exit
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The Item List Reference Table

File Edt Wiew Utiities window Help

iwBas & | e | t|oaEe

To view details of a particular item,
PES
[ ] DbICI |Ck the Item . 00 050 2300 DESIGN f BUILD (RDWY){PAVING) Ls 1 10
oo 0560 2400 DESIGM [ BUILD (RDWY)(DRAINAGE) LS 1 10
. oo 0460 2500 DESIGM [ BUILD (RDWY)(SIGHEPAY MARKING) LS 1 10
Each item has a |0ng and a Short 00 050 2600 DESIGHN { BUILD RDWYITRAF OFS) s | 10
0o 0 A0 2660 DESIGN/BUILD (RDWY)ITS) LS 1 10
H H H H 0o 050 3 DESIGN/BUILD (ROADWAY RECONSTRUCTION) LS 1 10
description. The long description canbe |5 5. DEEion Bt D et ety o L
- 0o 050 41 DESIGN/BUILD (BRIDGEMMOBILIZATION) LS 1 10
up to 60 Characters and WI II appear On aII 0o 050 4100 DESIGN/BUILD (BRIDGEMFOUNDATION) LS 1 10
. 0o 050 4200 DESIGN/BUILD (BRIDGEMSUBR STRUCT) LS 1 10
reports un'ess the reports are OtherW|Se 00 050 4200 DESIGM / BUILD (BRIDGE)SUP STRUCT) Ls 1 10
oo 0450 4400 DESIGH fBUILD (BRIDGENBARRIER) LS 1 10
Y M M . oo 0450 4500 DESIGHN/BUILD (BRIDGE) REM EXIST STRUCT LS 1 10
modified. The short description is a ® ume - L
- - oo 0an g DESIGN S BUILD (TRAFFIC OPERATIONS) LS 1 10
maximum Of 40 Characters and WI” 0o oion 7o OVERLAY DEMONSTRATION L5 1 0
0o 010 MOBILIZATION ) 1 ]
1 oo 0102 1 MAINTENAMNCE OF TRAFFIC LS DA 1 03
appear on any Screen that ShOWS Item oo 0102 21 SPECIAL DETOUR (DETOUR 1) Ls 1 03
. . 00 0102 2 2 SPECIAL DETOUR (DETOUR 2 LS q 03
description.

An item can be marked as obsolete by
checking the Obsolete Item box. Note

Ele Edit Wiew Utlties Window Help

that there is a field called "Item Obsolete |[1=Bas | ® | ¢

as of", but it is not actively linked to
project records. If an item has been added T A Spec vear 09
to a project prior to becoming obsolete L AT SR
and the project is still active and requires Unts o easure R TR
a change, when the Obsolete Item Flag is Cammon Uit Messur: combine Lia ams:
set, the item will kick out as an error Cn‘mcomlrtmn:gu:l i’:m Emp”Homufllr‘;rgm Dv':m
when project changes are saved. e e e o -
DBE Apply Interest:[T00.00 Supp. Des. Required; [
The Combine with Like Items Check Box e o MDD SpecTwo
contains the default value that the item
will have in this field when it is added to a

project.

The Item Class Function field contains a code that categorizes the item into various groupings
such as utilities, landscape, etc. This field is very useful in narrowing down the list of items to
be viewed by use of a filter.

The Trnseport Filter

A filter provides the user with a means to limit the list of records appearing in a window. The
Filter Function is available on most PES screens. It is especially helpful in limiting the item List.
Use the filter to enter selection criteria on one or more fields applicable to the active window.
For example, you may only want to see items in a particular Pay Item Year, or you may want to
see Projects with a certain Control Group. The fields that are available to include in the selection
criteria will depend on the active window.

PES and LAS are set up to support both upper and lower case characters. Fields that are
populated from the Department mainframe will be in uppercase because the mainframe stores
everything in uppercase. For instance, the Item Description is in uppercase, so when filtering on
the Short Description field, look for all uppercase characters. All code values are stored in
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uppercase. When filtering on a code-based field, search for uppercase letters. Other fields, such
as the second line of the Location field on the Project Header record, can have both upper and
lower case letters in them. Be aware of the case of a field when performing a filter.

To set up a filter from the Tool Bar,

s Filter
H H Where
e Click the Filter button. ™ - Sperator valne
The list box labeled Column will list | g corisine =] Joso

all of the fields that are available for oK cancel | Advanced.. | showan |
the search. The Operator list box
contains the relationships that are available between the field that chosen in the Column list box
and the entry in the Value box. The Value contains a literal that is being compared to the field in
the Column box. In the example above, a simple filter on the field Item Number is looking for
items that contain the string 0430.

For more complex filters, such as ones on multiple fields,
e Click the Advanced button.

The Advanced Filter feature allows filtering on more than one field and allows you to save the
filter so that it can be used repeatedly.

The Name field contains the name of the filter and allows you to choose from a list of previously
saved filters.

The Column, Operator, and Value fields operate the same as they did in the simple filter. The (+,
)-, and And/Or columns allow parenthesis to create complex logic.

To add the first row:
e Choose values for the Column, Operator, and Value fields at the top of the screen.
e Click the Accept button.
To add another row,
e Click the Add Row button,
e Click the row just added.
e Enter values in the Column, Operator, and Values fields.

e Click the Accept button.
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In this example the filter is designed to show drainage items (Item Class 06) that will become

obsolete after December 01, 2003.

Add parenthesis as needed and
choose either And or Or as
appropriate.

To save the filter,

e Enter a name in the Name
field.
e Click the Save button.

The filter will be available for future
use.

To apply the filter now,

Click the Apply button.

prs: Advanced Filter

Name: [obs »120103 fis06

=

Insert Row I

—Build Where Condition
Column: Operator: Value:
ltermn Class j |= j QIDE Accept |
—Select Where
1 Colurmn B anas
(- Name Operator Valueis) )- Or
Generic Date #2 = 12001103 AMND

Add Row |

Delete Row |

appty | [ save | Delete |

Close | Help |

Code Tables

The Maintenance Activity Number field i
an example. It is supported by the
CWRKCLS code table.

To view the CWRKCLS code table, from
the Menu Bar

Click File > Reference Tables >
Code Table List.

The Code Table List window showing all
code tables for PES/LAS will open.

To see the codes for a particular code
table,

e Click the table of interest then
with the cursor on the blue band,

¢ Rclick to open the Mouse Button
Menu.

e Click Code Table Entries.

e Trns-port PES
File Edit Yiew Utilities Window Help

S

Open Bid Letking Lisk
Cpen Proposal List
open Prime Projeck List
Open Project Lisk
Close

Districk COffice List
Fund List
Item List
Material List

Bun Process. ..
Process Stabus

(AR EE D wendor List
Irnport » Co List
Export Price Index List

Special Provisions List

Exit

= Trns-port PES

Fle Edt Wew Ublties Window Help

ipBas | B | v | t| s

s Code Tables

CANCEL Reason far Cancelling Proposal
CAREA CAREA
CATEG Category List
CERTTYP Type of Yendor Certification
CHRG Charge or Cash
CHAWDRS Reason far Non-Processing
CNSTAT Contract Status
CNTYRNAM CNTYRNAM
CONTCLS Contracting Classification
CONTTYP Type of Contract
CORPTYP Type of Carparation

County- Congressianal District- City

COUNTY
CWRICLS

Maintenance Activity Mumber
Proposal DBE goals

DBEMNOTE

DBETYFE DBEMVBE code

DEFREA Reason for Default

DISTRIC Districts and Congressional Districts
ECTGPCT Category Adjustment

ERRMEG ERRMEG

EVENT Event Type Code

FACHMATL Twne of material for facility

Add
Change
Delete...
Code Table

Code Table Entries

Run Process. ..
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This will show a list of all of the entries

Eile Edit Wew Utiities Window Help

for that code table. The Trnseport [1xeas | & | vi | ¢]2]
Coordinator will maintain reference tables
Codevaue  CodeDescripon
and COde tables' 0e0 ASSET MANAGEMENT (LS)
099 Asset Management (LS)
Note that the code table contains the full 135 ENVIRONMENTAL WORK (M)
) . 1490 SEMINARS AND MEETINGS
set of Maintenance Activity Numbers. 97 ENGINEERING DUTIES (W)
228 PREPARATION FOR CONSTRUCTION
294 TRAVEL
339 WALUE EMGIMNEERING DESIGN
Ly TRAFFIC COMTROL DEVICES CONTROL (MH)
411 ASPHALT REPAIR (MAMNUAL) (TR)
412 ASPHALT REPAIR (MECHAMICAL) (TR}
414 BASE REPAIR (TN}
421 PRESSURE GROUTING (CF)
423 COMCRETE PAVEMENT JOINT REPAIR (LF)
424 COMCRETE SLOPE PAVEMENT JNT REPAIR (LF)
425 COMCRETE PAVEMENT SURFACE REPAIR (5F)
434 MOTOR GRADER OPERATION (Shi)
432 REPAIRING MNOM-PAVED SHLDRS (MANUAL) (5Y)
433 SODDING (5Y)
435 SEEDING, FERTILIZING AND MULCHING (AT)
436 REWORK NONPAVE SHOULDER: (AC)
437 MISC SLOPE AND DITCH REPAIR (CY)

PES Components

Project Header | Proposal Header
Counties
T Long :
Categories Description Spgc!al
Provisions

Funds Sites '

v Addenda
Items

Figure 3

In PES there are two main components - Projects and Proposals. These two objects are referred
to as “root level” objects. They can exist by themselves. All other data in PES, except for code
and reference tables, belongs to either a project or a proposal. Figure 3 shows some of these
relationships.

All work in PES begins with the creation of a project. As illustrated in Figure 2 on page 7, a
project is composed of a Project Header record; one or more Category records and each category
can have one or more items belonging to it. Figure 4 on the next two pages shows a typical
project development life cycle in PES.

There are several ways for a project to be created in PES:
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e A project can be loaded from the FM (Financial Management) system.

e A project header can be entered by hand.

e A project header can be created by copying from another project.

e A project header can be created by importing it from a source outside of PES.

Currently the Department does not have a procedure or standards in place for the loading of
projects from outside sources.

Figure 4

Run the PES Clist or Perform a Copy Special to
Establish the Project Header

Run PES Clist to refresh the Project Header Data (if a Copy
Special was Performed), Enter additional Project Header detail

Create/Update Category Records.

A >

v

Add Items to the appropriate Category, update item
fields, and delete Items as needed.

Y
Update Control Group on Project Header
to transfer control of project to Estimates

l

Load historical unit prices and/ or
update estimated unit prices by hand

A 4
Generate Project Line Numbers

A\ 4
Run a Preliminary Detail Estimate

A
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Create Proposal Record

l

Attach Projects to the Proposal
(string projects)

A 4
Generate Proposal Section
and Line Numbers

|

Generate a Preliminary Detail
Estimate for the Proposal

Generate Proposal Schedule Report;
Including Proposal Estimate

A

v

Generate Bid-based Prices for Proposal and/or
Update estimated prices based on roll-up quantities

A 4
When satisfied with estimated quantities, generate final
Proposal Schedule without Proposal Estimate and pass to

Contract Administration

Create
Addenda as
needed

A\ 4
Change Control Group on Proposal to
enable Contract Administration to access.
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Maintaining Records in PES

There are two methods of maintaining records in Trnseport. These are the tabbed folder method,
and the drill-down method. The long-term plan of AASHTO is that the drill-down method will

be phased out.

The Tabbed Folder Method

A tabbed folder presents many associated
records broken out and grouped under
various Tabs. Each tab represents a
different type of record, but all of the
records in the Folder relate to each other.
For example in the Project Tabbed Folder,
you will see the category records that
belong to that particular project grouped
under the Categories Tab. All of the item
records that belong to those Categories
are found under the Worksheet tab, etc.
Using the Tabbed folder allows you to
view and modify many records at once.

The Drill-Down Method

The second method of maintaining
records in PES is the Drill-Down method.
This method involves selecting one record
at a time and then Rclicking on that
record to “drill down” to the next level.
For example, to get to a particular item on
a Project using the Drill-Down method,
first

e Highlight the Project,

e Rclick to open the Mouse Button
Menu.

e Click Category List,

Ble B Yew (ndes Wik el
i1x=Bas W 13 T

«  Project 19288917203

Ganaral |coumias| Categories | Funding| Pavadiust | Greakdowns | Worksheet | Atischments

* pagud 1 pagn 2

Projuct Niamber 197820817203
A projectie]
FrediBtale Projoct Mo [
DescrgtionLIGHTING MAINTENANCE
[ROUTING MAINTENARCE CONTRACTS

Lacaion: [P 117 10 200
I

Proposal ID: E8F33.R0
Pay Item Yaar FJh

Unil Bystem [F CES Joh Nurriher
Foad Name;
Routel stamsfEn
Road Soction No Ganst Eng Pet 000

Beqinaing Termink 000000000
Ending Termini:000u00 06
Hisginning Skl

 —
Ending Slation

District [o2 Ld

Projecl Grade|
Prooj Witk Typar i
Project Type: |
Contral Group; MLOT

fr= Trns-port PES

File Edt View Utilities Window Help

ixBas | ® | Y8 | + 2e@ES S|
[ProjectNumber  FederalfState Project Number  Deseipon

19288317203 [0

LIGHTING MAINTEMANGE

192885917202 iR LIGHTING MAINTEMANGE
19288517203 TiAy MIAMI-DADE COUNTY
19288817202 A MOWING & LITTER REM
19288817203 A SANGRASS

1926891 [iifs LIGHTING MF 117 TO

Add ENANCE

i o HEREI-
18281017204 NiA Srrgl EEFING
18261217202 Nis CEEEEe |mancE
18261217203 Nis Tabbed Folder Add MANCE
18261417202 Nty Tabbed Folder Changs 5T ZONE1
183 asphalt Ny Tabbed Folder Yiew =+ TEMPLATE =
183 sweeping INiA Profect FHTEMPLATE
18363715201 Ny INING
19363815201 NiA e -
18375026201 Nis =t
18375035201 3451012P Beedrlt
R i Caunty Information List b
REC{ERIETHT o Pay Adjustment Indices List
18361215201 Ny Run Process...
18381415201 3531038F
18382415201 8870604 CHARLOTTE COUNTY
40202042101 " G417 COMARION S
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Highlight a category.

e Rclick to open the Mouse Button
Menu.

e Click Item List

e Highlight the Item of interest.

e Rclick to open the Mouse Button
Menu.

e Click the Item desired.

e Click the Change Button to make
changes

e Click the Close Button when
complete.

frs Trns-port PES

Fle Edit View LUtiiies Window Help

iBaE | I v | ¢t 2é%H|
[Catg At Descrigion hme FedCs

0000 Fi PROJECT FUNDING T
HIG T LIGHTIMN K

Add
Change

Delete...
Catggory
Project

Quantities and Prices

Eun Process...

firs; Trns-port PES

Elle Edit View Utilties Window Help

|1 g | = vi | & 2@

ategory 0787 Project 19288917203

o100 LIGHT POLE FOUNDATION (F&1) 071510 2 100
o105 LIGHT POLE FOUNDATION{REFAIR) 071510 3 0105
o110 LIFL FOUNDATION (STRAIGHTEN EXISTING) 071510 4 a11a
0115 LIGHT POLE FOUNDATION (REMOVE] 071510 8 o115
0120 LUMINAIRE (F&D{ROADWAY COBRA HEAD) oF1a11111 0120
0125 LUMINAIRE (F&D{ROADWAY HIGH MAST) o71a11112 0128
0130 LUMINAIRE (F &N {UNDERDECK WALL MOUNT, 071511125 0130

0135 LUMINAIRE (F&N(SIGN SIGM MOUNT) 071611137 0135
LUMINAIRE (INSTALL)(R: A HE 071511311

0145 PULL BOX {F &) (ROADSIDE) 07151411 0145 add

0150 PULL BOX (F &) (SURFACE MOUNT) 07151414 0150 Changs
0155 PULL BOX (F&I COVER ONLY) (ROADSIDE) 07151481 0155 BB
0180 PULL BOX (REPAIR)(ROADSIDE-MOULDED) 07151471 0180

0185 SURGE PROTECTOR  (POLE BASE) 071519 1 0185 Breakdawn Ttems
0170 REFRACTER (STANDARD COBRA HEAD) 0715231 0170

0175 REFRACTER (UNDER DECK) 0715232 0175 (L e,
0180 REFRACTER (SIGN) 071623 3 D180

0185 REFRACTER (HIGH MAST) 071623 4 D185

0180 QUICK DISCN PLUG (POLE BASE, HIMAST) 071626 2 0180

0185 MAST ARM  (FURNISH & INSTALL) 071636 1 0185

fx+ Trns:port PES

File Edit View Utiities Window Help
Qs | | i

v tem 0140 Project 19288917203 Category 0787

Page 1 |

Project Iterm Seq Ma.: 0140

Itern Mumber: 0715 11311 jLUM\NAIRE (INSTALLY R OADWAY)ICOBRA H
Estimated Quantity: |6.000 EA
Estimated Price:|20.00000 Supp. Desc. Reguired: [

Suppl. Description

Itern Alternate Code Cambine with Like ltems: B
Specification Year: 00 Mon-Participating Fund Code: [ ﬂ
Revized Price Mon-Bid tem: []
Source of Price; |E Pre-Estahlished Price: []
Estimated Price Lock: [] Proposal Line Mumher: |01 40
Suppl. Proposal Descr, | Generic Code 1

Change | Close
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Creating Projects
Adding projects into Trnseport PES should be thought of as involving two steps. The first is to
create a project header, and the second is to add the project detail.
In general, projects can be brought into Trnseport PES in one of the following ways:
o Create a project header through an interface program.

e Enter a project manually through the Add or Tabbed Folder Add window from the right
mouse button.

e Enter a project manually through the Edit > Add or Edit > Tabbed Folder Add window
from the Menu Bar.

o Copy detail from one project to another.

To create a new project, use the FM Interface to create the project header and then add project
details into the new project, or enter a few fields of data to create a project header and then
complete information from the FM Interface.

Project List window

To view the list of projects, from the frs Trns-port PES
Menu Bar File Edit Wiew Utilties ‘Window Help

Open Bid Letting List
Open Proposal List
Open Prime Project List
Op ck: Lisk

e Click File > Open Project List

Remember that one of the fields on the ot >
project header is the Control Group. FM ET—
populates this field. If you download a S
project that is not a part of the control o
group, you will not be able to see itonthe | _

project list.

Exit

A_notht_ar meth_od of invoking the Project . Trns-port PES
List WIndOW Is to File Edit Wiew Uklities ‘Window Help

e Click the Project button on the 1 xBaS
Tool Bar. o

When the mouse is over a button on the
Tool Bar, an information box will appear
that will identify the button by name.
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These methods also apply to viewing other List Windows in Trnseport. There are four main List
Windows in Trnseport that the Department uses. These are

e Projects
e Proposals
e Lettings

e Vendors

The Department is not using the Prime Project function.

The FM Interface

The FM Interface creates and refreshes Work Program information in Trnseport PES. The
refresh feature of the interface runs every night and updates fields in all projects in PES
possessing valid FinProj Numbers.

To execute the FM Interface on
the mainframe,

e Enter TSO,

e Gettoa READY
prompt

e Type TSM

e Press <Enter>.

At the Trnseport Interface
screen,

e Enter B to either add a
project, or refresh a
project,

e Press <Enter>.

/3 http://has.dot.state.l.us/HostAccess/ENU/ Enterprise /RequestConfig.asp?WebYiew =eS2D¥ANTA 1= %]

File Edit wiew Tools Connec tion Options GoTo  Favori teslHe\p ‘

Back + = - @ 2} | Qusearch [GFavortes c#Hstoy | By- S md 5]

Address [@] tConfig. asp?iebiiew=e 2DV ANTAGE +ACTIVE%EZDHBElementKey=CO+ACTIVEY20nBEmbedded=08User Configuration=2 ¥ | ¥ Go HLims ”‘

I IE T |

KNS71IWC. SPFLOG3.LIST has been kept.
READY
TSM

/3 http://has.dot.state.lus/HostAccess/ENU/Enterprise /RequestConfig.asp?WebYiew=e%2DVAN] =R

| Fie Edit view Toos Connecton Options GoTo Favorites | Help ‘

| 4pak - = - @D [ A | Dsearch GFavortes (HHstary | By S w2

| atdress [£] tConfig. asprivebiew—em Z0VANT AGE +ACTIVE%:2DXBE |amentkey=CO-+ACTIVE%:ZDXEEmbedded=08User Configuration=2 7| {0 HLinbs =

NEWH Sy nelnled @ |

--------------- TRMSFORT INTERFACE TO (FES,LAS,SITEMANAGER,DSS) ---------------
OPTION ===» E

PRODUCTION - IMSA USERID = KN971WC
INTERFACE MENU DATE = 02/06/20
TIME = 15:10
A - SITEMANAGER PAY ESTIMATE (SITEMANAGER )
B - ADD-REFRESH TRNSPORT PROJECTS (PES,LAS)
C - ADD-REFRESH TRNSPORT VENDORS (PES,LAS)
0 - FTP PAY ITEM HISTROICAL PRICES (Ds52

X - EXIT
Z - I0F (wIEW JOBS SUBMITTEDD * ANY QUESTIONS, CALL YOUR DISTRICT TRNSPORT ¥
* COORDIMATCOR OR CENTRAL TRWNSPORT COORDIMATCR *

SELECT OPTIOM AND PRESS 'ENTER' KEY
F1=HELP F2=5PLIT F3=END F4=RETURN F5=RFIND F=RCHANGE
F7=UP FE=D0WH F9=SwaAPp F10=LEFT F11=RIGHT F12=RETRIEVE
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At the Add/Refresh Transport
Projects screen, enter as many
financial projects as needed.

e Enter one FinProj
number per line

e For the first line, enter
A (for SEL)

e Enter 01 (for CARD ID)

e Enter all 11 digits of the
FinProj Number

e Press <Enter>
To add another project
e Enter A (for SEL)
e Enter 02 (for CARD ID)

/3 http:/ /has.dot.state.flus/HostAccess/ENU/Enterprise/RequestConfig.asp?WebView=eto2|

JFiIe Edit  Wiew Tools Connection  Options GoTo  Favorites  Help

| 4pack - = - @ [0 A| Bsearch GiFavorites (Hristory | - S W

JAddrEss I@ tConﬁg‘asD?Web\u'iew=e%ZDVANTAGE+ACTIVE%2DX&E\ementKey=CO+ACTIVE%2DX&Embedded=D&Usercanfiguration=2j ﬁGu HLlnks >

= = W= = e N | ==

COMMAND ===

¥NOTE: MULTIPLE COWNTROL CARDS ALLOWED.
PF4 MAIN MEMLU PF7 PAGE BACK

¥FENTER FIMPROI# AMD PRESS EWTER FOR JOB CARD.

PFE PAGE FORWARD

E - ADD/REFRESH TRNSPORT PROJECTS

=X EXIT

THIS PROGRAM CREATES A FLAT FILE WHICH I5 TRANSFERED TO THE LAN TRANSPORT
APPLICATION SERWER. WHEN JOB COMPLETES, WALT A FEW MINUTES THEM ENTER PES
ON THE PC. YOUR REQUESTED PROJECTS SHOULD THEN EE ADDED OR UPDATED.

***************** TRMSPORT INTERFACES TO (PES,LAS,SITEMANAGER) Row 1 to 3 of 3

SEL= A(ADD) CCCHANGE) D(DELETE) CONTROL CARDS. CARD ID = ANY UNIQUE CHARACTERS

e Enter all 11 digits of the FinProj Number

e Press <Enter>

If you make an error in the length, an error message will be displayed. However, there is no
validation of the accuracy or existence of the FinProj number in the FM system as data is

entered.

When you have completed entering projects,

e Press <Enter> again without entering any data on the row

At the Job Card Information
Screen, you will be prompted
to enter a printer ID, a name,
and phone number. When that
is complete,

e Type SUB on the
command line

e Press <Enter>
A batch job is submitted that
will load the selected projects
into PES. The job name and
number appear on the screen to
the left.

File  Edit Wiew Tools Connection Options GoTo  Favorites  Help

SEL CARD ID FINPROJ#
_ G2 22247115201
01 41053717201
Bottom of data
F1=HELP F2=5PLIT F3=END F4=RETURM
F7=UP FE=DOWN F9=SwaAp F1O=LEFT

F5=RFIND
F11=RIGHT

FE=RCHANGE
F12=RETRIEVE

EBack + = - D A | @search GaFavorites (BHistory | By S

| Address [] tConfig.asprivebiiow=e 2DV ANT AGE HACTIVE:2DBE|ementkey=CO-HACTIVE%2ZDHEEmbedded=08User Configuration=2 7] @ HLinks »

DD s e e @2 =

——————————————————————— JOB CARD IMFORNMATIONCMANDATORYD

ENTER THE FOLLOWING:

USERID KNG 7 LinC
ACCOUNT NUMBER 5565971
PROJECT REQUEST NUMEBER 333444666
ROUTE PRINT LOCATION RMTE

JOB CLASS ==> A
MESSAGE OUTPUT CLASS A

FORMS :

14 > 8 1/2 GREEN BAR STANDARD ===>
===>
===3
===
===
===>

14 % 8 1/2 GREEN BAR Z-PART
14 X 8 1/2 WHITE 3-PART
B 1/2 x 11 WHITE LETTER SIZE
B 1/2 x 11 LASER PRINT (DIST 1,4)
8 1/2 x 11 LASER PRINT (CENT OFC)
NUMBER OF COPIES
LAST MAME ===> CONMOR_

B

01
PHOMNE ===» 414-4138

EXAMPLES:

RO999XX

333444666

DIST3,
2
A

5,7

15,7,8,9
(PRINTD, QCLI)

FOR
FORM TYPE

BIN ===

ENTER SUEB ON COMMAND LINE AND PRESS ENTER KEY TO SUEMIT JOB

F1=HELF
F7=UP

F2=5PLIT
FE=00wN

F3=END
FO=5SWAP

F4=RETURN
F1O=LEFT

F5=RFIND
F11=RIGHT

LTCNT73

FE=RCHANGE
F12=RETRIEVE
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C heck 0 n th e p rog reSS Of the -3 http://has.dot.state.flus/HostAccess/ENU/Enterprise /RequestConfig.asp?WebView=eo2DYANTA =

R . N R File Edit Wiew Tools Connection Options GoTo Favorites  Help ‘
job in IOF. The job output will | wex - = = O 14 2| Qe Garwortes Srsony | 5+ 5wl
- | Address |@ FCofiq asnrWebiisw=r 2DV ANTAGE-+ACTIVE 2D ementk sy=CO-+ACTIVE L ZDRAE mberded=08. ser Canfiguration=2 ¥ {&a “Links »
be put into the IOF queue. =
sUlglinelalles @8 |
——————————————— TRMSPORT IMTERFACE TO (PES,LAS,SITEMA JOB KM9/1WCE SUBMITTED

OPTION ===> IOF
PRODUCTION - IMSA USERID = KNO71WC
. INTERFACE MENU DATE = 02/06/21
In IOF, view the output of the TINE = 07:09
H '3 A - SITEMANAGER PAY ESTIMATE (SITEMANAGER )
JOb to see if it processed B - ADD-REFRESH TRNSPORT PROJECTS (PES,LAS)
. C - ADD-REFRESH TRNSPORT VENDORS (PES,LAS)
SUCCESSfU”y. Determine the D - FTP PAY ITEM HISTROICAL PRICES (DS5)

sequential number of the job.
Then enter that number on the
command line. This shows a e

i i Z - I0F (WIEW JOBS SUBMITTEDD) * ANY QUESTIONS, CALL YOUR DISTRICT TRMWSPORT ¥
IISt Of OUtPUt SeCtlons' * COCRDIMATCR OI,Q CENTRAL TRNSPORT COORDIMATOR *

SELECT OPTIOM AND PRESS 'ENTER' KEY
F1=HELP F2=5PLIT F3=END F4=RETURN F5=RFIND FE=RCHANGE
F7=Up FE=00wN FO=5SWAP F1O=LEFT F11=RIGHT F12=RETRIEVE

R -3 http://has.dot.state.l.us/HostAccess/ENU/Enterprise /RequestConfig.asp?WebView=e%2DYAN] =121 x|
Look for the one that is labeled |/ f e vew 15 comeston opons cato Fovortes ren [+ |
. | 4pak - = - @D [ A | Dsearch GFavortes (HHstary | By S w2
REPORT and seIeCt It by JAddress |@ tCunﬂg‘asp?WEh\l'lEw=e%ZDVANTAGE+ACTIVE%ZDX&E\EmErvtKEy=CO+ACTIVE%ZDX&EmhEdded:D&User[DnFlguratmn:Zj PG HLinbs »
putting an S next to it, or by e LT |
- Sl miimmnhar e e e eI IOF Job List Menu ------------- P
entering the sequential number CONMAND ===> _ ) SCROLL ===» SCREEM
fffffffffffffffffffffffffffffffff o T S et
——————— JOBMAME--J0BID-~-ACT-STAT - OWNER - - - -DEST /DEVICE -~~~ -~ -RECS -HELD-DAY -~ TIME
Of the REPORT OUtPUt You _ 1 KN971wWCB 1000526 KN971WC  LTESTH9GS 34 172 7:0c
_ 2 KN971WZE J004406 KN9Y1IWC  LTESTH9GS 34 171 14:3C
may have to pressthe F8 key to | = 5 a5l J80iace KNOTIWC  LTESTOGS 34 171 15:0%
_ 4 KN971wWCE 1005019 KN97IWC  LTEST9GS 34 171 15:1&
page down to see the REPORT
output.
F1=HELF F2=SPLIT F3=END F4=RETURN F5=RFIND FE=R.CHANGE
F7=UP FR=DOWH FO=Swap F10=LEFT F11=RIGHT F1Z=RETRIEVE
H H -3 http://has.dot.state.l.us/HostAccess/ENU/Enterprise /RequestConfig.asp?WebView=e%2DYAN] =121 x|
If nOthIng appears In the J File Edit Wiew Tools Connection  Cptions  GoTo Favuntes|He\p ﬁ
REPORT OUtpUt, look at the | pack - =& - @[] 4| Dsearch GFavortes BHistory | By S i 5]

| atdress [£] tConfig. asprivebiew—em Z0VANT AGE +ACTIVE%:2DXBE |amentkey=CO-+ACTIVE%:ZDXEEmbedded=08User Configuration=2 7| {0 HLinbs =

NEWH Sy nelnled @ |

output labeled ERRORRPT.

For example if the FinPrOj Specifty Disposition of Log Data Set

More: +
entered does not belong to your |3 2r2 set taerive SEFLfGSpﬁﬂ)dgl?giﬂﬁg gelete
district, this message in the BT e

(allocate same data set in next session)
Keep data set - New . .
(allocate new data set in next session)

S

output labeled ERRORRPT.
. . Batch Svs0UT class . .
At the Disposition of Log Data | |25z, 7rinter 1 or

Wi ter-nams L
Local SYSOUT class . .

Set screen

List Data Set options not available

Y Press ENTER key to complete ISPF termination.

Choose a prOCGSS Enter END command to return to the primary option menu.

[} Press <Enter> Job statement information: (Reguired for system printer)

===
H Command ===

e Toexit press F3 Fl=Help 1 F2=5p1it F3=ExTt F7-Backward Fo-Forward F9-5wap

FlZ=Cance

Reference Manual for Maintenance Projects PES Release 5.7b Page 28 of 117



TO eX it the F M I nte rface /3 http://has.dot.state.fl.us/HostAccess,/ENU/Enterprise /RequestConfig.asp?WebView=e == %]

File  Edit Wiew Tools Connection Options GoTo  Favorites  Help ﬁ
EBack + = - D A | @search GaFavorites (BHistory | By S
® Type an X a.t the JAddress |@ tConfig. asp?Wehiew=e%ZDYANTAGE-HACTIVE %2 DXEE ementkey=CO+ACT IVE%2DXEEmbedded=081 ser Configuration=2 j G0 HLinks 2
command prompt DS =il @ |
——————————————— TRNSPORT INTERFACE TO (PES,LAS,SITEMA  JOB KNO/IWCB SUBMITTED
p Ent OPTION === _
° r <Enter> PRODUCTION - IMSA USERID = KN371WC
€ss € INTERFACE MENU DATE = 02/06/20
TINE = 15:17
A - SITEMANAGER PAY ESTIMATE (SITEMANAGER)
B - ADD-REFRESH TRNSPORT PROJECTS (PES,LAS)
: C - ADD-REFRESH TRNSPORT VENDORS (PES, LAS)
A TSO screen will reappear D - FTP PAY ITEM HISTROICAL PRICES  (DSS)

with a ready prompt.

e To exit, type logoff
e Press <Enter> A8 B

Z - I0F (WIEW JOBS SUBMITTEDD) * ANY QUESTIONS, CALL YOUR DISTRICT TRMWSPORT ¥
* COCORDIMATCR OR CEMTRAL TRMSPORT COCRDIMATOR *

SELECT OPTIOM AND PRESS 'ENTER' KEY
F1=HELP F2=5PLIT F3=END F4=RETURN F5=RFIND FE=RCHANGE
F7=Up FE=00wN FO=5SWAP F1O=LEFT F11=RIGHT F12=RETRIEVE

When the FM Interface completes, the projects will appear in the Projects List window. (If your
Projects List window is open, you will have to refresh it by closing it and reopening it before
your new project(s) will appear.) These new projects will contain an Access Control Group that
is accessible to your district.

B fle Yew Lltes weder el
1Bas  ® Vi t | 2®MEe S

Creating a Project from Scratch

000BON0I00 A

If you are creating a “real” project from i a
scratch, use a proper FinProj number. i
Leave the FM supplied fields blank and

then run the FM Interface to refresh these
fields later. Enter the procedurally

required fields for the Project Header. o Tt o
To add a project header manually, . e
i A

e Rclick to open the Mouse Button
Menu from anywhere in the

FIBER OPTICS
TRAFFIC OPERATIONE

B Process. ..

Project List window Brosaks
) 15BaS - = LT - &
e Click Tabbed Folder Add ....u-m;e-:-r. | — | [ ] |
Or = g ] page 2
e From the Menu Bar, Click Edit >
Tabbed FOIder Add ProjactNumlnr:I— FProposal 10
Ml Projectie Py Iz Yoar [i
- - - - FediState Project Mo, A
This will display an empty Project Tabbed
Folder. Enter the Project Header N —
. . . unit System: e CES Jab Nuroer [
information first and then proceed to the T — —
other tabs. e e
Most fields are blank, but some are Frms e,

defaulted to particular values, such as the
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Unit System field (default is English). Most field defaults may be changed as appropriate.
Proceed to enter data in page 1 of the general tab for the following fields:

Project Number  Enter the Financial Project (FINPROJ) Number.

Pay Item Year A default value of 00 has been set.

Fed/State Project No. A default of N/A is assigned. For Federal Aid projects enter the
appropriate number.

Description Enter the project description. It will be updated from the FM system.
Unit System The default value is “E” for English. Change it if necessary.
Const. Eng. Pct  The default value is 0.00. Do not change it.

District Enter the managing district for the project, by clicking on the list box and
selecting the district.

Project Work Type  Select from the List box.
Project Type Select from the List box.

Control Group  Assign a control group to the project that matches the personal control
group, except that no wild cards (“*” or “?”’) may be used in the Project Control Group.
See Appendix B for a discussion of the Control Group structure.

IMPORTANT ****When adding a project from scratch remember to enter the
control group, otherwise the project will become “lost”” when saved.

Other fields may be left at their default values.
e Save the project by clicking the Save Icon. [

Creating a Project Using Copy Special

Copy Special is a function that provides a quick way of creating Projects or Categories. It takes
an existing Project or Category and creates a new Project or Category by copying ALL of the
records associated with the existing Project or Category. The new Project or Category can then
be edited to make the appropriate changes.

This will be used frequently by Maintenance as many of the maintenance projects are similar in
nature and require the same categories and items. The use of Templates will also be common for
maintenance projects.
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To initiate a Copy Special for a project,

fr Trns:port PES

File | Edit View Utilities Window Help

- - 1 Add Ins 13 t | 2 & f$
e Click the source project fromthe (2 e e L *] i8]
. . . E Delete... Shift+Del
PFOJ ect List window. B 1obbedFolder add
00 Tabbed Folder Change GUARDRAIL REPAIRS =+ TEMPLATI
. . . 11 SHLDR REFAIRISOD =+ TEMPLATI
o CIle Edlt > COpy SpECIal from 1 Heer el SHLDR REPAIR/SOD = TEMFLATI
17 S HENDRY LIGHTING MAINTENANCE
the Menu Bar 13 Gopy e DITCH CLEANING == TEMPLATE =
! 15 Cirley SRA00US 192 == TEMPLATE =

TOLL EQUIPMENT

This will open a window that asks what
project to create using the copy. The
project you are copying to cannot already
exist.

19070815202

19073715201
19073715202
19073815211
190736815214

To perform the copy,
e Enter the new Project Control Number
e Click ok. The new project will be created.

The new Project Control Number should be a

t Ctrha TOLL PLAZA REMOVATE
19UBTAL5ITT ! REFLACE SAWGRASS
19061465201 NIA TOLLBOOTH
19061485201 NIA SAWGRASS TUNMNEL
19070814301 MiA SURPLUS PROPERTY

PiA ROOF REPLACEMENTS
PiA DRAINAGE IMPROVEMENT
TiA DRAINAGE IMPROVEMENT

pr Copy Project
Page 1 |

Copy Project Control Mumber: 19073515201
Mews Project Cantrol Murnber: [1 07351 5201w

valid FinProj Number, unless the project being created is a template or temporary project.

Project Data

Updating Project Headers Nt iet A e W L e —
s profpecte |
To update an existing Project Header a

record,

e Rclick the project to open the
Mouse Button Menu.

e Click Tabbed Folder Change.

The General tab

The General tab contains two pages of
Project Header information.

MOA MANATER COUNTY
MECHANICAL SWEEPING

Py Aciutment irchoes Lt

Bun Process...

The fields that are highlighted are the ones that are populated from FM.

Project Number Pay Item Year

Description Location
Road Number Status
Beginning Termini District

Control Group

Fed/State Project No.
Unit System
Road Section Number

Ending Termini
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These fields (except for Control Group)
should NEVER be updated directly in
Trnseport because the nightly FM refresh
process will over write them. These fields
can be refreshed on demand by running
the FM Interface.

The Pay Item Year will default to 00 and
will not be reset when the FM refresh
program runs.

If there is incorrect or incomplete
information in any of the FM fields,

Blo B Yow Ules Widm Hop
1oy kA ¥ 4 *

v+, Project 41053717201

Gunal | counties | Catagoniss | Funting | Payamist | | | |

* paged 1~ paged

Project Numbar 41053717201
Alt. Projact i
Fadrstat Projact No
Dsunplion

Proposat ID: E1D16
Py ftem Yaar

Lacasan
|

Unit Systeen (£
Foad Name:
Route:|

Raad Saclion No

it

CES Job Nurnber.

statzs TG
Canst Eng. Pet:o.00
Distiit

contact the FM Administrator to have the fields updated in FM.

To view page 2 of the Project Header information,

e Click the page 2-radio button.

% Estimated Amt of Project This
required field is filled when
you run the process Generate
Preliminary Detailed
Estimate. This process will be
run several times over the
project development life. It
must be run after the final
Engineers Estimate for
historical purposes. When the
contract transfers to
SiteManager and DSS this field

Blo B Yow Ules Widm Hop
1By A } I L

Gonoral | Caunties | Catagories | Funding | Pay Arjust | | | |

 pagnl  * page 2

Estimated Amt. of Project [Fag00 60
Designer|
Ciate of Estimate:[ 000000 @] Becurmins in Liny
Prices oy | of Ratainage: [
Date Priced [ o000 @] Longhude of Midpont [1850000  (DDOMMES)
Retsd by [ Latitude of Midpownl. 50000 (DDMMSE)

Lagt Revigion [ oomom0 @) Flodd Book: [
Exighng Lanes: 000 Work Mic

Improved Lanes. {000 Class;

Adon Lanes [0 Proposad Letting Date: | oowonon @]

transfers as the Engineers Estimate.

The Type of Road and Work Mix fields on page 2 come from FM.

To update fields other than those populated by FM, on any screen

e Type over the field.
If a code table supports the field,
e Click in the field.

e Click the down arrow that appears.

A list box of selections will appear.

e Click the desired value in the list box.
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If you type something

Fle Edt Yew LUtlies Window Help

incorrectly in a field and wish |3 gas sm o | 0 | ¢

to restore the original value,
Dress <ESC> While you are Stll | sy oo | comee | i | et s v [ e
in the field. This does not work

if you selected a value for a

field by choosing it from a list
. Alt. Praject ID: Pay ltem Year: 00

box. It only works if you typed
) | f d Descrigtion:[SHLOR REPAIRIFERT/
ina value. If you need to . BT o
recover the Change and have UnitSystem:E CESJob Wumker]
gone beyond the partiCUIar RDEdSECU:”ID;LE. Caonst En‘ztaP“:tSmD—
field, you can close the project ** EningTermin 00T 70— Proctorace

- Beyginning Station: Proj. Wark Type:
and NOT SAVE It When the Ending Station: Project Type:

Contral Group:

prompt comes. If you do this,
you lose all changes made in

the current session. This is an
example of a list box of valid codes appearing for the field Project Type.

The Counties Tab

To view the Counties,
Fle Edt Yiew Lblties Window Help
. . liBas | - = | v | &
o Click the Counties Tab.
General Counties Categories | Fundin | Pay Adjust |” | | ttachment: |
The county record tells you what R o o

percentage of the project is in each
county.

The FM Interface will provide the county records and their percentages.

If you create a project from scratch, you can add county records or you can leave this tab blank
and run the FM Interface to refresh your project

If you add a county that does not exist in FM, the refresh process will not delete it, however, it
will set the Percent of Project Length to zero. So, if the county information is incorrect or
incomplete you should contact your Work Program Administrator and have them correct the
county information.

To Add or Delete a County record,
e Rclick to open the Mouse Button Menu.
e Click Add or Delete as appropriate.

Remember that information in the County tab is refreshed from Work Program. If corrections
need to be made, make them through the Work Program office.
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The Categories Tab

A Category in PES is a record that
belongs to a Project. It provides a way of
grouping items together. For
Maintenance projects, Categories
represent the particular Maintenance
Activity that is to be performed. There
should be one category for each
Maintenance Activity in the Project

Adding a Category
To add a category record
e Rclick from anywhere in the top

half of the Category tab screen to
see the Mouse Button Menu.

Bricge width (Fivy 00000 Bridoe Tyoe:|
e Click Add.
Change
This will open an input window at the bottom of the screen. ~ &etee
Or glnt:;:\llil
Sort ...
e Click Edit > Add from the Menu Bar. 7:;;1"| i
Hide: Detail Change
R . Copy Special elete. ..
If there are not two sections of the screen showing, = =
Filter ...
. - Shov Al
e Rclick in the screen to see the Mouse Button Menu. sort..
Select All
L] C“Ck ShOW Detail Show Detail
Copy Special

You should then see both an upper and
lower section of the screen.

Notice that a new blank line also appears
in the top half of the screen.

The Category No. field is the unique key
to the Category record and therefore each
value must be unique to a particular
project.

For maintenance projects, the Category
Number field is to be the Maintenance
Activity Number preceded by a “0”. To
see a listing of valid numbers, click the
list box for the Maintenance Activity
Number field. This list box contains the
valid Maintenance Activity numbers.

frs Trns-port PES

Fle Edit View LUtiiies Window Help

lizBaE | FE | & | v &

Find Categony

noao FM FROJECT FUNDING [
0471 LARGE MACHINE MOWING [l
0482 SLOPE MOWING Ll
0485 SMALLMACHINEMOWING] ——  [m
0541 ROADSIDE LITTER REMOY, [
0545 EDGING AND SWEEFING [l
| K I

s Project 19288817202

Genera\l Counties Categories |Fum1mg| PayAd]ustl Breakdowns | Wurksheell Attachments |

541
545

* page1 " page2
Category Mo, 0485 Category Alternate Code
Category Description:|SMALL MACHINE MOWING

Federal Construction Class:M
Caonstruction Eng. Pet.|0.00
Category Lenath (Mifk): |0.0000

Maintenance Activity Number:|485 Category Width (Fth):0.0000

Structure Work Class: Category Depth (|nfcm)'
Structure Wark Type: Lane Mikm:[0.0
Bridge 1D

Bridge Length (FtM):j0.0000

Proposal Section Number:|0001
Combine wiLike Categories: [
(Same Fed Constr Class)

Mumber of Spans; I

fri; Trns-port PES

File Edit VYiew Utilties ‘Window Help

lixBas | FEB & | v | ¢

Find Category:

aoog FM PROJECT FUNDING
0471 LARGE MACHINE MOWYING
0482 SLOPE MOWING

0485 SMALL MACHINE MOWING
0541 ROADSIDE LITTER REMOY,
0545 EDGING AMND SWEEPING

| Kl

fre  Project 19288817202

Generall Counties Categories |Funding| PavAdjustl Breakdowns | Worksheetl Aftachments |

IEEEEEE

* page 1 ¥ page2
Category Mo Catagory Alternate Code:]
Category Desctiption

Federal Construction Class:
Construction Eng. Pet
Cateqory Length (Mifk): 100000

Proposal Section Number.
Combine wilike Categories: 24
(Sarne Fed Constr Class)
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The Category Number should be the same as that chosen for the Maintenance Activity Number
field and the Category Description should be the same as the code description found for the
selected Maintenance Activity Number.

Categories Tab page 1
e Complete the following fields for each category:

Category Number - Required by the system; and should contain a Maintenance Activity
Number as described above.

Category Description -

Required by the e i3 —
- lkbkas @ b %

system; should contain
the code description s ; e ]
that is found with the [
Maintenance Activity |«
Number.

an
A0
T
541

EEEEE K

LITTER REMCV:
MO SWEEPING

Combine with Like

Category Flag - T »
Defaults to Yes (or ﬁ ”;“::“m“ﬁ,m”““’“'_ o]
checked). Thisfield | st — oo =
in conjunction with e el
the Combine with B e~y

Eridge Langin (FAMy 10000 Mumber of Spans:|
Like Item flag controls st kel
the rolling up of item
quantities for bidding.

Proposal Section Number  Leave this blank. It will be automatically generated later.
Federal Construction Class — This corresponds to the design group for construction projects
(01-Structures, 02-Roadway) or an M for Maintenance projects.

Bridge ID, Bridge Type, No Spans, Bridge Length and Bridge Width - are all procedurally
required for a Structure Category.

Maintenance Activity Number — This field is procedurally required and should be set to the
appropriate Maintenance Activity Number for each Category.
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Categories Tab page 2

When information on page 1 is
complete,

e Click the page 2 radio
button to display the
remaining fields.

Certain information contained
on the general page has been
repeated here (e.g., termini,

stationing, and section number).

It is not required that all
categories reflect the same
overall information.

Required Fields

Beginning and Ending
Termini — From FM.

Unit Number  Not in use
at this time. The
default value is 000.
Do not change this
value.

When category information is
complete,

e Click ok to finish
adding category
information.

e Click ADD MORE to enter

-, Trna-port PES
B Gt ow \Mltien Wik el
1bBas  *@ TH | &

Project 21324315201w

General | Counties  Categurivs |mnml Pay Adjust | Rraakitwne | ‘Warksheat | Aacheents |

e Categony: [ rp[Enow Al 5]
aooo FM PROJECT FUNDING NA 0o
0100 5 e ] (] Fi
0101 018 01 (] 3
oo me m o 3
0103 018 0 0 3
0104 01e 0t (] 3
nos me m o
0108 018 0t (] T
oo me m n
0oe ne n o
o110 018 o 0
o AT » 5 oe o1 o
K I —

T pagel F page @

Highway Tyne - Road Section Number:
Higtreeary Humbser. LUinft Numnber: 000
Beginning Termink Uinit Description:
Ending Tormink Adistment Code;
Begineng Stabon. Ro0000 000 Ay % o0

Engn Slation: 00000 000
Brigge Desigrer,
Super Structure Type: [3
Bub Structure Typo: [1

Fourdution Typo: 1
Struchure Location: |7

Lefladls e

+, Trna-port PES
B Gt ow \Mltien Wik el
bRy *@
b ralect 19 Y03

ot [ Enow All= -

FM PROJECT FUNDING
04T LARGE MACHINE MOWING

W
o 4T 0
04e2 M 40z ]
nass SMALL MACHINE MOWING o s (]
0541 ROADSIDE LITTER REMOV: L 541 n
EDGING AND SWEEPING N 0

e — |
T page ]l page 2
Highway Type: | -
Highrwary Husmber.
Beginning Termink
Ending Tormink
Beginrng Station
Endag Slation
Bicge Designer [
Super Structure Type
Sub Stnckure Typo
Foundation Type
Structure Location:

FRoad Section Number.
Linit Nusnber: 000

Linit Description:
Adiugtment Cody;
A %00

Lefladls e

information for another category.

e Click caNceL to return to the Categories List window without saving the new record.
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The Combine with Like Category Flag
(See also Combine with Like Items)

& page1 — page2
The Combine with Like Categories field Ceizrorl - EEF Caegory Alismate Code
N . . ) Category Description:|Repairing Non-Paved Shoulders
and the Combine with Like Items field on
- Froposal Section Numbhber: Federal Construction Class: M ;I
the Item Record ContrOI the presentatlon Combine wilike Categories: [<] Construction Eng. Pct.
of items for bidding in the proposal. 0 oS 00
. aintenance Activity Mumber:|432 Category Width (FUM)..D.DDDD
When both of these fields are marked Yes Structure Work Class: Category Depth (inierm
(or Checked) then |tems from categorles Structure Work Type: |MiA Lane Mifkm:|0.0
Bridge D
: : Bridge Length (Fimix:[0.0000 Mumber of Spans:[
which have the same Federal Construction G Bridge el
Class and the same Category Alternate

Code will have their quantities combined
and only be presented once on the proposal for bidding.

For example, if there are two separate categories each of which contained the tem M104 4 4
MOWING and the Combine Flags were both set to Y, then the quantities for these items would
be combined and the item would appear only once on the proposal. If the Combine with Like
Category Flag is set to N then this will override the settings on the Combine with Like Items
flags and the items for that category would not be combined on the proposal. If the Combine
With Like Category flag is set to Y then individual items can be excluded from rolling up by
setting their flags to N.

Like Category Like item Results

Y Y Quantities Combined

N Y Quantities Not Combined

Y N Quantities except for particular item combined

Creating a Category Using Copy Special

There is a Copy Special feature for a
category similar to the Copy Special for a | & et vew utites window belo

project. The difference is that only the [Atlcas | 21wk | 212=k0

particular category and its associated [Project Number " Feteral/State Project Number  Descripon |
. . . 25464515204 RIS TRAFFIC OPERATIONS
records (Item detail) will be copied and L7
BRIDGE REPAIR
. . . Add
not the entire project. Because of this, the Changs BRIDGE REPAIR
R ; 25466435201 RIS Belete THERMOPLASTIC
25466455201 RIS = THERMOPLASTIC
pro-leCt that yOU are Copymg to must 26466465201 IR Tabbed Folder Add THERMOFLASTIC
i 25467715202 NI Tabhed Folder Change TRAFFIC OPERATIONS
already exist but the Category you are 25467715203 MiA Tahbed Foldar Visw TRAFFIC OPERATIONS
H H 25467715204 RIAY = TRAFFIC OPERATIONS
Copylng to mUSt nOt eXISt' 25482215201 TiA Project U 41/ER 45/BROAD 5T
25482315207 R Category List U3 41/5R 45/BROAD 5T
254842115201 T PES Worksheet US98 (PONCE DELEON)
25553615201 IR Breakdown List SR 39 (BUCHMAN HWY)
25558515201 Nig, County Information List SR 38 (ALEXANDER ST)
25559815201 MiA, Pay Adjustment Indices List SR B76 (CAUSEWAY BL)
25563015201 184201 SR 60 (MEMORIAL HtY)
25583415201 RIS Buin Process... SR G674 (SUN CITY BL)
25584215201 RIS US92/SRE00/DALE MBRY
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This function can be used to create the
Category records for a new project. Copy
them from a template that has all of the
categories in it or copy individual
categories from existing jobs that are
similar to the one being created. Once the
Category is copied, add or delete items
and update the quantities as appropriate.

To initiate the Copy Special for a category,

firz Trns-port PES

File | Edit Miew Utiities ‘Window Help
1 vy | ¢ ReEHE]

Change

H Delete... Shift+Del
[ca

Filter Chrl+F

000 sark Chrl+s
011
Copy. A+
04!
0

Paste Gl

ERTILIZINGMULCH

4
47 MPAYE SHLDR

Select All Chrl+a,

04; E/DITCH REFAIR
n4gz SLOPE MOWING

=== =F

e Highlight the source project in the Projects List window.

e Rclick Category List.

e Highlight the category number to be copied.
e From the Mouse Button Menu, Click Copy Special

Or

e From the Menu Bar, Click Edit > Copy Special.

Alternatively from within the Category
Tab of the project,

e Highlight the category number
you want

e From the Menu Bar select Edit >
Copy Special.

Whichever process you used above, you
will see a screen that asks for a destination
Financial Project Number and a destination

Copy Category Mumber: 0436
Category Number. 'You can use the down arrow New Project Nurnber: [£10557 17257 4
and select your project that way. The category New Category Number: i43s]

number that you enter must not already exist in

the new project, so enter it here.

e Click ok when you finish.

¢ Trns: port PES

File | Edit View Utiities Window Help

s [ & vu [ <

Chenge

H Delete. . Shift+Del

itr ik
Sort ks

| Funding | Pay Adjust |E\ akdown!

. Chr+C
Chrl+y
FROJECT FURNDING M
g M
043 i} 433
M 435
R
MISC SLOPEIDITCH REPAIR M 437
SLOPE MOWING i} 482
&k Copy Category 0436 of Project 41053717201w

Copy Project Murmhber: 41083717201 w

Cancel |
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The Category 0000 Record

One special category record is created by
the FM Interface. This is the Category
0000 record. It contains all of the funding
information for the project. Trnseport
permits funding for each category;
however, The Department has elected to
store the entire project funding under the
0000 Category. The funding information
will not be updateable in Trnseport and
Category 0000 should never be deleted.

If any funding information is in error,
contact the Work Program staff to have it
corrected. Here is an example of the
Funding Information that came from FM.
You will not be allowed to update, add, or
delete any funding information.

Updating Category Records
From the Projects List window,

= Trnsport PES

e Rclick the desired
project.

e Click Tabbed Folder
Change.

e Click the Category tab.

frs; Trns-port PES
Fle Edit View Utiities Window Help

ixBos | BRB | & | v | ¢

= Project 19288817202

Generall Counties  Categories |Fundmg| PayAdiustl Breakdowns | Warksheetl Attachments |

Find Category:

FMPROJECTFUNDING | w | |

0471 LARGE MACHIME MOWING [ 471
0482 SLOPE MOWING M 482
0485 SMALL MACHIMNE MOWING ] 485
0541 ROADSIDE LITTER REMOY) M 541
0545 EDGING AND SWEEPING M 545
0432 Repairing Mon-Paved Shoul ] 432
{ Kl |

= page1 —" page 2
Category No.: 0000 Categary Alternate Code
Category Description:|Fi PROJECT FUNDING

Proposal Section Mumber:
Combine wiLike Categories: [
(Same Fed Constr Class)
Maintenance Activity Number.

Structure Work Class:
Structure Work Type.
Bridge ID
Bridge Length (Ft/m):j0.0000
Bridge Width (Funy:fo.o00n

Federal Construction Class:|m
Construction Enag. Pet. j0.00
Category Length (Mifk): J0.0000

Categary Width (Fihd): [0.0000
Category Depth (mfcm)'
Lang Miskm:[0.0

Mumber of Spans.
Bridge Type:

B Gt ow \Mltien Wik el
bRy *@

ot [ Enow All= -

This will display a list of all the
category records in the top half
of the screen and the detailed
record information in the
bottom half of the screen.

To update a category record,

|
pagel © paged
Cubegory b 487
Categury Dezcriotion ELOPE MOWING

Praposal Sacton Ny
Cambing wiLikh Cate &
(dame Fed Const Class)

Categosy Langth (MUK)

Mainbenance Activity ismber i3 Catngoey ¥ (Fom): [ 0000
Stnucture Work Class | Category Depth (e
Gtruchare Wark Typa Lans M3 0
Drisge iDx]
Eefdge Langih (FoM):f1.0000 Number of Spans [
Birige Width (F¥M).f0 0000 Dridge Type:

i
Calegory Atemate Code 0K
Cancal
] Fadnral Constuchon Class
Genstrucion Eng. Pet [T 00 Al Ko

e Highlight the Category desired.

e Enter the desired changes in the fields at the bottom.

When you are done,

e Click the ok button.

To update the information on Page 2, click the page 2 Radio button and change the data in a

similar manner.
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The scroll bar at the right in the bottom half of the screen allows you to see additional fields for
that particular category. The scroll bar on the right hand side of the upper half of the screen
allows you to scroll up and down through the category records.

Deleting a Category Record ¢ Trns-port PES

File Edit Wew Utilities Window Help

There are two ways to delete a category [1xees [ e | & [ vi | ¢

record. &+ Project 41054517201
Generall Counties Categories |Fun|:|ing| Pay Adjust | Breakdowns | Wurksheetl Attachments |
To delete a category record from the Find Category:

Category Tab in the Project Tabbed 0000 Fi PROJECT FUNDING "
Folder 0532 PAVEMENT STRIPING (LAR M
° RCIiCk the record. 0994 MAINTEMNANCE SUPPORT £ gnge

. . Eilker ...
e Click the Delete option on the fos
Mouse Button Menu. seectal
Hide Detail
Capy Special
| KN} |
 pagel " page 2

Category Mo 0537 Category Alternate Code:l
Categary Description |RAIE‘.ED PAYEMENT MARKER REPLACEMENT

fr= Trns:port PES
Or File ]Hiew Utiities Window  Help
- . il o =] AT &
e Highlight the record to be deleted. HE L — RN x|
° From the Menu Bar GE g!trstr Eg: |Funmng| PavAdjustl Breakdowns | Worksheetl Attachrments |
Click Edit > Delete. | IS
[ PROJECT FUNDING M
. B ; 05: sathu T s EMENT STRIPING {LAR: M
You will be prompted with a window that | sss——————rreuen sruso.s

MAINTEMNAMNCE SUPPORT £

asks you to confirm your delete.

L |
. - - * pagel — page2
If yOU WISh to continue Wlth the deIEte’ ’7 Category No.: 0537 Categary Alternate Code]
Catrunn Desorintinn:RaISER PAYEMERT MARKER REP| ACFEWMENT
e Click yes, otherwise Click No.
If you press the Yes button you will PY——

again be prompted with a window telling
you hOW many records you W| ” be @ ‘fou are about to delete the highlighted rows From the list. Do you wish to continue?
deleting and what other dependant
records you will be deleting.

When you delete a category, you will also delete any fund records and any item records that

belong to that category. Again, if you do not want to continue with the delete, press the No
button.
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e Click Yes to delete the category R
reCO rd and al I Of its aSSOC i ated @ ¥ou are about ko delete 1 rowis) from the list. All the Funds and items associated with the categories are also about
to be deleted, Do you wish ko continue?
records.

These same methods of Rclick to use
mouse button menus or selecting the option from the Edit selection on the Menu Bar are
available for most other entities such as Projects, Proposals, items, etc. You can also select
functions such as Add in the same manner.

Saving Data in Tabbed Folders

To save the changes that you have made in the Tabbed
Folders, click the X at the upper right hand corner of the
Tabbed Folder window. When you do, any Changes that ® Do you wish ko save changes?
you have made to any of the tabs will be changed. You Modified Tabs:

will be notified as to which tabs had changes recorded for - General

them and you will be prompted to confirm your save. T

PES - Project Tab Folder

Mo Cancel

If you choose No then, you will exit the Tabbed Folder
window without saving anything, but also without changing anything.

If you choose Cancel, no changes will be posted to the database and you will be returned to the
Tab that was active when you clicked the X.

Choosing Yes above will give you this window. If you click the Yes button, your data will be
validated and then the changes will be made to the database.
Do NOT click the Save As button. This option

. .
creates a temporary file on your PCs hard drive.
Data has been modified

It also locks the project that you were working on Click Yes to update the database.

so that no other users can access it. This is very

Click Save As to store changes in a temporary

dangerous because if your PC has a failure, the format and maintain the database lock.
project will be unavailable until the Trnseport
Coordinator or an OIS person can clear the lock L Yes Save s

on it. In addition, any changes that you made that
were not committed to the database will be lost.

When you make changes to the Worksheet, all of the records will be verified and updated,
regardless of whether or not the record was actually changed. So, it you have only a few changes
to make, it would be better to use the Drill-Down method as discussed later in this manual.

Always click the X to save while in Tabbed Folder Add. As with most windows programs, the
Save button on the Tool bar or select File > Save from the Menu Bar are also available

Cautions on Deleting Data

Trnseport has three levels of delete available in some instances. Users should, in general, never
use Power or Strong delete unless the full effect of the action is understood.
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Delete The lowest level of deleting. Usually deletes one data record from one file, so you will
only see one Delete Warning window.

Power Delete This second level of deleting, deletes multiple records from more than one file, so
you will see two Delete Warning windows. For example, if you are deleting a bid-letting
package, Power Delete will delete the letting call, bids, planholders, and proposal.

Strong Delete The third level of deleting, deletes multiple records from more than one file, so
you should see three Delete Warning windows. For example, if you are deleting a bid-letting
package, Strong Delete will delete the letting call, bids, planholders, the proposal and the
projects, items and funds (the whole tree of data).

The Breakdowns Tab

The Breakdowns tab is not being used for maintenance projects. A default value of 1" and
"Worksheet Breakdown Default™ should appear automatically to satisfy Trnseport system
requirements. If it does not appear, enter a "1" in this field on the Worksheet.

This tab is used for construction projects to classify a project using the "search 16" process and
contractor qualifications.

The Worksheet Tab

Adding Items to Project Categories

The FM system has no Item data. Most of the work will be in this Worksheet tab entering Items
and quantities.

All items must be associated with a category under a project.

There are several ways to add items to a project category. The first method is using the PES

Worksheet. This method is good to use for

- == - - H File Edit View Utlities Window Help
initially adding many items, however it can be [lxgas | [ Ve | t| 2em@Eels

overwhelming if you are only updating a few

Item quantltles or add|ng Only a feW Items. 41053717201 we hA SHLDR REPAIRIFERT =%
41053717201 hiA SHLDR REPAIRIFERT/ B
41053817201 HiA GUARDRAIL REPAIRS
To access the Worksheet il
41054517201 [ .
41054717201 MiA gegt‘za
H H 41054817201 hs ekt
e Rclick the Project to open the Mouse | i
41055017201 hiA ange
Button Menu 41055117201 HiA
41055217201 A
41059515201 R, 2’219“ et
. steqary Lis
e Click Tabbed Folder Change. ueastsiL i pes et
41081417201 HiA Ereddrmi:
41061417202 it County Information List
41062515201 Mg, Pay Adjustment Indices List
41064026201 A T eEme
41064115201 A, o NECER AYENTE
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o Click the Worksheet tab.

file Edit Wew Utities Window Help

ikBEaz | #E | & | vi& | ¢

Ad d | n g an d Del etl n g ROWS Generall Cuum\esl Categories | Fundmgl Pay Adjust | Breakdowns WWorksheet | Attachments |
. Find Project tem Line Number:
You can add or delete rows in the
0532 0001|0005 0007 071133 |TRAFFIC STRIPE SKIP (THERMOPLASTIC) AH) LF
WorkShGEt by 0532 0001|0010 0008|0711 34 |TRAF STRIPE SKIP (THERMOPLASTIC) (YL} LF
0532 0001 0015 0008|0711 3561 |TRAF STRIPE SOLID (THRMPLETCHAH) (6 LF
- - 0532 0001 0020 0014|0711 3661 | TRAF STRIPE SOLID (THRMPLETC)YLI( 6 LF
o RCI'Ck In the WOFkSheet tO Open 0534 0001 |oozs D00z [0711 3 PAVT MESSAGES THERMOPLASTIC EA
0534 0001|0030 0003|0711 4 DIRECTIONAL ARROWS THERMOPLASTIC EA
the Mouse Button Menu 0534 0001 0035 0004 0711 5 1 |GUIDE LINES (THERMOFLASTIC) AMHITE) LF
0001|0040 0711 52 |GU 2 OPLASTIC) (YELLOW)
0534 0001|0045 o005 |07t 7 Pay dR e THERMOPLASTIC SF
1 H H 0534 0001|0050 0010 |07113581 [TRE RowEOENS B MPLSTC)MWH) (87 LF
d CIICk the approprlate aCtIon 0534 00010055 0011 071135121 |TRE g;i::e RMPLSTC){AH] (127 LF
0534 0001|0060 0012 |071135181 TRE—— WMPLSTC)OAH) (187 LF
0534 0001|0065 o013 071135241 TRe e RMPLSTC)(AH) (24 LF
0534 00010070 0015 [07113861 |TRE zh“'tM“ RMPLSTC)(rL)( 8 LF
0534 0001 0075 0018 0711 38181 [TRE_ RMPLSTC){YLI(18") LF
- 0537 0001 0080 0017 |ET06 142 |REF SelectAl AND REF)(CLASS B) EA
o CI'Ck |nsel’t ROW, and a blank 0995 0001 |ooes 0001 010210 | OFF-DUTY LAW ENFORCEMENT OFFICER WH

row will be inserted prior to the
highlighted item. e

[ixEas ®&H | 2 vi | ¢

e Click Add Row to End and a s Project 41054517201
H H Generall Cnunnesl Calegnnesl Funmngl Pay Adjust | Breakdowns Worksheet | Aftachments |
blank row will be inserted at the e
end of the Worksheet.

0531 0001|0005 D007 071133 TRAFFIC STRIFE SKIF (THERMOPLASTIC) Mk |LF
. . 0532 0001|0010 |oooe 071134 |TRAF STRIPE SKIP (THERMOPLASTIC) (VL) F

Ona blank screen, the Optlon that WI" 0532 0001 [0015  |0o0a 07113561 (TRAF STRIPE SOLID (THRMPLETC)MAH) () i
. . . 0532 0001|0020 |04 0711 3661 | TRAF STRIFE SOLID (THRMPLETCILIC B F

ShOW In the RCI ICk menu wi ” be Add . 0534 0001 0025 000z (0711 3 |PAWT MESSAGES THERMOPLASTIC EA
D534 001 [o030 |poo: 0711 & |DIRECTIONAL ARROWS THERMORLASTIC EA

The |nsert ROW and Add ROW to End Wl” 0534 0001|0035 0004 0711 51 |GUIDE LINES (THERMOPLASTIC) (AHITE) LF
not appear on the list until other rows are | et o1 o st et e

PAVT MARKING REMOVE  THERMOPLASTIC SF
- 0534 0001|0050 0010 [07113561 |TRAF STRIPE SOLID (THRMFLETCHWH) { 8" LF

there YOU ma.y Se|eCt these OptIOI’]S from 0534 0001|0055 0011 071135121 |[TRAF STRIPE SOLID (THRMPLSTCIOAH) (12°) LF
R R 0534 0001 |onga 0012|0711 35181 |TRAF STRIPE SOLID (THRMPLSTC)MH) (18" LF

the Ed |t 0pt|0n On the Menu Bar 0534 0001 [ooss 0013 0711 35241 |TRAF STRIPE SOLID (THRMPLSTC)(vH) (24" LF

To quickly add many rows to the end of the worksheet, hold down the <Shift> key and press the
<Insert> key repeatedly.

e Click Delete, and all of the selected (highlighted) rows will be deleted. There will be a
delete confirmation screen.

The data in any grayed out columns cannot be updated.
To update a field

e Click the field.

e Enter the new data.

The arrow button beneath the Item Number column will pull up the item List from which you
can choose an item. Keep in mind that this takes a while to load so it is better to just type the
Item Number in if you know it. The item description and some of the other grayed out fields will
automatically be populated from the item Reference table.

Any fields that are flags must have a value of either “Y” or “N”. These values MUST be capital
letters.

Even though the Department is not using breakdowns, the Worksheet was designed around
breakdowns and breakdown items. Therefore, several fields are required even though they will
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not be used. Breakdown ID is one of these fields. The number "1" should always be entered for
this field. The Breakdown item Line No and the Project item Line No column are also

required. These columns each contain

rrs Trns: port PES

Fie | Edit View Utilties Window Help

sequential numbers. There are automated |1 et [ve |«

methods of generating these numbers.

To generate the sequential numbers for
the Worksheet

04
04 Consistency Checking I |DESIGN i BUILD (BUILDING) LS
E Assign Line Numbers » Project Items CE OF TRAFFIC LS DA
f . . . O g ame s v
e Click Edit > Assign Line o - SEED GRASE PERVANENTTYFE) B
[CE e 0001 MULCH AT ™
Numbers from the Menu Bar. e i I ooy arer FoR omass wo
oy peely
; ; } 095 solertal Cultw  |0001  |SHOULDER REWORK v
e Click PrOJeCt 1tems or [T 0001 |BHGAYATION SUBSOIL ov
D43_eroernacn D001 |EXGAVATION CHANNEL ov
kd 1 1 0437|0120 6 o011 |ooss 0001 |EMBANKMENT cv
Breakdown items as approp“ate' 0437 |012072 o012 |ooso 0001 |FILL GRAVEL ov
0437 |012170 0013|0085 0001 |FLOWABLE FILL cv

Project item Line numbers will be

Add Row to End Shift+Ins
Chenge
Delete... Shift-+Del

I Funding | Pay Adjust |Breakduwns Worksheet |Atlachmems|
Generate Worksheet Report [ S———

Perform Calculation

Hide columns
Updake with Historical Price
Range Fil » (0001 [MOWING (SLOPE) AC

generated in increments of five. Breakdown Line item numbers will be generated in increments

of one.

To set the Breakdown Id of all records to

lllll’

tab out of that field.

e Click the Column Heading to
highlight the Breakdown 1D
column.

e Click Edit > Range Fill > Fill
Down from the Menu Bar.

This will populate all of the records with
Breakdown Id of “1”.

e Trns-port PES
Fie | Edt View Utiies Window Help

Insert Row

[ v | &

ml-

add Row to End Shift-+Ins
“1" in the fi dand | &2 I —
i Enter a 1 In t e IrSt recor an B ShitCel I Funding | Pay Adjust | Breakdowns ~ VWorksheet | Attachments |
=l ] »
e ation

021}
020 Consistency Checking
020 Assign Line Humbers
020 ey CHiF LS
020 sort S LS
020 Ls
o o fative &
—=  paste Chrl+y
020 copy speds. LS
020 select al Ctrl+a MH
020 - ED
ng.Referendng On BARRWVALL (TEMP) (FEI(CONCRETE) W1
0200|2102 71 21 0012 0605 BARRWALL (TEMP) (REL)(CONCRETE) 1
0200 [2102 74 1 0013 0610 BARRICADE(TEMF)TYPS LILVF & DRUM) ED
0200|2102 76 0014 0616 PANELS ARROW ADVANCE WARNING ED

a 0200|2102 77 0015 0620 HIGH INTENSITY FLASH LI (TEMP - TYF B) ED
0200|2102 78 0015 0625 MARKER PAVT REFLECTIVE (TEMPORARY) EA
0200|2102 79 0017 0630 LICTEMP-BARR WALL MNT,TYP ¢ STEADY BURR) ED
0200 (210289 7 0018 0635 IMPACT ATTEN VEH (TEMP)(REDIRECTIVE OFT) Lo
0200|2102 99 0018 0640 SIGN VARIAELE MESSAGE (TEMPORART) ED
n200 1102100 020 NEAS PREVERTATIE MAINTERARCE ANMD RTH PEPAIR. LS InTY

The Range Fill option will fill all of the

records. Partial range fill is not currently supported.

Worksheet Field Definitions

Breakdown ID  Not used, but required by Trnseport. If the default value of 0001 does not
appear, enter a value of 0001. Use the Edit > Range Fill option to set all occurrences

to 0001.

Breakdown Item Comment  Not used.

Breakdown Item Generic Number 1

Breakdown Item Generic String 1

Not used.
Not used.
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Breakdown Item Line Number  This is a required field. It can be entered automatically.
To assign this number Click Edit > Assign Line Numbers > Breakdown items from
the Menu Bar.

Breakdown Item Quantity  Enter the quantity for the Item.
Category Number  Enter the Category Number from the drop down window.

Extended Amount  The product of the quantity times the price. Trnseport automatically
calculates this field.

Item Alternate This is a 3-digit code used to identify alternate items. Maintenance
currently does not use alternate items.

Item Description  System generated when an Item Number is selected.

Item Number  The pay Item Number from the Master Pay item List. It is contained in the
ITEMLIST code table of Trnseport.

Item Units  The unit of measure for the Item, which is system generated.

Pre-established Price Flag  The Pre-established Price Flag field determines whether the
Estimated Price of an item will be automatically entered on bidders proposal schedules.
If set to “Y” then the item will appear on the bid blanks, however the unit price will be
filled in and not bid on by the bidder.

Price Lock Flag  The Price Lock flag field indicates whether manually entered estimate
price information for any automatic processes will update items. Enter “Y” in this field
to restrict modifications to manually entered information, in other words, to “lock” the
manually entered prices.

Price Source The Price Source field identifies the source of the Estimated Unit Price. The
entry in the Price Source field must be a value from the PRICSRC code table.

Project Item Generic Code 1  Not in use.

Project Item Line Number  The Project item Line Number field is a four digit number
Trnseport uses to identify the item. Trnseport will automatically enter this value it runs
a process. These numbers may be entered directly in the worksheet by selecting Edit >
Assign Line Numbers > Project items.

State Mat Flag (Non-Bid item)  The default value for this field is "N". Non-Bid items
will not appear in any bid documents, and will not be passed to SiteManager. A
common use for this field is to identify FHP use on a project.

Estimated Quantity  Used by Trnseport to determine the extended cost of an item. It is
generated from the Breakdown item Quantity and cannot be changed.

Supplemental Description Part One  Not in use.

Supplemental Description Part Two  Not in use.

Reference Manual for Maintenance Projects PES Release 5.7b Page 45 of 117



Lump Sum items

In order to keep track of the cost of Lump Sum items by Maintenance Activity Number
(Category Number), the Lump Sum items will be flagged as Combine = Y, the item Quantities
will be set to one (1), and the total cost of the Item for the project will be apportioned to each
Maintenance Activity Number.

For example, if you have Mobilization on the project and you want to track the cost for two
different maintenance activities on that project, you would add the Mobilization Pay item to both
categories. Set the quantity for each as "1", and set the amounts based on your estimate of the
split. If the estimate for mobilization of the project is $10,000.00 and you estimate the split to be
60% to 40% for the two categories, set the amounts to $6,000.00 and $4,000.00 respectively.

The Attachments Tab

All of the Trnseport tabbed folder windows have an Attachments tab. It allows you to integrate
OLE-compatible documents (for example, letters or spreadsheets), web pages, and plug-in
applications into Trnseport. At this time there are no standards established for use of this feature.

Customizing the Worksheet

You can do some things to customize the look of your own Worksheet. Change the size and
location of a column or hide columns. See Appendix C for a more complete discussion on
customizing the worksheet. With Citrix MetaFrame, the customizations discussed here will be
saved to the Citrix Server in use when the changes were saved. You will have to re-do these
settings for each server in use.

Rearranging Columns in the Worksheet

To move columns on the Worksheet, put your cursor on the heading of the column to move and
hold down the left mouse button while you drag the column to its new location. You can only
move the column on the screen that is visible, so you may have to drag and drop several times.

Resizing Columns

To resize a column, place your cursor on the right hand vertical gridline of the column heading
you want to resize. You will see your cursor change from an arrow to a vertical bar with two
arrows on each side. You can now hold the left mouse button down, drag, and drop the vertical
line to where you want it.
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Hiding Columns

Some Worksheet columns such as the
Generic fields will not be used. These can
be hidden so the Worksheet is smaller.
This also protects from inadvertently
entering information in the fields. This is
important in the case of the Supplemental
Description field, because data in this
field affects how items roll up on the
proposal. The Department has made the
decision NOT to use the Supplemental
Description field.

To hide columns,

e Click Edit > Hide Columns from
the Menu Bar.

This will open a screen that shows all of
the columns that can appear on the
Worksheet.

e Highlight the columns to be
hidden by clicking on them.

To re-show a particular column click it to
un-select it.

To show all columns again,

e Click the Show All button.

Sorting Records in the Worksheet

To sort the records in the Worksheet,

frs Trns: port PES

Fle | Edt View Utites window Help

|
Al

Insert Raw | | T | & ‘
Add Row to End Shift+Ins

hange

Delste... Shift-+Del

Generate Worksheet Report »
lation

listorical Price

I Funding | Pay Adjust |Elreakdnwns Worksheet |Aﬂathmems|

Range Fil > OPE) AC
045 Consistency Cheding DESIGN | BUILD (BUILDING) L5
070 Assian Line Numbers > WMAINTENANCE OF TRAFFIG L5 DA
045 Fiper Ctrl+F SODDING 37
045 s Chrkes SEED GRAGS (PERMANENT TYPE) 1B
04z WULCH MATL ™
— copy Chr+C

ITER Py \WATER FOR GRASS WG
[0 Cn cpecia, FERTILIZER (SLOWY RELEASE) ™
045 selectal Qi SHOULDER REWORK v
04z EXCAVATION SUBSOIL o
{04z rerEngna On ECAVATION CHAMNEL o
0437 0120 & o011 |00ss EMBANKMENT o
0437 012072 o012 |n0an FILL GRAVEL o
0437 012170 o013 |u0es FLOWABLE FILL o

= Trns: port PES

file Edt Vew Utities Window Help

ixBas PR 2 | v | &

Genera

Find Pr

i Hidden Columns

Supp. Desc. Required
Supplemental Description
Supplemental Description Part Two
Estimate Quantity

Prop Line Number Show All
Alt Code
Price Lock Flag LS
Combine Flag LS DA
Exception Fund Code OK I v
Fized Price
State Mat Flag LB
Revised Item Price ™
Price Source Cancel MG
S Generic Code 1 ™
Breakdown ltem Comment
Breakdown Item Generic String 1 il
LLLb Breakdown ltem Generic Humber 1 CY
0437 |01Z g
0437 |0120 6 0011|0055 EMBAMNKMENT cY
0437 (012072 o012 |ooso FILL GRAVEL cv
0437 |012170 0013|0085 FLOWABLE FILL C

e Sort

‘ Column

Category Number

ftem Number

femRumber o BICEE O]

e Click the Sort Button ]a on the Tool Bar.

e Choose the columns to sort and their order.

e To sort on additional fields, Click Add.

e Click Apply when complete.

@ asc  (CJDESC

Apply

Cancell Add | I_nSBrtl Qelelel Help |
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Printing the Worksheet

To verify what you have entered in your
Worksheet, it is often helpful to have a
hardcopy report to look at. You can get a
listing of your Worksheet by running a
Worksheet Report.

To do this,

e Click Edit > Generate
Worksheet Report > Visible
Columns from the Menu Bar.

The Print Worksheet message window will open showing

the printer to be used.
If the printer is correct
e Click ok
Otherwise
e Click Printer
e Select another printer.

e Click ok

Using the Drill-Down Method

The Drill-Down method involves
selecting a particular object and then
Rclick it to Drill-Down to the next level
or DbIClick it to update the associated
information. This method deals with one
item record at a time within one category
at a time within one project at a time.

Adding Items

By using the Drill-Down method, you can
open a window that shows all of the detail
of the element you are working on in a

= Trns-port PES

File | Edt View Utiies Window Help
4 InsertRow

==

[ ve e

— Add Row to End Shift-+Ins

E Change

shitsosl |70 i
undiric Pav Adjust | Breakdowns ~ Worksheet |Arlauhmems |
= n
ar
Hide

B rengeFi » T TRTNTENARCE OF TRAFFIC L5 DA
042 Consistency Checking 1 DESIGN / BUILD (BUILDING) L5

047 Assign Line Humbers » [ SODDING oy

045 Eer CUliE 1 SEED GRASS (PERMANENT TYPE) ]

043 gort s 1 MULCH MATL ™

04 1 WATER FOR GRASS WG

S CiiEG 1 FERTILIZER (SLOW RELEASE)

=S pasie Chrl+y e EE)

1045 Copy sperial 1 SHOULDER REWORK v

041 Seleceal Chl+h 1 EXCAVATION SUBSOIL cv

04 - 1 EXCAVATION CHANMEL cv

.. Referengng on 1 e o
0437|0120 72 0012 [oos0 1 FILL GRAVEL oY

0437 |0121 70 0013 [ooes 1 FLOWABLE FILL oY

0483 [E104 4 2 o014 [oo7o 1 MOWING (SLOFE) lac

frs: Print Worksheet

Printer: Clienthco-kndFlweiy\hdotscoprintdl \Burns_35W1E74 U
Ao pry| T 5

Copies: 1 =
Page Range Lancel |
= All

Printer... |
Help |

LI V¥ Collate Copies
" Print to File

" Pages: I

Enter page numbers and/or page ranges
separated by commas. For example, 1,35-12

Print: All Pages in Range

5 Trns-port PES

Flle Edit Wiew Utlites Window Help
lixmaE | B | Ve | ¢t ceE@Ee 5

fre Projects

4106371 7201w A
41063717201 xc A

SHLDR REPAIRIFERTY
SHLDR REPAIRIFERTY

T TRAINING

T TRAINING

41053817201 1/ GUARDRAIL REPAIRS
2dd
41054517201 [ Changs BTRIPING
41054717201 A Delets. . HEARING
41054817201 A ———— HEARING
41054917201 i Tabbed Folder Add IL & SIGN
41066017201 A Tabbed Folder Change IL & SIGN
41056117201 A Tabbed Folder ey R
41055217201 A R
41059515201 A ORTEZ ROAD)
41059515218 A ORTEZ ROAD)
41061217201 A BR DECKS
41061417201 A A ——— - MONROE CO
AU Ll Pay Adjustment Indices List [ M1OMROE CO
41062515201 A B [ R TS
41064025201 A Bun Pracess. . A 344TH ST.
41064115201 A WINKLER AYENUE
41064213101 A SR 739 (METRO PKWY)
41064215201 1081028P SR 739 (METRO PRWY)
41064315201 A SR 997/KROME AVEMUE
41064415201 A SR 968ISVWISE 1 STEB
........... A O ALAICALLINE A

single window display. For Pay items, this window is very similar to the one seen at the Master
Item list. For Categories, it is similar to the lower window portion of the Categories Tab with

pages one and two combined.

To Drill-Down on a project to the category level
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e Rclick the project to update.
e Click Category List.
The list of categories will open.

e Rclick the category to which to
add the items.

e Click Project items List.

From the Item List window,
e DbIClick the item to update.
Or

e Rclick and Click Item or Change.

To add a new item,
e Rclick
e Click Add.
To delete an item
e Rclick
e Click Delete.

frs; Trns-port PES

File Edt View Lklliss window Hslp

ixBas | | v | &/ 2ée%8H
lcag  aw  pescrpion  Twe Feos

0o0g Fi FROJECT FUNDING

[l
0102 MOT [l
0433 g00D [l
0435 SEEDINGIFERTILIZINGMULCH )
0436 REWRK NONPAYE SHLDR L)
0437 L)

MISC SLOPEDITCH REPAIR

0482 SLOPE MOWING Add M
Changs
Delete. ..
Category

Project Funding List
Project [tems List
Quantiies and Prices

RUn Process, .,

frs Trns:port PES

File Edt View Unities Window Help

ixBeas | & | v | t|2E

0045 EXCAYATION SUBSOIL 0120 4 a0z0
ilildn) EXCAYATION CHANNEL 0120 5 nozs
0055 EMBANKMENT 0120 B 0030

add
Change
Delete...

0065 FLOWABLE FILL 012170 0040

To enter changes, first click the Change button if you opened the window with a DbIClick. The
down arrow after the Item Number field will open the Item. As in the Worksheet, this takes a
while so if you know the item numbers it is faster to type them in. Some fields are backed by a

code table, and when you click the field,
or tab to the field, the arrow will appear
allowing selection from the table.

e Click Close to save the changes
and exit the screen.

When you Rclick from the Item List and
Click Add, you will get an empty screen.
Unlike the Worksheet, this screen will not
refer to Breakdown fields and the Item
Line Number is automatically assigned.
When re-opening the Worksheet after
adding items through the Drill-Down
method, the breakdown fields will be
empty. Remember to fill them in the
Worksheet.

e Trns-port PES

File Edt View LUties Window Help
i1xBaz | B |
fre Add tem  Project 41053717201w Category 0437

Page 1 I
Project lterm Seq No: po7s
Itern Mumber. ﬁ
Estimated Quantity:|0.000
Estimated Price:|0.00000 Supp. Desc. Required: [
Suppl. Description:
Itern Alternate Code. Comhbing with Like ltems: [
Specification Year: 00 MNon-Participating Fund Code: ﬂ
Revised Price: Mon-Bid ltem: []
Source of Price: |E Pre-Established Price: []
Estimated Price Lock: [] Proposal Line Mumber:
Suppl. Proposal Descr, | Generic Code 1
0K | Add More | Cancel |
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This is an example of an Add Item
Screen.

After entering the Item Number and
leaving that field, the program will
automatically enter the description and the
default for the Combine with Like items
Flag.

Note that the Project item Sequence
Number is assigned automatically. In the
Worksheet, you had to generate this
number.

When you are finished entering in the
information,

e Click ok to save the record.

e To keep adding records click the
ADD MORE button.

e Trns-port PES

Fle Edit View Utities Window Help

|lizeas | B | ¢
i Add tem  Project 41053717201w  Category 0437

Page 1 I

Project ltem Seq Mo (00749
Itern Mumber:|0120 73 EFH_L LIGHTWEIGHT AGGREGATE
Estimated Quantity [450.000 oY
Estimated Price:|[15.25000
Suppl. Description

Supp. Desc. Required: []

Item Alternate Code:
Specification Year. 00
Revised Price
Source of Price: |E
Estimated Price Lock: []
Suppl. Proposal Descr. |

Combine with Like ltems:
Mon-Participating Fund Code: ﬁ
Mon-Bid ttem: []
Pre-Estahlished Price: []

Proposal Line Number:

Genetic Code 1

0K | Addﬁnlel LCancel |

The key difference between the Worksheet and the Drill-Down methods is that the Worksheet
processes many records at a time and the Drill-Down method deals with one record at a time.

Updating Item Quantities and Prices

The Quantities and Prices window is
available to update the item Quantity and
the Estimated Price. You cannot add or
delete items using this screen. Itis
helpful in the case where you have copied
your items from another project or a
template project and you only need to
change the quantities of the items. This
screen is also accessed via the Drill-Down
method.

To access this screen,
e Rclick the Project
e Rclick the Category List
¢ Rclick the desired Category

e Click Quantities and Prices.

i Trns: port PES

Ele Edit View WUtlities Window Help
lixeas & | v | t 2&sH|
iy Categories Project 41053717201w

noog

FM PROJECT FUNDING

0102 MOT

SEEDINGIFERTILIZINGMULCH b
REWRK MOMPAVE SHLDR
MISC SLOPEDITCH REPAIR
SLOPE MOWWING

Change
Delete. .

L

bl

W

0438 W
0437 W
D482 W Category
Project Eunding List
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e Enter the quantities or estimated
prices for the items.

Use the Sort function to best order the
items to perform the updates.

Hide columns and move columns around
in the Worksheet. However, the changes

prs Trns-port PES

File Edt Yiew Utities Window Help

ixBaE | B | v | ¢

pr; Quantities and Prices for Project 41054517201

0005 1.000000711 33 TRAFFIC STRIFE SKIP (THERMOF| I
0010 600.000; 1.50000/0711 34 TRAF STRIFPE SKIF (THERMOFLAS I
no1s 4000.000) 0900000711 35 1 [TRAF STRIPE SOLID (THRMPLST! N
noz20 4000.000) 1.20000/0711 36 1 [TRAF STRIPE SOLID (THRMPLST! N

are not saved, as they are when customizing the Worksheet. They will only be there for the

duration of the stay in that window.

Combining Projects

You may want to combine project information when different people have developed different
portions of a project that in the whole has extensive category and Item detail.

e To combine the work, designate one of the projects as the host. This should be the
project being creating. It has a real FINPROJ number as its Project Control Number.

e Verify that the Category Numbers for all of the projects to be involved in the combining

operation exist in the host project.

e If there are last minute changes to the host project, save it so that the project information
exists in the database as well as in the memory of your PC. The data base is where the

process of combining the projects
will occur.

To combine two or more projects into a
single project:

e Click the host project in the
Projects List window.

Trnseport will keep the header from this
project and add categories and pay items
from other projects to it.

e Click Tabbed Folder Change to
open the project.

e Click the Worksheet tab to open
the Worksheet for the selected
project.

In this case, there are no Items displayed.
A view of the Category tab of this project
would reveal that all necessary Category
Numbers exist.

frs; Trns-port PES

File Edt Yiew Uities Window Help

ixBas & Y& | t|2>@E@Ee s

frs; Projects

41063717 201wt i SHLDR REPAIRFFERTI =+ TRAINING =
410537172015 i SHLOR REPAIRFFERT = TRAINING ==
41053817201 NI GUARDRAIL REPAIRS

471054517201 o THERM pETRinlls

41054517201 [ THERMC 243

41054717201 A power  Change

41054817201 i poweR Dot
41054517201 i GUARDF  Tabbed Folder Add

41055017201 i e Tabbed Folder Change

41055117201 i FERTILIZ" Tabbed Folder e

41055217201 i FERTILZ
41059515201 i SRBad(  Proect

410595152L5 i SRBge( CategoryList

41061217201 i SR 5iUg  PES Worksheet

41061417201 i SRang]  BreakdownList

41061417202 A SR County Infarmation List

41062515201 A SR iug. e Adiustment Tndices List

41064025201 A SR 8336,
410641145201 MiA WWINKLE

Bun Process. .

|

= Trns-port PES
Fle Edt Yiew Utilies Window Help

likeas ®E| = | v | &

fre  Project 41054517201

Genera\l CnuntleSl Categaries | Fundmgl Pay Adjust | Breakdowns  Worksheet | attachments |

Find Project item Line Number:

0001|0005 0007 [TRAFFIC STRIPE SKIP (THERMOPLAS [l
0711 34 'TRAF STRIPE SKIP (THERMOPLASTIC) (¥L)

0532 0001|0015 0009 0711 3561 |TRAF STRIPE SOLID (THRMPLSTC)(WH) ¢ 6") LF
05332 ooo1 0020 o014 0711 36 61 |[TRAF STRIPE SOLID {THRMPLETC)(YL)( B} LF
0534 0001|0025 0002 0711 3 PANT MESSAGES THERMOPLASTIC EA
0534 000 |o03o o003 0711 4 DIRECTIONAL ARROWS THERMOPLASTIC EA
0534 0001|0035 o004 0711 51 GUIDE LINES (THERMOPLASTIC) MHITE) LF
0534 0001|0040 o005 0711 5 2 GUIDE LINES (THERMOPLASTIC) (YELLOW) LF
0634 0oo1 0045 0006 0711 7 PAVT MARKING REMOVE ~ THERMOPLASTIC SF
0534 000 |o0so o010 07113581 [TRAF STRIPE SOLID (THRMPLETC)(WH) (8" LF
0634 0oo1 0055 oo11 071135121 [TRAF STRIPE SOLID (THRMPLETC)OWH) (12') LF
0534 0001|0060 012 0711 35181 |TRAF STRIPE SOLID (THRMPLSTC)(H) (18" LF
0634 0oo1 0065 0013 0711 35241 [TRAF STRIPE SOLID (THRMPLETC)(WH) (24"} LF
0534 0001|0070 015 0711 3681 |TRAF STRIPE SOLID (THRMPLSTC)(VL)( 8" LF
0534 0oo1 0075 0016 0711 36181 [TRAF STRIPE SOLID {THRMPLETC)(YL)(18") LF
0537 0001|0080 a7 E706 142 |REFL PAWT MARKER(REM AND REP)(CLASS B) EA
0335 0oo1 0085 ooot 010210 OFF-DUTY LMW ENFORCEMENT OFFICER MH
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Trnseport displays a list of projects. Use the Filter

and Sort options to help you locate projects to 209720252012 Hia 5R 228 HAF
- . . KO Project A Production 1
combine. You must combine projects where all of  xcss Proects Production
. HCIC Project C Production i

them have the same Pay Item Year and same Unit  xexo PrjecD Prducor
rojec’ roduction

From the Menu Bar Click File >
Import > Combine Projects.

System.

In this example the filter was used to find the

desired project.

Click a Project Number to combine.

Click ok.

Trnseport returns you to the Worksheet
where it loads data from the selected
project into the open Worksheet.

To combine other projects with the
first project, repeat these steps for
each one.

When all projects have been
combined, rerun the Assign Line
Numbers process for both Project
Line Numbers and Breakdown
Line Numbers.

prs Trns-port PES

Fle Edit View Utlties Window Help
Open Bid Letting List it ‘ & | T ‘ -@.‘
Open Proposal List
Open Prime Project List
Open Project List
Close:

guriesl Fundmgl F'avAdiustl Breakdowns Worksheet | Aftachments |

humber: [

Referance Tables 5
Save

Bn Frocess, .

Proress Status 0 nonB 071134 | TRAF STRIPE SKIP (THERMOPLASTIC) (Y1) L
T btsenp. !5 [0008 07113661 |TRAF STRIPE SOLID (THRMPLETCHONH) (6 L
i bo 014 07113861 |TRAF STRIPE S0LID (THRMPLSTCI(VLI( B L
—___hs Iz n7ie s ©4yT MESSAGES THERMOFLASTIZ EA
(i s [RECTIONAL ARROWS THERMOFLASTIZ EA
Erport P| - leEiiiches B |J\DE LINES (THERMOPLASTIC) (AHITE) LF
oo T T
Load Project Estimate Data
1534 0001 0 Lnsd Frojacts AF STRIPE S0LID (THRMPLETCIH] ¢ &) i
0534 D001 | Load Projects from SAPW AF STRIPE SOLID (THRMPLETC)MH) (127 L
n534 ono1 n0R0 0012 071135101 [TRAF STRIPE 50LID (THRMPLSTCI0NM) (187 L
0534 D001 D0BS 0013|0711 35241 |TRAF STRIPE SOLID (THRMPLETRI0NH) (24°) L
1534 onol_ln0fo__lnots 07113801 TRAF STRIPE S0LID (THRMPLSTCILCE) L
-
F#Templated Template for Training proj Production

19733025201 we MiA SRET2AIR

of
| Kl | 3
OK | Filter | Sort | Cancel | Help |

01

L« | i

0K | Sort | Cancell Help |

¢ Trns: port PES

File Edt View WUtlities Window Help
ixBas | FE | & | v | ¢

frv  Project 41054517201

Genwa\l Cuunhesl Categories | Funmngl Pay Adiust | 1 | |

Find Project item Line Number:

0001|0005 o007 071133 TRAFFIC STRIPE SKIP (THERMOPLASTIC) () LF
0001|0005 oo 071132 [TRAFFIC STRIPE SKIP (THERMOPLASTIC) (vH) LF

0001|0010 oo0a 0711 34 TRAF STRIPE SKIP (THERMOPLASTIC) (vL) LF
0001 |0d10 o0og 0711 34 [TRAF STRIPE SKIP (THERMOPLASTIC) (YL) LF
0001 0015 {spleg) 0711 3561 |TRAF STRIPE SOLID (THRMPLSTC)(H) (6"} LF
0001|0015 0006 0711 3561 [TRAF STRIPE SOLID (THRMPLSTC)(vH) (6 LF
0001 (0020 0003 0711 36 61 [TRAF STRIPE SOLID (THRMPLETCH(YL){ 6} LF
0001|0020 0014 0711 36 61 [TRAF STRIPE SOLID (THRMPLETC)(YL){ 6} LF

0001|0025 o002 0711 3 PAWVT MESSAGES THERMOPLASTIC
0001|0024 o015 0711 3 PAWVT MESSAGES THERMOPLASTIC
0711 4

DIRECTIONAL ARROWS THERMOPLASTIC

0711 4 DIRE! HE| C
0534 0001|0035 03 0711 5 1 GUIDE LINES (THERMOPLASTIC) WHITE)
0534 0001|0035 o004 0711 5 1 GUIDE LINES (THERMOPLASTIC) (WHITE)
0534 0001 (0040 0005 0711 6 2 GUIDE LINES (THERMOPLASTIC) (YELLOW LF
0534 0001 (0040 o012 0711 6 2 GUIDE LINES (THERMOPLASTIC) (YELLOW) LF
0534 0001|0045 0011 0711 7 PAWT MARKING REMOVE ~ THERMOPLASTIC SF
0534 0001|0045 0006 0711 7 PAWVT MARKING REMOVE ~ THERMOPLASTIC SF
0534 0001|0050 o007 07113581 [TRAF STRIPE SOLID (THRMPLSTC)(vWH) (8 LF
0534 0001|0050 oo 07113581 |TRAF STRIPE SOLID (THRMPLSTC)(AH) (8") LF
0534 0001|0055 0006 0711 35121 |TRAF STRIPE SOLID (THRMPLSTC)(AH) (12 LF
0534 0001|0055 a1 0711 35121 |TRAF STRIPE SOLID (THRMPLSTC)(H) (12" LF
0534 0001|0060 0005 0711 35181 [TRAF STRIPE SOLID (THRMPLSTC) (WWH) (168" LF
0534 0001|0060 o012 0711 36181 [TRAF BTRIPE SOLID (THRMPLETC) (WWH) (18") LF
0534 0001|0065 o004 0711 36241 [TRAF BTRIPE SOLID (THRMPLETC) (WWH) (24") LF

v L
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Generating Reports and Running Processes

In PES, reports and other batch jobs are run by the Run Process selection.

Project Level Reports

Using the Mouse Button Menu

After entering projects, add categories, and items, and designate where the work is being done,
you can run project-level reports. The Preliminary Detail Estimate process produces a printed
report that details the Items. Trnseport also summarizes the estimate with subtotals for item

categories and funds.
Fle Edit View Utles window Help
e Click the project for which to 1wBas | v |t oemEEe s
- :
generate reports in the Projects
List window. s T N SHORREPARFERT  ~~TRANNG

41053817201 [MIA GUARDRAIL REPAIRS
41054517201 g
41054817201 A

41054717201 i Change
Delete...

(To select more than one project, hold

sy 41054817201 A R
down the CTRL key and select additional | pems
. R 41055017201 [y Tabbed Folder Change SIGN
41055117201 HiA Tabbed Folder ¥
projects with the mouse). Hossirot ik | Tabbedfolderyew |
41059515201 A z'“;le“t Lt EZ ROAD)
- 41059515215 MIA LI EZ ROAD)
e Click Run Process from the 41081217201 A PR ECcKs
41051417201 A %’“"t‘jUIW:L‘Stt Lt NROE GO
Sty Tformation Lis
Mouse Button Menu. 0417202 s pox Ao s [
41064025201 A e
- - - - 410684115201 NIA
This will dISplay a list of processes that HOBAH M A SR 730 (METRO PR

are available to you.
rr= Processes

Generate Master Payitern List -
‘Generate Preliminary Detail Estimate ]
Generate Froposal Mumber Change Report
List Project Estimates

List Projects

Froject Proposal Crosswalk

Renumber Project Estimate [tems
Sumimary of Quantities -

Here is a sample list. Your security authority may not
permit you to run all of the processes available in the
system.

Generating a Preliminary Detail Estimate

To run a Preliminary detail Estimate, [ ok | concel | ew |

e Click Generate Preliminary Detail
Estimate from the Processes List window

frs; Detail Cost Estimate Parameters

[ ] CliCk OK Page 1 |Paggzlpagesl
Trnseport displays the Detail Cost Estimate
Parameters window.
The parameter selection window has three pages. Renumber Estimates: [

Page 1 shows a default selection to renumber the
Item line numbers. To renumber them,

e Click the box to set the check mark.
° C“Ck the Page 2 tab Submit I Parameters Cancel
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On page 2, enter the level of summarization.

Project is the default level. This option

determines whether to run the Detail Estimate for
a project, prime project, or proposal. The
Department is not using prime projects. After

entering the level of summarization,

e Click the Page 3 tab.

Page 3 shows the Parameters window, which
allows you to select the reports to produce.

e Check the boxes of the reports to generate.

e Click Submit to run the process.

e Click Parameters to change process

submission parameters.
Or

e Click Cancel to return to the Projects List
window without running a process.

When you click Submit, two informational windows will appear.

The first will inform you that the process has been submitted.

When they appear,

e Click ok.

When your process is completed, this window

will appear.

e Click ok.

Using the Menu Bar

Select the project or projects for which
you will run reports. To do this click the
project in the Project List window. If
you want more than one project use the
<CtrlI> key or the <Shift> key to select
multiple projects.

Then,

e From the Menu Bar, Click File >
Run Process.

/1 Detail Cost Estimate Parameters [ x]

Page1 Page2 |Page 3 |

" PRIME
% PROJECT
" PROPOSAL

Level of Summarization:

Submit I Parameters | Cancel |
(1 Detail Cost Estimate Parameters [x]

Page 1 | Page 2 Page 3 |

Select Reports:
Detail Estimate Cover Page: [v
Cost Summary: W
Cost Estimate: @
Funding Surnrary: @
Funding Surnrmary by Unit: [
Funding Surmrmary by Fund: [»

Select Data Sources: Default Database is PES

Letting and Award System (LAS): [
SiteManager System [~

Submit I Ealamelen;l Cancel |
Client Job Monitor Eq

@ Process PESGPDEA submitted,

DPS Status Monitor

@ Profile PESGPDES For process PESGPDE has completed

fr Trns-port PES

|Fie Edt Yiew Uiliies Window Help
Open Bid Letting List
Open Proposal List
Open Prine Prajeck List
Open Project List
Close:

[ | v | t[ormme s

I Y MOA TOWN OF LONGBOAT
Referenca Tables v one MOA MANATEE COUNTY
e MECHANICAL SWEEPING
His MECHANICAL SWEERING
His TREE TRIMMING
A SR i TREE TRIMMING
Inport v owe TV VIEWINGISTORM
Export v we TV VIEWINGISTORM
— | nm SHLDR REPAIRISOD
Eat hiA SHLDR REPAIRSIS0D
41049117201 His SHLDR REPAIRISOD

41049217201 A

SHLDR REPAIRISOD
MOA LEE COUNTY
SHLDR REPAIRIFERTI ™ TRAINING
SHLDR REFAIRIFERTI = TRA|

41063717201x A SHLDR REPAIRIFERT! ™ TRAINING =
41053717 201xc A SHLDR REPAIRIFERTI ™™ TRAIMING =™
41061217201 A SR 5/US 1 BR DECKS

41061417201 A SREUST_- MONROE CO
41074617201 i SAR; COUNTY
41075217212 A UNDECLARED EMERGENCY
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The Processes List will appear. The contents of the
Processes List window will vary depending upon what
object you are running the process on (project verses

proposal, etc.).

The List Projects report will generate a report that lists
project header information for all selected projects.

o PrOCEsses E

Generate Master Payitern List |
Generate Preliminary Detail Estimate

Generate Proposal Mumber Change Report

List Project Estimates
‘List Projects

Project Proposal Crosswalk
Renumber Project Estimate ltems

Summary of Quantities -

Proceed as above when using the Mouse Button Menu commands.

Viewing Reports
To see the results of this process, from the
Menu bar,

e Click File > Process Status.

This screen lists all of the processes
recently run.

e Highlight the report just run
(check the date and time columns),

e DblClick the blue band.

Usually reports are labeled
OUTPUT.TXT. Sometimes there will be
more than one report available. For
example, you may have an exception
report in addition to the regular report.

These are the reports available from this
process.

e Click the report to be opened.

e DbIClick the report
OUTPUT.TXT and review the
report on screen.

OK I Cancel | Help |

1, Trns-port PES
| Fle Edit View Utities Window Help

Open Bid Letting List |11. | v 12 ‘ ry ‘ o™ & 18 |

Open Propasal List

Open Prite Project List

Open Project List

Close Ni& MOA LAKE WALES
W IMiA MOATOWIN OF LONGBOAT

Nia MOA MANATEE COUNTY
Run P IMiA MECHAMICAL SWEEPING
Nia MECHANICAL SWEEPING

Prink Set. IMiA TREE TRIMMING

— | me TREE TRIMMING

Expnrt b IMiA TV VIEWINGSTORM
| IMiA TV VIEWINGSTORM

Exit Nia SHLDR REPAIRISOD

AT0457TT 20T IMiA SHLDR REPAIRS/S0D

41049117201 Nia SHLDR REPAIRISOD

41049217201 IMiA SHLDR REPAIR/SOD

MOA LEE COUNTY

41049627201 [iA
1 SHLDR REPAIR/FERT/ *** TRAINING **

41053717201 we TiA

SHLOR REPAIRIFERT, == TRAINING ™
41083717201x iR SHLDR REPAIRIFERT/ ** TRAINING
41053717201 TiA SHLOR REPAIRIFERT, = TRAINING =
41061217201 iR SR 5iUS 1 BR DECKS
41081417201 TiA SRAMST_- MONROE CO
41074617201 iR SARASOTA COUNTY
41075217212 TiA UNDECLARED EMERGEMCY

(1, TFms:port PES

fle Edit View Utiies Window Help

lixras | & | v | t|a]

Regular | scheduled |

FPESGFDE FPESGPDEA Ccampleted 09/04/03 08:48 am 0848 am 048 am 156.75.195.104
FPESGFDE FESGPDEB Ccampleted 09/04/03 08:59 am  08:599 am 09:00am 156.75.195.104
PESGPDE PESGPDEA Completed 09/04/03 09:23am 0923 am 09:23am 156.75.195.104
PESGPDE PESGPDEB Completed 08/04/03 09:31 am 0331 am 09:31 am 15675195104

PESGPDE PESGPDEA Completed 08/04/03 03:48am 0348 am 09:48 am

15675195104
166 76186104

ez Tens-port PES

File Edit Yiew Utiities Window Help
iexpas | &k | ¢ 259

PROCLOGTHT 09.49.44
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The Show system files check box will show all of the files the system generates. If the process
gets an error when it is run, you may need to look at these files when you work with the System
Administrator to debug the problem. Otherwise, leave the box unchecked to limit the list of

output files displayed.

The report window has a toolbar associated with it that permits you to edit the text. You may

highlight a word or phrase and
change the font, use line out,

bold etc. | (T a ) s ) === 5 A
You can scroll around in your I " e : I
report by using the scroll bars at T T T gl
the left and at the bottom of the  [fu ., e
screen. e e g
To print a copy of the report, e Saskinces | 1 e e o oo oo s
o Clickthe Printbutton at [ s« e wmwis e s %

the bottom of the screen. o o o e i o
The Save As Text and Save As il B L
Rich Text buttons allow you to [ s s s s o ariem: oo
save the report to a file on your [ I [ e =

PC.

Bl Edt Yew (ks Window Heb
1bBaT | &+ ¢

The Done button closes this screen and returns you to the output list screen.

Deleting Reports

frs Trns-port PES

Over time, this Process Status List
window will grow to the point that the
scroll bar is needed to see all of the

File Edt Wiew Utlities ‘Window Help
ixBaEs 0 | T t]a

pr Process Status List

Regular | scheduled |

reports. Each user will need to delete

LASPTSM

LASPTSMG

Completed

1101504

o 07:00 pm

a7:00 prr

156.75.184]

reports that are no longer needed. To do 0500 em
. LASPTSM LASPTSMG Completed 1101504 07:00 pm 07:00 prm 156.75.184]
thls, LASPTSN LASPTSMH Completed 1101504 0653 am 0500 am 05:03 am 156.75.194
LASPTSM LASPTSMG Completed 1101504 06:52 am  07:00 pm 07:00 prm 156.75.184]

e Hold down the cTRL key.

e Click each process to be deleted.

LASPTSM

LASPTSMG

Completed

Completed

Completed

Completed

T1016/04

0653 am
06:52 am
0653 am

06:52 am

05:00 am
07:00 pm
05:00 am
07:00 pm

a7:00 prr

a7:00 prr

166.76.184

LASPTSM LASPTSMH Completed 111504 0B53am  0500am 05:03 am 156.75.194

- LASPTSM LASPTEMG Completed 111604 06:52am  07:00 pm a7:00 prr 166.76.194

In this example three records have | cew v conpiend T S Eom e e e
b h' hl h d LASPTSM LASPTEMG Completed 111604 06:52am  07:00 pm a7:00 prr 166.76.194
een Ig Ig te . LASPTSM LASPTSMH Completed 111504 0B53am  0500am 05:02 am 156.75.194
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e After highlighting the rows to be
deleted,

e Place the cursor on one of the blue
bands.

e Rclick to open the Mouse Button
Menu

e Click Delete.

A delete confirmation window will open.

e Click YESTOALL

The Process Status List window will
appear. It will be necessary to routinely
delete unneeded process files.

Printing Reports
To print the report,

= Trns-port PES

FEle Edt Wew Utlties Window Help

ixBaes B | v o«

= Process Status List

Regular | scheduled |

LASPTSM LASPTSMG  Completed 1171504 0B52am  O700pm  0F00pm 15575104
Completed 05:00 am
LASPTSM LASPTSMG  Completed 111504 0&52sm OT00pm  0F00pm  156.75104
LASPTEM LASPTSMH Ccompleted 111604 D653 am 0500 am 05:03 am 16676194
LASPTSM LASPTSMG  Completed 111504 0E523m 0T00 pm 15675194
Cornpleted
Completed 07:00 pm
Completed FProcess Eles
LASPTSM LASPTEMG  Completed Bun Process. . 0T.00pm 0700pm 15675194
LASPTSM LASPTSMH  Completed 111504 0B53am  05D0am  0503am 15575104
LASPTSM LASFTSMG  Completed 1N&04  06:52am 07.00pm  0700pm  156.75.194
LASPTSM LASPTSMH  Completed 111504 0B53am  05D0am  0502am 15675104
LASPTEM LASPTEMG Completed 11116/04 06:52am 0700 pm 07:00 pm 16676134
LASPTSM LASPTSMH  Completed 1171504 0B53am  05D0am  0502am 15575104
fre Confirm Delete
Delete row:
Process Hame = PESGPDE
Profile Name = PESGPDEE ?
Yes 1 Yestodl | Ho | Cancel |

¢rs; Trns-port PES

File Edit View Utiities wWindow Help

[lreas | & | vi | t|8]

&+ Process Status List

Regular | scheauted |

PESGPDE PESGPDEA Completed 09/04/03 02:48am  09:48 am 08:48 am 156.75.19:
PESGPDE FESGPDEB Completed 09/04/03 0858 am  08:99 am 09:00 am 196.75.194
PESGPDE FESGPDEA Completed 09/04/03 09:23am  09:23 am 09:23 am 196.75.194
PESGPDE PESGPDEA Campleted 09/04/03 09:48 am - 09:48 am 09:48 am 15675195

FESGFDE FPESGFDEB Completed 09/04/03 0343 am  08:43 am 03:48 am 16676195
Completed 12:35 pm

PCSECLIN PCEECLING Completed 09/08/03 01A0pm 0110 pm 01:40 pm 16676195

PCEECLIN PCBECLINE Completed 09/08/03 0MA5pm 0115 pm 01:14 pm 16675195

PESGPDE PESGPDEA Completed 09/08/03 08:20am  08:20 am 08:21 am 156.75.195

LASGRTE LASGBTEA Completed 09/08/03 1018am 1018 am 1018 am 156.75.195

To printthe current object, select Print.
To change wour printer ar printer options, select Printer Setup.
To cancel printing, select Cancel.

e Click the Print button

A window will open showing the default printer

you set up for Citrix. Currert Pricter

e Click Print again and your report will go VBT I s

to the designated printer.

Printer Setup Cancel

If your report is printing in Portrait, click the
Printer Setup button, and at the layout tab, change the layout to landscape.

NOTE: If you have not previously done so, you will need to configure Citrix MetaFrame to
print your reports. Follow the procedures in Appendix D.
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Creating Proposals

A Proposal in PES is one or more projects that are going to be let as one contract. A Proposal
becomes a Contract once it is awarded. In a Project, you had Category and Project Line Item
Numbers. In a Proposal, you will have Sections and Proposal Line Numbers that serve a similar
function in managing the proposal. In a project, the Combine Like Items flag determine which
items are combined for bidding purposes. The Combine with Like Categories flag controls how
categories are presented to the Bidders on the Proposal. If Categories and items are set to
combine, then the quantities will be added together and presented only once on the Proposal for
bidding. Sections are created from Categories. The example below illustrates what happens in a
Proposal when two Projects are “strung” together under the same Proposal.

Project A Project B
0484 0541 0484 0541
Intermediate Litter Removal Intermediate Litter Removal
Machine Machine
Mowing Mowing
Proposal
A\ 4
Section 0001

In this example, the Categories in both Projects are set to combine, with an X in the Combine
w/Like Categories box. All of the items in each Category are marked to Combine with Y in the
Combine flag column on the worksheet.

In some views, flags may be set with a check mark (V), while in other views they may be set with
an x. In either case, these marks are converted to Y when the data is saved and transferred to the
database. If a box has a "blank in it, it is transferred to the data base as an N.

The Proposal automatically rolled up all of the item quantities in the Categories for both Projects
and put them in Section 0001. Each item will appear in Section 0001 only once.

If any category had been marked as Combine = N, then another Section would be created. If any
item had been marked as Combine = N, then that item would appear twice (or more) under the
combined Section 0001.
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Like a Project, a Proposal has a Control
Group assigned to it to control who can
see which Proposals. When you create a
Proposal, it defaults to your personal
Control Group. Change this
immediately if you have an "*" or "?" in
your group. It must be changed prior to
adding a project to the proposal. Save the
Proposal after you fill in the Proposal
General Tab and then reopen the proposal
to add the rest of the Proposal information
and attach Projects.

To access the Proposal List window,
e Press the Proposal button. [

To Add a new Proposal,

e Rclick in the Proposal List window and

e Select Tabbed Folder Add.

For the Proposal, we will be doing everything with

the Tabbed Folder functions.

Proposal Data
The General Tab

General Tab Page 1
This is the blank Tabbed Folder for a new

pr; Trns-port PES

Eile Edit View Utiliies Window Help

1xBas || Yi |t coxenEBe |

EBCEB-RO SMF MAINTENANCE AND CAMNAL CLEANING MC
ESCET ASPHALT MAINT. & SINKHOLE STABILIZATION MC
EBCE8-RO SIGN MAINTEMAMCE MC
ESCES STRIFING REHABILITATION D

SHOULDER REHABILITATION

Add

E8CA1 SHOULDER REHABILITATION
E8Co2 SHOULDER REHABILITATION Change

EBCI3-RD GUARDRAIL & FENCE MAINTEMANCE B

EBCa4 GUARDRAIL POST AND BLOCK REFLACEMENT Tabbed Folder Add
E8CA5 ATTENUATOR REPLAGEMENT Tabbed Eolder Change
EB8C08-RO MOWING & LITTER REMOVAL Tabbed Folder View
EBCAE-R1 MOWING & LITTER REMOVAL

EBCA7-RD MECHANICAL SWEEPING Proposal

E6Ca8 MOWING & LITTER REMOVAL e Rl e
EBCa9 ADD SUNPASS Proposal Dgscription
EBDN0-RO BRIDGE SLOPE HERBICIDE Acdndurn List
EGD01 SLOPE & SHOULDER MAINTENANCE e
E8D02 PERMIT MODIFICATIONS Spclal Proisions List
ESD03-RD TRAFFIC CONTROL DEVICES Sl Lol U
EED04-RO GUARDRAIL & FENCE MAINTENANCE EEETmlES

E8D05 SLOPE IMPROVEMENT & BEAUTIFICATION Letting Propozals
EED0E-RO TURF MAINTENANGE R
E8D0T-RO TURF MAINTENANCE n

pre Trns-port PES

File Edit Yiew Utlities Window Help

[1 % Bla=

Proposal. Notice the similarity to the ot A IR, T S
Project Tabbed Folder; there is a General Goneal | varpton | swos | omets | gt proauns | ocsams |t | e sl | atctmont |
Tab with two pages of information and “rmt et
other tabs that contain other groups of
records that pertain to the Proposal. The
Department is not using the Special Euxein] Lo
.. FrediStale Projoct No. s Call PCH
Provisions, FY Schedule, or Attachments Lot '
Tabs at this time. e — s [ ORE
Highway Tyoe:] Bid Methoo:
Higkrway Musmiber: Contract Type:
PrimanyCistrict 4 ConrariWork Types|
Control Group; et Aside Propossl
Coundes| [ DBEMEE Goal Pomifiog
lass \'4:: 3:2 g«i}: ——
PRI uual.mastos:r_l__l_
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Page 1 of the General tab has the following 26 fields:

Contract ID A unique identifier for a proposal or contract. The system will accept 15
alphanumeric characters. Maintenance contracts will have Contract Ids in one of the
following forms.

District Let Contracts: Enter the planned District Contract number in the
general form E#??7?, where # is District Number and
?7?? is a sequence number. Do not enter dashes or
spaces.

Purchase Order Contracts:  Enter the Encumbrance Number assigned by Contract
Funds Management System (CFM) in the form #P????,
where # is the District Number and ???? is a sequence
number. Do not enter dashes or spaces.

Renewable Contracts: Enter the regular District Contract Number as above
followed by —RO0 (Rzero).

Memorandum of Agreement: Enter in the form of #????, and select MMOA in the
Contract Type field.

Letting Number A unique identifying number or alphanumeric for a letting. It may be
composed of any combination of eight numbers and letters. For lettings in the districts,
allocate two positions for the district number, two for the year, two for the month, and
two for the date. This will be in the form of #YYMMDD, where ## represents the
district number. If the occasion should arise that you will hold a second letting on the
same date, you may insert a "B" in position seven. The Central Office lettings
commence with a prefix of CT. This field will not be filled now.

Call Number  The order in which bids will be opened for a specified proposal during a bid
letting. This field will not be filled now.

Description A short description of the proposal.

Federal/State Project Number  The federal or state project number identifying a project,
proposal, or contract. Leave the default value of N/A for Maintenance contracts.

Contl PCN  This is the lead project to be associated with the proposal. Enter the Financial
Project Number of the lead project.

Location  The site where work is being performed for the proposal.
Route Number  The route number or road number of the road that is affected by a project.

Pay Item Year The Item year identifier for Items to be used for the proposed contract.
This value is set to 00.

Spec Bk Year  The Specification Book to be used in the administration of the contract.
The default value is set to 04.

Road System A classification of the road. Select from the drop down menu.
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Proposal Type A classification for the proposal. Choose from the drop down list to
identify a proposal as either to be let in the District or in the Central Office.

Highway Type  Not in use.

Bid Method Choose a value from the drop down list, or leave the field blank if Innovative
Bidding is not involved.

Highway Number  The identifier for the road being worked on in a project.

Contract Type A value, selected from the attached CONTTYP code table. For
maintenance contracts choose a value beginning with M.

MAM Maintenance Asset Management

MC Maintenance Contract

MCS Maintenance Contractual Svcs Contract
MEC Maintenance Emergency Contract

MG Maintenance Grant

MMOA Maintenance Memorandum of Agreement
MPO Maintenance Purchase Order

Other Contract Types you will see in this table are:
Construction Contracts
CC Construction Contract
CDB Construction Design Build
CEC Construction Emergency Contract
CFR Construction Fast Response Contract
CHW Construction Hold Witness Contract
CLS Construction Lump Sum Contract
CPB Construction Push Button Contract
Traffic Operations Contracts
TO Traffic Operations Contract
TOPB Traffic Operations Push Button Contract

Primary District  The managing district.

Contract Work Type  For Maintenance contracts; leave the default value “I” — Other in
place.

Control Group  On adding a new proposal, your personal Control Group will be entered
into the Control Group field of the proposal header. If your personal control group
contains ? or *, you will have to change this control group before you can save the
proposal header. Enter a Control Group composed only of numbers and letters.

Set Aside Proposal  Leave this field blank.
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Counties  You can enter up to four counties for each proposal (select from the drop down
list). Trnseport prints this information on some reports, but does not use it in
processing.

DBE/MBE Goal (PCT) Not in use at this time. A percentage goal set for disadvantaged
(DBE) or minority (MBE) business enterprises for a proposal. The default value is
0.00.

WBE Goal (PCT) Not in use at this time. A percentage amount indicating the goal you
have set for women business enterprises for the proposal. The default value is 0.00.

Proposal Class  Select a value from the attached PROPCLS code table.

Prop DBE Goals Not in use at this time. A value, from the attached DBENOTE code
table that indicates which of the two goals applies to this proposal. If you choose
NONE, Trnseport will not print goals on any report. If you choose DBE, Trnseport will
only print the DBE/MBE goal and will label it a DBE goal. If you choose BOTH,
Trnseport will print both the DBE/MBE goal (labeled as an MBE goal) and the WBE
goal. Select the one you want from the drop down menu.

Qual. Classes Not in use at this time. A classification of work for which a vendor is
qualified.

General Tab Page 2
Bid Bond Not used at this time.

Gl [t Yew (RMter Window Ll

Prev Let As ContlD Indicates the IR L Lo
Contract ID under WhiCh a Gowesl | Ceserpron | Gies | Projects | SpecialPrivisions | Sectens | hems | Py Genedule | Asschments |
. © paged page 3
proposal was previously
advertised.
Cost of Proposal Package Used for e —— e

Secsan Assignment (7]

planholder invoicing in the LAS
module. This field shows the
cost of the proposal package (bid
blank, plans and specs). It has a
default value of 0.0. This should
be the cost before taxes.

Section Assignment  Flag telling Trnseport if you want to assign project categories to
proposal sections automatically or do it yourself manually by entering section numbers
in the category records. The default value is Y, which means Trnseport will
automatically assign categories to sections.

Cost of Plans  Used for planholder invoicing in the LAS module. Trnseport will bill this
cost to purchasers of complete plans for a proposal. The default value is 0.00. This
should be the cost before taxes.
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Special Provisions  This feature is not in use at this time. It is a flag used to tell Trnseport
if you will assign special provisions to this proposal. The default value is N (you have
assigned no special provisions). Do not change this flag.

Cost of Specs  Used for planholder invoicing in the LAS module. Trnseport will bill this
cost to purchasers of complete plans for a proposal. The default value is 0.00. This
should be the cost before taxes.

Cost of Proposal Used for planholder invoicing in the LAS module. Trnseport will bill
this cost to purchasers of complete plans for a proposal. The default value is 0.00. This
should be the cost before taxes.

Last Addendum Number  The last addendum number used for a proposal. Trnseport
enters this field automatically.

Min. Order Fee Used for planholder invoicing in the LAS module. Trnseport will bill this
cost to purchasers of complete plans for a proposal. The default value is 0.00. This
should be the cost before taxes.

Last Description Number  Trnseport enters this field automatically when you enter long
descriptions.

Acqui. Time  Used to identify special acquisition times for specialty items required to be
fabricated under construction contracts.

OJT Flag To identify contracts where OJT is required of the contractor. Not required for
maintenance contracts.

Special Start Date  Used to identify a delayed start to a contract.
Proposal Notes  Not in use.

If you have only one Project
attached to a Proposal, you can
populate some of the basic
proposal information by filling
in the Cntl PCN project and
importing the data for the
Controlling PCN. This is also
applicable for the lead project
where two or more projects are
strung together.

After you enter the project
number in the Cntl PCN field, from the Menu Bar,
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e Click Edit> Import Controlling
PCN Data.

This will enter information that is
common from the Project Record.
District, Pay Item Year, Description, etc.
This can save some typing if the proposal
information will be the same as the
project information, as well as reduce the
chance of introducing errors.

A confirmation screen will appear. To
continue,

e Click Yes.
To stop the process,
e Click No.

This box tells you what data will be copied over
from the Lead Project Numbers Project Header.

Once the information is over, you can
change it.

When you use the Import Controlling
PCN function, the Controlling Project is
automatically attached to the Proposal and
will appear in the Projects Tab.

Page 1 will appear like this when all of
the necessary fields have been entered.

The Description Tab

After you have entered the General
information, you can move to the
Description tab.

Enter as detailed a description as possible.

s | FY Schedule | Attachmants |

Contract D Listing Mo Call
Dezchiption:
FeiStats Project Ho. e crtl Pon: IR~ |
Location:
Risulis Kurnkics Pay liam Yoar [0 Spec Bk vearfia
foad System: Proposal Type:
Highway Typa: Eid Methor
Highway Number Contract Type:
Pramiry Disrict L Conlract Wark Typir
Coritral Group;[ Eut Agide Froposal
Caunties: DEEIMBE Gosl (PCTY .00
WHE Goal {PCT) 100
Proposal Class: Frop. DEE Goals:
Gl Gl |

PES - Proposal Tab Folder E

2)

Importing Conkrolling PCH's data will affect the Following Fislds:
- FederalfState Project Mumber

- Spec Year

- Description

- Location 1, Location 2

- Counkyl, Counky2, County3, Countyd

- Fouke Mumber

- Road System

- Primary Diskrick

Do wou wish ko conkinue?

o Trns-port PES
B Ede Wew Utiws Wndow el
i1=Boe A g 13

1+, Proposal £5G97

General | Duscrgtion | &tos | Projucts | Spoeial Provisions | Sections | moms | P Schetul | Atachemars |

= opaml O paged

Conlract ID: E&GAT
Descriplion. MILL & RESURFACE
Fedéstate Project Mo, jhA
Location: MISCELLANEOUS LOCATIONS

Lifting Mo 08040203 Call 008

ol PoR: 1431827201

Roulex ks
Ruoad System
Highwsy Type:

Highway Number:

Primary District [0 L Corfract¥ork Typec)
Cantrol Grouy: LS St Asicle: Proposal
Caimlie [3 DBEMBE Goal (PET) [0 00
WEE Gosl (PCTER.00
Proposal Class:jl Prop. DBE Goals:

Uual Clagses:

frs; Trns-port PES
File Edt Wiew Ukities ‘Window Help

1keas  &WE | 2 | v | ¢

i Proposal EBE5SY

General Description | Sites | Projects |Specia\me5ion5| Sections | ltems |FYSchedu\e|Aﬂacl

Work under this Contract congists of praviding all labor,
materials, equipment, and incidentals necessary to
rehabilitate shoulders and slopes by reworking shoulders
including local stabilizing material, finish soil layer
preparation, sodding, and watering, at various locations on
Florida's Turnpike, MP 100.0 to 200.
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The Sites Tab

A Site in PES is a record that has information about the contract time or times within a Proposal.
A Site record could represent various physical sections of the Project, like Structures for
example. Or, a Site can be any other division of a Project.

The Site 00 record. This record will
contain the total contract time for the
Proposal, and is required by the system.
On a new proposal, the tab will be empty
as seen at the right. You must add at least
one row of data.

If the Sites tab looks like this
e Rclick in the white space.
e Click Show Detail.

This will show all the Site records in the
top half of the screen and the detail for the
selected record in the bottom half of the
screen. Always show the detail before
adding a record.

The screen will now have a white area in
the center, and a lower portion in which
detail will be entered.

e Rclick to open the Mouse Button
Menu.

e Click Add

fri Trns-port PES

Fle Edic Yiew Utblities ‘Window Help
lixmas ®E | = | v | ¢

= Add Proposal

Genera\l Description Sites |Prmects |SpemaIPrnvismns| Sections | fterns |FVSEhedu\e|Aﬁachmenls|

Find Site Number: |

Lle de Yew (hities Wndow el
ixBas R | & T @
General | Deseripion | SMes | Prolects | Speclal Prosisions | Gechans | ttems | £ Scheouls | Amscnmens |

Fiod Se Numbar: [

1+, Trns-port PES

L Edt view LRtws Window |k

1E@as " ik &

Geners| | Cescripon  Sites | Projects | Gpeclal Provisions | Sections | ttems | Py Scniedute | Anachments |
inel Sie Nurnber: |
—————
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The screen is now ready for Site data.

Site Number 00 has opened as the default.

This is the required site to show contract
time and type of days.

Required fields for the Site Tab are:

Site Number Use the default value
of 00.

Type of Days Choose from the
drop down menu. The usual
choice will be CD from the
TIMMETH code table.

Number of Days  Enter the number
of days planned for the work. If
Type of Days is chosen to be

= Trns: port PES
File Edic Yiew Utlites Window Help

lixBas ®FE | =2 | vi | &
frs; Add Proposal

Genersl | Descripton | Sites | Projects | pecialProvisions | Sectons | fems | Py Schedule | atachments |

4l |

-Site Details

Site Nurnber: [00
Liguidated Damages per Day: [
Type of Days: [0 B ase peroay
Number of Days: [150

Road User CostPer Day: Entefing & value indicates (A+H) Site Time Cost

Maximum Days:

Specified Start Date:] _00/00/00 @ Number 2
Specified Completion Date:| 000000 @ Date 1:[_owonioo__ ©|
Description:] Contract Time -
Long String 1 Time 1
Long String 2 Tirme 2

Calendar or Working days, then a number of days must be entered. If the type of days
is Completion Date, then the Specified Completion Date must be entered and the
number of days need not be entered.

Liquidated Damages per Day there is a default value of $1.00. Liquidated Damages will
be handled in SiteManager. The Site 00 record information passes over to Site Manager
as the Original Contract Days. Other Site records pass to Site Manager as Milestones.

Description  Enter "Contract Time" from the SITEDES code table choices.

When complete,

e Click ok

And the information in the detail panel will transfer to the data row in the upper portion of the
screen. The Site 00 data will look similar to the screen above.

The Projects Tab

Attach the Project(s) to the Proposal. Go
to the Projects Tab. If you used the
Import Controlling PCN function, you
will already see the Cntl PCN in the
Project List in the lower window.

To assign one or more Projects to the
Proposal,

e Click the Project or use the
<Shift> key or the <Ctrl> key to
select multiple Projects.

1 Tmsport PLS

e B Yew \ties Wrdow el
lkEas kW | & T ®

1. Prupusal ESFITA
Ueneral] Description | Sites Projects |SDaoa|Hms|cN|s] Sactions | nerms I
Find Project Comrol Number:

| Atachenents |

Prujucts Master List: | a| w| v
Find Project Control Bumber: [ [t Selected

193NN A U517 SE{MARION AVE) E uw
19303215201 HIA g 41

19384R25701 15020077 2R 70
5723101 s
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e Click the single Up-Arrow
button.

The Projects will then appear at the top of
the screen and are now associated with the
Proposal.

If you did not select a Controlling PCN on
the General Tab, you may place a check
mark in the Controlling PCN box on this
tab.

Note that all of the projects displayed in
the lower panel are of the same Unit
System and Pay Item Year.

¢r= Trns:port PES
File Edit View Utlities Window Help

lixzBas pE | = | v | & |

s Proposal T29898

oeneral | Deseription | sites Projects |Spec|a\Prawsmns| Sections | terns | v conzduie | Atachments |

Find Project Control Number:

Projects Master List:

Find Project Contral Number:

i}
SR 371 GAINES STREET
SR 10 {US 90) MAHAN
SR 145 PERRY STREET
SR 30 (US 88)
SR B1 {US 88 & 318)
BLOUNTSTOWN GREENWAY

21877016201 MR
21984315201 [RI}
22025415201 A
22061216201 42240170
22062016201 4224012P
22112815201 [RI}

i}
i}
i}
i}
i}
i}

M
M
M
Mt
M
M
M
It

22247115201 A SRABA1-10& 110 ** TRAINING ** 00

«» Warning: In the Tabbed Folder Change mode, PES has checks to block a project from
being attached to more than one proposal. You can make such attachments through
the Drill-Down method. DO NOT attach projects to proposals using the Drill-

Down mode of PES.

Sections Tab

When you enter the Sections tab for the
first time after attaching projects to it, you
will get this message box. It is telling you
that you must Generate Section and Line
numbers for the Proposal.

This process rolls up like items and
categories for the proposal.

e Click the ok button.

1x8as | ¢H 3 EEEE

Genarat | Detcription | Sees | Prejects Wl\ml Sactions | meme | Fv Scnadule | Asschmants |

[Find Sctian Mumber: |
I

FES - Propasal Tab Folder

3) i e Rt

Saectson Detalls
Proposal Section Number. 01001
[PAVEMENT ETRIFING {LARGE MACHINE)

Gt ate Section & Line Nurnber s

If the screen has a large area of white as seen previously for the Sites tab,

¢ Rclick to open the Mouse Button Menu.

e Click Show Detail.

e Click Generate Sections & Line Numbers button
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If one of your projects or a category

File Edit Wiew Ublties Window Help

contains no items, you will receive a ArBas | kW | & | v | ¢
message like the one at the right.

Generall Description | Sites | Frojects |Snecia\Prowsmn5 Sections | Iterns |FYSchedu\e|Atta

Exit the Proposal and correct the problem | s

in the Project, by either adding items to T
the Category, or deleting the Category if it
is not required in the contract.

e Click ok on the message box, "'“"“
- - - The following project(s) do not have any items:
e Click the X in the upper right hand

corner of the Add Proposal
window and save the Proposal

Return to the Proposal List window.

When adding a proposal or a project the first time using Tabbed folders, do NOT try to save the
proposal or project by choosing File >Save from the Menu Bar, or by clicking on the Save &
icon on the Tool bar.

After the project data has been corrected,

Fle Edi Wew Ubities MWindow Help

and section and line numbers have been ~ |2k8as ®a| - ve &

generated, the Section Tab Wi” now General | Description | Sies | Projects | Special Provisions  Sectians | tems | P Schedule | Atiachments |

Find Section Number: |

appear like this with one or more sections.
Review the section descriptions, and
revise them as necessary. The default
titles are the description of the lowest
numbered Maintenance Activity for the
Categories that made up that Section.

This description will print on the Proposal
Schedule report that is sent to prospective
bidders' -Section Details

Proposal Section Mumber: 0001
Description: |PAVEMENT STRIPING (LARGE MACHIME)

The Generate Section and Line Numbers Process

When initiating the process, Trnseport combines the project categories and project items in the
following way:

e All categories whose FEDCCLS fields are the same will be combined, except when a
category is an alternate.

e Items from alternate categories are combined with alternate categories in other projects
only when the alternate codes for the categories in both projects are identical.

e Trnseport assigns a unique section number to each proposal section and updates the
database record for every category to reflect the section to which it is assigned.

Reference Manual for Maintenance Projects PES Release 5.7b Page 68 of 117



Trnseport aggregates items within combined categories (proposal sections) when the
items have the same Item Number and Proposal Supplemental Description. The
exception to this is that lump sum items are not automatically flagged to combine.

Trnseport removes items that are members of an alternate Item set from the section and
places them in a section describing the alternate relationship.

Trnseport combines alternate items across projects only when identical alternate codes are
used in both projects.

If an Item has been marked to not combine, Trnseport will not combine it.

The process of generating section and line numbers will roll up the project-level items and
categories to the proposal level and assign proposal line numbers and section numbers to the
items and categories. Trnseport uses the section and line numbers assigned through this batch
process to generate the proposal items in the Trnseport LAS initialization process. All proposal-
level reports will use these line number assignments.

Proposal Level Reports

Generating a Preliminary Detail Estimate

pr; Trns-port PES

File Edit View Utilties Window Help

To run a Preliminary Detailed Estimate at |1 =Bas | & Vi | ¢ 20A926EEBE |

the Proposal Level

EBC2E STORMMNATER & PIPE MAINTENANCE - ZONE 3 MC
. EBC2T LIGHTING MAINTEMNANGCE MC
RCI |Ck to open the Mouse Button EBC2T-R1 LIGHTING MAINTENANCE e
EBC28 STRIPING (RESURFACING) add M
E8C28 STRIPING (RESURFACINGI F cpanae [
Menu EBC30 TURF ESTABLISHVMENT Delete... Mmc
EBCH LAKE COUNTY _— cD
EBC3Z MOWHNG & LITTER REMOWAL  Tabbed Foldar Add MC
CI |Ck Run Process EBC33 ST LUCIE CO. BRIDGE Tabbed Folder Change cD
EBC34 DADE CO. BRIDGE Tabbed Folder View cD
EBC3s ASPHALT LEVELING Proposal MC
EBC3E BOCARATON TOLLS DATA C Proposal Prafec List DB
EBC3T MOWING & LITTER REMOWAL O — MC
EBC3E LAMDSCAPE MAINTENANCE Addendum List MC
EBC38-R1 LANDSCAPE MAINTEMNANCE T — MC
EBC33 MOWING & LITTER REMOWAL i e e MC
EBC38-R1 MOWING & LITTER REMOWAL Site Lacations List MC
EBC40 MOWING & LITTER REMOWAL Section List MC
EBC40-R1 MOWING & LITTER REMOWAL Letting Propossls MC
EBC41 GUARDRAIL & FEMNCE MAINT MC
EBC41-R1 GUARDRAIL & FENCE MAINT MC
Click Generate Preliminary Detail Estimate. iz Processes
Generate Master Payitern List -
‘Generate Preliminary Detail Estimate
Generate Proposal Mumber Change Report
enerate Proposal Schedule
Generate Section and Line Mumbers (nguiry)
Generate Section and Line Mumbers (Update)

List Contract Praposals
List Froposal Addendums ;l

OK I Cancell Help |
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A window opens to choose which parts of

/i etail Cost Estimate Parameters
the report are needed. page1 |
e Uncheck boxes that are not needed. Select Reports:

Detail Estimate Cover Page: @
e Click Submit. Cost Summary:
Cost Estimate: @

Funding Summary: v
Funding Summmary by Unit:
Funding Summary by Fund:

Select Data Sources: Default Database is PES

Letting and Award System (LAS): [
SiteManager Systern [

Submit I Parameters Cancel

Generating the Proposal Schedule Report (Bid Blank)

The Estimator will have the capability of generating the Proposal Schedule Report (bid blanks).
This should be done to verify that all of the items and sections rolled up as desired and that non-
bid and fixed price items were appropriately marked. In addition, it is possible that the Estimator
will want the change the estimated unit price for an item after they see the rolled up quantity.

To run the Proposal Schedule Report, \; Processes

Generate Preliminary Detail Estimate -]
Generate Proposal Mumber Change Report
‘Generate Proposal Schedule
Generate Section and Line Mumbers {nguind
Generate Section and Line Wumbers {Update)

|

e Rclick to open the Mouse Button Menu.

e Click Run Process

List Contract Proposals
List Proposal Addendums
List Proposal Pravisions

OK I Cancell Help |

e Click Generate Proposal Schedule.

A window opens to choose which parts of

the report are needed. P“I il L ]
Pra osaICwerSheetF
¢ UnChECk boxes that are nOt F‘roposaIpSchedule of ltems:
needed. Praposal Estimate: [

Special Provisions Listing: [~
. . Special Provisions Text [
[ ] CI'Ck Subm't Quantity Sheet Summary: [~

DBE Interest Repart [~
Generate Pass File to EBS: [

EBS Pass File Mame: IW
Preparlng tO Advertlse Submit I Ealamelelsl Cancel |

When the proposal is complete and ready
to transfer to the district Contracts Administration Office, open the Proposal Header and change
the Access Control Group from MD## to ML##. At the same time open the project headers of
all associated projects and change their Control Groups to ML##. The District Contracts
Administration Office will then initialize the proposal in LAS and prepare the advertisement
documents.
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Creating Addenda in PES

Once a Proposal has been advertised, then
all future changes made to the
project/proposal scope must be made
through an Addendum.

Create an Addendum, from the Proposal
List window.

e Click the proposal

e Rclick to open the Mouse Button
Menu.

e Click Addendum List.

A window listing all addenda for the
proposal will open. You must first create
an Addendum Header and then you can
add the Addendum items.

To create an Addendum Header

e Rclick anywhere in the white
space to see the Mouse Button
Menu.

e Click Add.

The Addendum Number is automatically
assigned, commencing with 0001.

e Enter the Date of the Addendum
in MM/DD/YY format.

e Enter a Description up to 60
characters in length.

e Click ok when done.

frs Trns-port PES

Fle Edit View LUbities Window Help

ixBaEz | v |t 2o xsaE@e |

[Contractm pescripion  mwe
EBC2E STORMWATER & PIPE MAINTEMANCE - ZONE 3 mMe:
EBC2T LIGHTING MAINTENANCE mMc
EBCIT-R1 LIGHTING MAINTENANCE MC
EBC2E STRIPING (RESURFACI S
E8C23 STRIFING (RESURFACIL o CO. MG
EBC30 TURF ESTABLISHMENT - 20" MC
EBC31 LAKE COLNTY e E— co
EBC32 MOWING & LITTER REMC  Tabbed Folder add me
EBC33 5T LUCIE GO. BRIDGE Tabbed Folder Change cD
E8C34 DADE CO. BRIDGE Tabhed Folder View ch
EBC35 ASPHALTLEVELING MG
EBC35 BOCARATONTOLLEDA | 0 0 ot py DB
EBC37 MOWING & LITTER REMC o MC
EBC38 LANDSCAPE MAINTENAR puryrrmrpmrymy M
EBC38-R1 LANDSCARE MAINTENAHSSEESTER 558 Mc
EBC39 MOWING & LITTER REMC R0 R mMc
EBCIS-R1 MOWING & LITTER REMC 270 8 mMc
EBC40 MOWING & LITTER REMC 220 MG
EBC40-R1 MOWING & LITTER REMC B 0700 MG
EBC41 GUARDRAIL&FENCEM,— " MG
EBC#1-R1 GUARDRAIL & FENCE M¢  Run Process... MC
EBC42 GUARDRAIL & FEMCE MATNTERNANCE e

| ;

{ Trns-port PES
Fle Edt Yiew Utlties Window Help

[1xBas | B | v | &]2%

15, Trns-port PES

Fie Edit Yiew Utiities Window Hep
leeas | = | <

i1 Add Addendum Proposal EDOtest2

Page 1 |

Proposal Addendum Mo.: j000001
Date of Addendum 09/03/03
Description: JAdd Slope Mowing
Generic Code 1:[

=]

K Add More | Cancel
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Adding New items

To add the Addendum items,

e Rclick the Addendum row to see
the Mouse Button Menu.

e Click Addendum Items.

e Rclick in the white space to see
the Mouse Button Menu.

e Click Add.

e Click New Item to add an item to
the proposal

Other choices are:
Add>Modify item Add>Remove
item

In this example add an item.

On this screen enter in sequence:

e Project No., by selecting from the
down arrow.

e Category Number by selecting
from the down arrow.

e Project item Line No. that does
not already exist.

Recall that Project Item Line Numbers are
initially generated in steps of five. These
gaps allow the insertion of addendum
items in their logical order. Examine the
project worksheet or a copy of the
Preliminary Detailed Estimate and select
an appropriate line number.

e A Pay Item Number from the drop

(1 Trns-port PES

Fle Edt View Utiies Window Help

ixBas | B | v | e|ax

i+ Addendums Proposal EOOtest?

add
Change
Delete. .

Addendum
Addendum Items

R Process...

Cle [dt Wew Lelties Window b
i1=Bas | B N T
s Proposal E00Lest? Addendum 000001

{1i; TFns-port PES

fle Edt Vew Utiies Window Help

lixBas | B |

+:;Add Addendum Item Proposal EODtest2 Addendum 000001
Page 1 |

Project No.: [41063717 201w
Category No.:[0437
Project ltem Line No.: [0075
Type ofAction: A (A C, D)
Itern Number: [E104 4 2 4 MowiNG (SLOFE)
Estimated Guantity: [52.500 AC
Estimated Price: [10.25000
Supplemental Descr.

Supp. Desc. Required: [

Itern Alternate Code:
Speeffication Year: 00
Reviged Price;
Source of Price: [E

Est Price Lock: []

Generic Code 1

Combine with Like tems: (]
Non-Participating Fund Gode |

Nor-Bid ltem: (]

Pre-Established Price: []

Proposal Line Mumber: |035

oK AddMore | Cancel

down arrow, which opens the Master Pay item file.

e The Quantity for the added item.
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e Proposal Line Number. Examine a copy of the Proposal Schedule and determine where
the item should be displayed, and enter an appropriate number. Recall that Proposal Line
Numbers are initially generated in steps of five. These gaps allow the insertion of
addendum items in their logical order.

When these steps are completed,

e Click ok if there is only one item to Add or

e Click Add More if other items are

to be added.
Modify Existing Item

If the addendum is to modify one or more
item, choose Add>Modify Item as seen
above.

In this widow:

e Click the Project Number from
the down arrow.

e Click the Category Number from
the List Box

e Click the Project Line Number
from the List Box (the Pay item
and Proposal Line Numbers are
now identified).

e Enter the corrected quantity.

e Click ok, or Add More if other
item quantities are to change.

Deleting items

If an item is to be deleted, choose
Add>Remove Item above.

In this window in sequence Click:

e Project Number from the down
arrow

e Category Number from the down
arrow

e Project item Line Number from
the down arrow.

The deletion is now fully detailed, as all

rzy Trns:port PES

File Edit Yiew Utlties Window Help
[imBaE | B | &
1 Add Addendum Item Proposal EDOtest2 Addendum 000001

Page 1 |

Project No.: 4105371 7201w
Categony Mo.: 0433
Praject ltern Line Mo : j0015
Type of Action: G A, G, 00

Iterm Mumber: IUSTS 1 ﬂ S0DDIMNG
Estimated Quanlww.m— Y
Estimated Price: 2.05000 Supp. Desc. Reguired: [

Supplemental Descr:

Itern Alternate Code:
Specification Year. 00
Mon-Bid tem: [
Pre-Established Price: [
Proposal Line Mumber: [0060
Generic Code 1:

oK |Addﬁme

Cancel |

3 Tens-port PES
Eile Edit Yiew LUtlities Window Help

1oz | * | ¢

Page 1 |

Project MNo.: |41053717201%
Categary MNo.: 0436
Froject ltern Line No.: [TTER >
Type of Action: D (A, C, D)

Itern Number: 0577 70 SHOULDER REWORK
Estimated Quantity. 25200.000 sy
Estimated Price: 0.75000 Supp. Desc. Required: []

Supplemental Descr:

Itern Alternate Code: Combine with Like tems: B
Specification Year: 00 Maon-Farticipating Fund Code:
Revized Price: MNon-Bid Itern: []
Source of Price: E Pre-Established Price: []
Est. Price Lock: [] Proposal Line Mumber: 0065

Generic Code 1

oK | Add More | LCancel |

Reference Manual for Maintenance Projects PES Release 5.7b Page 73 of 117



other fields on the window are blue.

Addendum items WILL NOT show in the Items Tab in the Proposal Folder. The Addendum
items WILL show on the Proposal Schedule Report.

Generating the Proposal Addendum Report

To produce the Proposal Addendum
File Edit Yiew Utiities Window Help
report: [ixBaE | & Ti | t cO@ADEEEE
_
e Click the Proposal from the [Contractip ™ Deseription T e
. . E-GAGE DISTRICTWIDE STRIPING HAND WORK 02103 cD
PI‘OpOS&l Llst WlndOW E-fiAG8 CLEARING & GRIIRRING & TREE TRIMMING 0707 r
E-6ABS-RI wo Y |
1 S = enerate Preliminary Detail Estimate -
i RCIICk to Open the Mouse BUtton E-BAT1 DIs genera}e gru;usalgfmée‘rihtangle Report _I
E-BAT2 SIG | Generate Proposal Schedule
Menu E-BAT3 MOl genera}egec[tjmnalr?drlii:ell\lumhers(lnquinr)
E-BATS DEt G_enerate Section and Line Mumbers (Update)
e Click Run Process £ sane-Re o T
A A E-BA34-RD Nol |- A -
E-T967 SR
o Click List Proposal Addendums | e 8R| ok | comcer | uew |
. SH
° C||Ck OK. E1B73 SR 738 (HANSON 5T) cD
E1B382 COLLIER COLINTY MC
H E1B83 HIGHLAMDS COUNTY MC
SmeIt the process- E1B34 CHARLOTTE COLIMNTY MC

= f=T=FA LEE S nl IR fadn

If you make any changes to a Project or Proposal after it has been initialized in LAS, then the
Proposal will need to be re-initialized in LAS.

Sending the Proposal to LAS

When it is time to send the Proposal to Contract Administration for Letting the Control Group on
the Proposal and the Projects should be changed to be the Contract Administrators Control
Group and the Estimator should notify the Contracts Administration Office so they can initialize
the Proposal in LAS and attach it to a Letting. Once the Control Groups are changed, the
Estimator will no longer be able to access that Proposal or its Projects. If Addenda need to be
added to the Proposal, the Contracts Administrator will need to change the Control Group on the
Proposal back to the Estimator’s Control Group.

Running the Bid Tab Analysis Report in LAS

Because of the confidentiality of the Estimate, it may be the Estimators responsibility to run the
Bid Tab Analysis report in LAS.

To start LAS,
e DbIClick the LAS Icon on the Citrix Screen.
e Enter the PES/LAS UserID and password.

e Click ok.
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Open the Bid Letting list window by
clicking on the button that looks like an
envelope.

Then

e Rclick the desired Letting to see
the Mouse Button Menu. =y

e Click Letting Proposal List.

The Letting Proposal list window will
open.

e Rclick the desired Letting
Proposal to see the Mouse Button
Menu.

e Click Run Process.

e Click Generate Bid Tab Analysis.

e Click ok.

For the first run, select all reports including the

Engineer’s Estimate.

This set of reports will show the Engineer’s
Estimate on the reports in comparison to the
bidders' prices.

e Click Submit.

i\ Trns:port LAS

File Edit Y¥ew WUtiltes Window Help

limas | B | v | )5

BidLetting Number _ Dale of Letting__ Timeof Letting_ StatusofLetting |
08040720 07720004 230FM SCHD

08040722 0722004 230PM SCHD

08040727 07/2TIng 230 PM SCHD

08040803 0aMmnd 230 PM SCHD

08040810 08/10/04 T
08040817 08 TI04 230P M add

08040824 0824004 230 PM Change

08040301 09/0104 EmerDec Delete

08040813 0an 4ind Hurricane Tabhed Folder Add

08040821 D@rz1ine 230PM Tabhed Folder change

08040328 narzaing 230FM Tabhed Folder View

08040830 09300 2:30PM

08041005 10504 230FM

08041012 1012004 230PM

08041019 101804 2:30 PM RuN Pracess...

08041026 10726004 230PM BUAD

08041102 110204 230 PM SCHD

08041109 110904 230 M SCHD

i Trns-port LAS

File Edit Wiew Utlities Window Help

l1kBEaEs | B Y8 |t/ 2Eeen
i Letting/Proposals Bid Letting Package 08040810

Add
change
Delete.. .

Tabbed Folder Change
Tabbed Folder Wiew

Letting Proposal

DBE Contract Commitrments List
Planholders List

Bidder Information List

Bid Tab Estimation

tia; Processes

Generate Avwarded Vendaor Mailing Labels
Generate Bid Letting Summarny

Generate Bid Tab

(Generate Bid Tab An: 5
Generate Bid Tab Edit Report
Generate Contract Project Directory
Generate Contract Schedule

d ' |

OK

Cancel |

Help |

t#4s; Bid Tab Analysis Options

Page 1

Lowe Bid Summary: [
Tahulation of Bids:

Loy Bid term Analysis: W
Include Engineer's Estimate: [#

Submit IEalametersl Cancel |
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The second time you run the reports, do not check EEIRSYITTETTIINE
Include Engineer’s Estimate. Pege !

. . . Law Bid Summary: ¥

This second set of reports will be given to the Tabulation ofBids:E

.. . . Lo Bid [tem Analysis: v

Contracts Administration Office. ncluge Engineers Eotmate -
o CIle Smelt Submit I Ealametersl Cancel |

Rejecting Bids

When the situation arises that bids are to be rejected and a contract is to be re-advertised the
process will begin in the Contracts Administration Office. Certain fields in the Letting process
will be re-set to indicate that the bids are being rejected and the contract re-advertised.

The OId Proposal Header
Contracts Administration Office

e Change the Access Control Groups Of the proposal and all associated projects from
CL## to CD##, so that the district estimator who created the Proposal Header will be
able responsible for preparing the projects and creating a new Proposal Header for the re-
advertisement.

District Estimator
e From the Proposals List window, Highlight the proposal to be modified.
e From the right mouse button menu, select Tabbed Folder Change.

e Go to the Projects tab and select the single or double down arrow to remove the project(s)
from the proposal.

e After removing the project(s), close the proposal and save the file. This process makes
the project(s) available to be attached to a new Proposal Header.

e Change the Access Control Groups of the proposal from CD## to CL##. The old
proposal header will then be available in the appropriate contracts administration office
for history purposes.

e When the Save confirmation message opens, click YEs.

The Projects

Make any changes to the projects(s) that may be necessary. Particularly, if there were any
addenda to the original proposal, enter all changes into the projects before re-advertising the
proposal.
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The New Proposal Header

e From the Proposals List window, select Tabbed Folder Add from the right mouse button
menu.

e In many cases, using the Copy Special feature for projects, categories, and proposal can
save steps. In this case, however, it is important to NOT use the Copy Special feature.
If the original proposal had addenda attached to it, the number of the last addendum
issued, would be recreated on page 2 of the new Proposal General tab.

e When the new Proposal general tab window appears:

Go to the Cntl PCN: field, and from the list box select the lead project.
From the Menu Bar, choose Edit > Import Controlling PCN data.
Enter the new Proposal Identifier (“E” Number).

Click the page 2 radio button,

Enter the Old Proposal Number into the Prev. Let As ContID field.

O O O O o o

At the Projects Tab, Select any additional project or projects to be connected to the
new Proposal Header. Click the single up arrow.

o0 Click the Items tab. A warning window will open indicating that changes have been
made to the proposal Click ok.

o Click the Generate Section and Line Numbers button at the bottom of the window.
Change the Section Description as Appropriates

0 The reconstructed proposal Item information will appear in the Items tab.

e Save and close the tabbed folder by clicking on the X" for the tabbed folder window.

Special Contracts

There are three special types of Maintenance contracts that will be entered into PES/LAS, and
several other Innovative Bidding types of Contracts.

Memoranda of Agreement, Purchase Orders, and Contractual Service Contracts.

These contracts will be treated a little differently than other contracts in that they have already
been negotiated and awarded outside of Trnseport. They are being put into Trnseport for the
main purpose of transferring them to SiteManager.

These contracts will be entered into PES with the awarded prices put into the estimated price
field.
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Appendix A Glossary

AASHTO American Association of State Highway and Transportation Officials.

Ability Factor The numerical rating of the vendor's capability to perform work. It is a factor in
calculating the vendor's capacity; it is not a performance evaluation. See also Adjusted Net
Worth and Capacity.

Access Control Group Each user and each project and contract can be assigned a Trnseport
control group code. A given user only has access to those projects and contracts that have the
same control group as the user. (See Control Group)

Account Number The account number of the contractor who is setting up a securities account.
This number could be the same as the contractor's vendor number (as maintained in the Vendor
file) or the Contract ID number, depending on the Trnseport installation setting.

Accounting Fund Code The accounting department's code for a fund when it differs from the
Trnseport code.

Accounting Project Number A code the Accounting department can enter for projects.

Acquis. Time Available to indicate to bidders that acquisition time is available to procure long
lead-time items such as mast arms or other items needing to be fabricated.

Action The type of action (add, change or delete) to be performed by an addendum item.
Active Project The open or highlighted project (of possibly many) that commands will affect.
Active Window The open window (of possibly many) that commands will affect.

Addendum After sending proposals to planholders, handle subsequent changes through
modifications called addenda. Addenda allow modifications directly into the system to apply
changes to the proposal information before the bid letting. Send a copy of each addendum to
planholders as soon as possible so planholders can incorporate the changes in their bids.

Addendum Date The date the addendum is added or becomes effective.
Addendum Description A short description of the proposal addendum.
Addendum Number The sequential number identifying a proposal addendum.

Addendum Project Item Line No. A unique sequential identifier for an item within a
project. Choose a value from the attached drop down list. When you select a category number,
Trnseport fills in the Project item Line Number list with all Project item line numbers for the
selected project and category.

Additional Vendor Name A field for an additional name of the vendor.

Add-On An adjustment to the pay items of a contract after the award is made. This adjustment
is something other than a formal supplemental agreement.

Address Sequence Number A sequential number used to identify one of multiple addresses
for a single vendor.

Address The address of the district, area office, field office, or residency.
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Address Type A coded value indicating the type of address for the vendor (for example,
billing or shipping) when a vendor has multiple addresses.

Adjusted Net Worth The total value of the vendor’s assets minus the total value of its debts.
This number can represent the agency’s estimate, the vendor’s claim, or an audit amount.

Adjustment Code Not in use by the Department at this time. A coded value (which must be
in the ECTGPCT code table) indicating the percent to be used for any additional adjustments.
The adjustment fields act like E&C percent (for example, gross receipts tax percentage).

Adjustment Item Changes to a construction contract item after award, which can include
incentives, disincentives, and liquidated damages.

Adjustment Percent Not in use by the Department at this time. A percent adjustment made to
the category, which is applied to the total category construction cost to compute the total
category amount.

Adjustment Type Code A coded value (from the ADJTYP code table) indicating the kind of
price adjustment being applied to the item.

Advance Account If your state allows contractors to set up accounts for contractors, this field
holds that number. It is not used for any Trnseport processing.

Advance Account Number If the state allows contractors to set up accounts for contractors,
this field holds that number. It is not used for any Trnseport processing.

Affiliate Vendor Number The name of the vendor associated with another vendor. All
references to vendors are validated with the VVendor file.

Affiliates Two Vendors that are legally related to one another in an ongoing way. The
Affiliates can be parent and subsidiary, or substantial owners of each other’s stock. Two
Vendors who engage in a single joint venture are not considered Affiliates.

Agency A specific agency that provides funding for a specified purpose (for example, bridge
rehabilitation).

Alternate Item Number ID Not in use by the Department at this time. A separate item code
used in public documents or in communication with other systems if the regular item number is
inappropriate. For example, the regular item code might be too specific for public documents.

Alternate Project ID Not in use by the Department at this time. A code that identifies a
project in some electronic or manual system outside of Trnseport. Trnseport can use this value to
communicate with that external system.

Alternate Vendor ID A code that identifies a vendor in some electronic or manual system
outside of Trnseport. This value can be used by Trnseport to communicate with that external
system.

Alternate Vendor Number An alternate identification number or code for a vendor.
Amendment Another name for an addendum.

Amount Due to Date The total amount presently due for payment to the contractor for a given
project.
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Amount Encumbered The dollar value of securities being withheld by the state to cover
retainage requirements to date for a contract or vendor (see Securities Account for a description
of the agency's options). This is the amount withheld from payments if there is no securities
account or if the securities account had insufficient funds. The total of all Amount Encumbered
values for a particular securities account is limited by the current value of securities on deposit in
the account.

Amount Further Subbed (Actual) The dollar value of all child or "sub-subcontracts" of a
subcontract, which is based on the actual amount agreed to by the subcontractor with the sub-
subcontractors. Because the actual agreements between subcontractors and their sub
subcontractors might not be known to the agency, this value might not be meaningful.

Amount Further Subbed (Contract) The dollar value of all child or "sub-subcontracts” of a
subcontract, which is based on the contract prices for all items.

Amount The amount of the transaction.
Approval Date The date the vendor was approved for work.
Approval Flag A notation indicating the acceptability of the vendor to work on the contract.

Approximate Percent of Project Length The percentage of the project (measured in
physical length or size, duration, dollars, or other characteristic of choice) that occurs in the
indicated county, city, or congressional district. This value is used to estimate the value of
projects in selected geographical areas.

Area A portion of the state that consists of one or more counties in their entirety. Each Area
belongs to exactly one Area Type.

Area Type A specification for partitioning the state into Areas. The Areas in an Area Type
must be disjoint (have no overlap) and, when combined, must include every part of the state.
Different Area Types partition the state in different ways for different reasons; for example, Area
Type "Steel" might partition the state by variations in steel prices while Area Type "Asphalt"
would be a different partition by variations in asphalt prices.

Ascending List order such that the first character of each successive list element has a symbol
that occurs later in the alphabet or number system than the preceding element. The list of
numbers 10, 20, 40 and the list of codes A25, C11, Z44 are in ascending order (see Descending).

Authorization An official authorization approval of a recommendation.

Authorized Payment Limit The maximum amount that can be paid to a contractor for a given
project.

Automatic Payment (Auto-Pay) Item Items, such as mobilization, with set schedules for
voucher payment as determined by the basis of work on a contract.

Automatic Payment Specification The rules governing the rate of payment of Auto-Pay
Items. Typically of the form "When the contract reaches X% complete, pay Y% of the item."

Automatic Section Assignment Flag This field tells Trnseport to assign project categories
to proposal sections automatically or do it manually by entering section numbers in the category
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records. The default value is Y, which means Trnseport will automatically assign categories to
sections.

Auto-Pay Item See Automatic Payment Item.

Average Pavement Depth The average depth of the pavement in the roadway portion of the
proposal.

Average Pavement Width The average width of the pavement in the roadway portion of the
proposal.

Average Price The weighted average unit price bid for a particular item. The item bids
analyzed will usually be grouped according to similar proposal or proposal item characteristics.

Average Unit Price (AUP) Work Type Used to determine average unit prices. One of nine
work types related to a specific project. Trnseport uses this field to help generate bid-based
prices for the project items.

Award Contract Amount The dollar amount originally awarded for a contract.
Award Date The date a contract was actually awarded to a contractor.

Award The contracting authority's acceptance of a bid subject to the execution and approval of
the contract.

Awarded Amount The dollar amount awarded to the winning bidder for a proposal.
Awarded Vendor Number The vendor number of the winning bidder for a contract.
Batch A computer process that runs by itself with no user interaction.

Beginning Termini Defines more precisely where the project is taking place with notation
defined by your agency. This data, which is printed on some reports, is passed to Trnseport
BAMS/DSS to pinpoint the project on maps.

Bid A sealed written instrument conveyed to the Department by a bidder that details the bidder's
offer to handle the construction work outlined in a proposal for a price included in the bid.

Bid Alternate A portion of a proposal that contains two or more groups of items for which the
bidder must bid on at least one of the group.

Bid Bond A dollar amount required to bond contractors. This field is printed on some
Trnseport reports but not otherwise used in any processing. The default value is "0". Do not
change it.

Bid Edit Status Indicates if the automated bid editing process detected any errors in the bid
(such as incorrect arithmetic).

Bid Letting An event at which a Department staff person opens and reads all bids for specific
proposals, determines the winning bidders, and awards contracts.

Bid Letting Control Number The value Trnseport uses to uniquely distinguish the bid letting.
It does not need to relate to other Trnseport data values in any way.
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Bid Letting Package A group of proposals processed in a single bid letting. After you define
proposals, assign them to a bid letting package.

Bid Note A description field to store textual notes (brief written comments) about a particular
bid for a letting.

Bid Note Sequence Number A sequential number Trnseport generates whenever you add
notes about a bidder.

Bid-Based Prices Unit prices for work items that are derived from estimated historical bid
prices. This process uses either regression or weighted averages that are based on data generated
by the Trnseport BAMS/DSS PEMETH model.

Bidder A vendor who submits a bid on a proposal.

Bill-to Address Number The sequence number of the planholder's billing address. Trnseport
references the address information in the VENDADDR file.

Bi-Weekly Estimate The estimate the engineer generates every two weeks for a particular
project.

Break Item Quantity The recorded quantity of a work item at the plansheet level. These
quantities will be rolled up to the estimate item level.

Break Item The portion of a regular/structure/sewer item assigned to a particular plansheet.

Breakdown A detailed description or graphic of a section of work performed in the project. It
can contain sketches, items, and quantities.

Breakdown ID A unique identifier for the breakdown within a project. If the default value of
"1" does not appear, enter a value of "1".

Breakdown Item Line Number The line number identifying the breakdown item. This is
usually a number sequenced for the items within a single breakdown. This number is
differentiated from the Project Item Line Number, which may include more than one Breakdown
Item Line Number. This field can be entered automatically. See “Assigning Line Numbers".

Breakdown Item Quantity Enter the quantity for the Item.

Breakdown Type A code table indicating the plansheet might be of a certain type or contain
certain data (for example, roadway, bridge, structure or sewer).

Bridge ID A unique identifier for a bridge structure.
Bridge Length The length of a bridge.

Bridge Type A value selected from the attached BRDGTYP code table that indicates the type
of bridge (e.g., Overpass, Trestle Low, etc.).

Bridge Width The width of a bridge structure.

Calculated Bid Total Trnseport calculates the vendor bid total by checking various figures on
the vendor's bid tabulations. Trnseport calculates and sums item extended amounts or sums
vendor section totals according to an installation option. This figure should be the same as the
Proposal Bid Total.
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Call During a bid letting, the person in charge of the letting calls each proposal in a pre-specified
order so bidders can submit their bids. For bid lettings, the terms call and proposal are often
used interchangeably. Trnseport identifies each call by a three-digit number. Many reports in
Trnseport LAS list proposals in call order.

CAS Contract ID The label used to identify proposals to be combined into one contract.

Cash/Charge Code A coded value (which must appear in the CHRG code table) indicating
the method by which the plans were purchased.

Category A subdivision or grouping of items within a project. Each category represents a
collection of related work items that have the same agencies with the same participation. Each
category can have one or more funding sources (funds). Associate each category with a
particular unit of work in the project; that is, group all items for a single structure into a single
category. Each category should contain items belonging to the same class of work and E&C
percentage. Use categories to group items by alternate design possibilities.

Category Adjustment Code A coded value (which must be in the ECTGPCT code table)
indicating the code for a percent to be used for any additional adjustments. The adjustment
fields act like E&C percent (for example, gross receipts tax percentage).

Category Adjustment Code A coded value (which must be in the ECTGPCT code table)

Category Adjustment Percent A percent adjustment Trnseport will make to the category.
Trnseport applies this percent to the total category construction cost to compute the total category
amount.

Category Alternate Code Different categories can be alternates for each other, which means
that a bidder can choose to bid on either category but not both. The code you enter here indicates
that this is an alternate category. The first two characters specify the alternate group and the
third character specifies the alternate number. The Category Alternate Code field and the
Federal Construction Class field control the generation of section numbers for the proposal. If
categories have the same Federal Construction Class and Category Alternate Code, they will be
combined into a single section.

Category Depth The average pavement depth in inches/cm.

Category Description A short description of a category’s purpose (e.g., funding agencies)
used as default label for proposal section description. Required by the system; should contain
the code description that is found with the Category Work Class field for the Maintenance
Activity Number chosen. Enter the description from the Category Work Class description.

Category Length The length of the category in miles or kilometers. This quantity will be
printed on some reports as an overall project length. You may assign the full length of the
project in any category, or you may split the length among categories so that the combined
length is equal to the overall project length. Enter in miles or kilometers. The default value is
0.0000.

Category Number A four digit number Trns*port uses to identify the category. Enter the
Category Number from the list box. A range may be entered all at once.
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Category Width The width of the portion of the project represented by a given category. The
default value is 0.0000.

Catg. Suppl Work Code Similar to the Federal Work Category except that Trnseport uses the
FEDSUPP code table. A coded value indicating the type of federal work performed in a
category.

Change Order A written order issued by the engineer to the contractor. It covers permissible
adjustments and minor plan changes or corrections, rulings with respect to omissions, and
discrepancies or intent of the plans and specifications. It does not include any extra work or
other alterations covered by the supplemental agreement.

Check Box A dialog box component that allows selection of options. Select none, some, or all
of the available check boxes (see Radio Button and List Box).

City The city in the district address.

Classification Function A coded value indicating the classification or category into which
the item fits. Used by Trnseport BAMS/DSS to group items into the same market share.

Clerk Writing Order A coded value indicating the person who took an order for the purchase
of plans.

Clicking Pressing and releasing one of the mouse buttons, usually the left button.

Combine Flag Trns*port will take several different category items and combine them into a
single proposal line item under certain conditions. To stop Trns*port from doing that, enter an
"N’ for this field. That will force Trns*port to create a separate proposal line item for this
category item. Trns*port will combine different category items into a single proposal line item if
they match in five fields: the item number, the supplemental description, the item alternate code,
the supplemental proposal description, and proposal section number.

Combine with Like Categories The default value for this flag is YES. Do not change this
flag. Trnseport can combine several categories into a single proposal section according to some
simple rules. If you do not want that to happen, force Trnseport to put all the Items in this
category into their own proposal section. If the check box is marked, then Trnseport combines
all the Items into a single proposal section. This field in conjunction with the Combine with Like
Items flag controls the rolling up of item quantities for bidding.

Combine with Like Items Trnseport combines category items into a single proposal line item
if they match in four fields: the item number, the supplemental description, the item alternate
code, and the supplemental proposal description. If you check the Combine with Like Items
check box, each item will only appear once in the proposal, even if you list it in more than one
category. Trnseport will combine items if the item code (if filled in) is the same and if the
alternate code and supplemental descriptions match exactly. If you remove the check from the
check box, Trnseport will not roll up the items. Items that meet these criteria must reside in
categories that have the same federal construction class (proposal group) to be rolled up into the
same section of the proposal.

Command Button Part of a dialog box that executes a command when you choose the button.
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Commitment Amount The total dollars committed to the DBE/WBE vendor.

Common Unit of Measure A coded value from the attached UNITS code table indicating the
common unit of measure to which Trnseport can convert the item for comparison to other items.

Completion Date See Specified Completion Date.

Construction Engineering Percent (C & E Pct) Not in use by the Department at this time.
The default value is 0.00. Do not change it. The amount of construction engineering work to be
performed on a project expressed as a percentage of the total category or project amount. If you
put a zero in the Construction Engineering Percent field, Trnseport will assume that you mean
0%. Trnseport leaves the field blank by default and assumes the C&E percent is the same as for
the project as a whole.

Cont Alt ID 1 Use this field and Cont Alt ID 2 to store identifiers the agency will use for this
contract in addition to the Contract ID Trnseport requires. Trnseport does not use this field in
any Trnseport processing.

Cont Alt ID 2 Use this field and Cont Alt ID 1 to store identifiers the agency will use for this
contract in addition to the Contract ID Trnseport requires. Trnseport does not use this field in
any Trnseport processing.

Contract ID A unique identifier for a proposal or contract. Enter the planned District or Central
office Contract number, and use it as a Proposal Identifier.

Contract Proposal See proposal.

Contract The written agreement between the contracting authority and the contractor that sets
forth the obligations of the parties, including performance of work, furnishing of labor and
materials, and basis of payment. Trnseport creates a contract from a proposal when you let and
award the proposal. The contract contains all the proposal information needed to manage
construction and pay for construction work. Like proposals, contracts consist of projects and
sites. Contracts also contain item payment information, voucher information (including
retainage and liquidated damages), contractor performance and schedule information, and
subcontract and DBE/WBE commitment information. You can modify the contract as the work
progresses (see add-on, supplemental agreement, and change order).

Contract Type A value selected from the attached CONTTYP code table, that you use to store
a classification of the type of contract this proposal will become (e.g., a maintenance contract).
Trnseport prints this field on some reports but does not use it in processing.

Contract Work Type A coded value your agency can use to store a classification for the work
type for this contract. For Maintenance contracts, leave the default value "I" — Other. For other
contracts, choose a code from the list box.

Contracting Classification A value selected from the attached CONTCLS table that
indicates the class of contract.

Contractor Bid A bidder's offer to perform the work in a proposal for specific unit prices
specified by the contractor.
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Contractor Info A contractor that submits a response to The Department's proposal and offers
to perform the work for specific unit prices.

Contractor The winning bidder to whom you award the contract. Any business entity that
interacts with The Department; for example, bidders, contractors, subcontractors, material
suppliers, escrow agents, railroads, utilities, and consultants are all contractors.

Control Group A group of users who can access the same set of projects, proposals, or
contracts (e.g., only users in the Estimates control group can access Estimates projects). Each
control group member may only view, change, and delete projects, contracts, or proposals in
their own control group. To pass a project, contract, or proposal to another control group for
processing, a user can change its control group code to the new group code. When the user saves
the project, contract, or proposal, the original control group will no longer have access to it.
Trnseport will automatically enter the control group of the user who signed on and added the
project in the Control Group field. For example, if an Aeronautics user with a control group of
Al adds a project, the project’s control group will be Al and only other users in the Al control
group or less restrictive control groups (*1, A* or *) will be able to view, change, or delete the
project. To pass a project to another control group for processing (e.g., from Estimates to
Contracts), a user in the first control group can change the control group code to the new code.
After the first user saves the project, the first control group will no longer have access to the
project. If you put a specific control group in the field and save the project, only users with a *
control group (they can view all projects) can access the project and change the control group.

Control Menu Every window has a control menu, which contains commands that change the
size of, move, or close the active window.

Controlling PCN Indicates which project is the controlling project in a multi-project contract.
Enter the Financial project Number of the lead project.

Conversion Factor to Common Units Trnseport multiplies this conversion factor by the
item quantity to convert the item units to the common unit of measure.

Cost of Plans Used for planholder invoicing in the LAS module. If there is a charge for plans,
enter the cost of the plans only, exclusive of sales tax. The default value is 0.00.

Cost of Plans without X-Section Not in use by the Department. Used for planholder
invoicing in the LAS module. Trnseport will bill this cost to purchasers of complete plans
without cross-references for this proposal.

Cost of Proposal Package Used for planholder invoicing in the LAS module. If the
district charges for plans, enter the cost of the complete package of bidding documents, exclusive
of sales tax. This field has a default value of 0.00.

Cost of Proposal Used for planholder invoicing in the LAS module. Trnseport will bill this
cost to purchasers of plans for this proposal. The default is $0.00. The next fields—Cost of
Plans, Cost without X-Section, and Cost Per Plan Sheet—are used for the same purpose.

Cost of Specs Used for planholder invoicing in the LAS module. If there is a charge for
specs, enter the cost of the specs only, exclusive of sales tax. Default is 0.00.
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Cost Per Plan Sheet Used for planholder invoicing in the LAS module. If the district charges
for plans, enter the cost of the specification package only, exclusive of sales tax. Default is 0.00.

Cost Plus Time Bidding A bidding method that involves time with an associated cost in the
low bid determination. This type of bidding consists of the traditional work items and represents
the total contract amount. The Time component is a bid of the total number of calendar days the
bidder will require to complete a milestone. Both the work items and the Cost Plus milestone
components appear in the bid proposal and are used to determine the lowest bidder. The total
number of calendar days bid by the low bidder for the contract site (Site 00) becomes the
contract time and the work item bid component becomes the contract total for contractor
payment.

Counties Enter up to four counties for each proposal (select from the list box). Trnseport prints
this information on some reports, but does not use it in processing.

County Name The county name will be entered automatically after selecting the county
number.

County or Congressional District From the list box in the field, select the county to be
added. Once you select a county, the county number will be displayed and the county name will
appear in the adjacent field. Do this for each row of data.

County/City/Cong. Dist Code A coded value indicating that the project or proposal includes
work in a county, city, or congressional district.

CSV (Comma Separated Value) A type of file where fields within a record are separated by
commas. Used to transfer data between systems.

Current Work The current dollar amount of work the bidding vendor has outstanding.

Date and Time of Purchase The date and time a vendor purchases a set of plans for a
particular proposal.

Date of Addendum The date you add the addendum or the date it becomes effective. Enter in
MM/DD/YY format.

Date of Estimate The date you complete an estimate. Enter in YY/MM/DD format.
Date of Letting The date you will hold a letting. Enter in YY/MM/DD format.
Date Priced The date you priced an estimate. Enter in YY/MM/DD format.

Date The date you entered the status.

DBE Apply Interest A percentage indicating the average number of times this item is selected
for DBEs and the value of the item portion set-aside for.

DBE Approval (Flag) Indicates the acceptability of the vendor to work on a contract.

DBE Certification Date The date on which you certified the vendor for its business enterprise
type.
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DBE Commitment Bidders state that if the Department of Transportation awards them a
particular contract, they will use a particular qualified DBE vendor as a subcontractor or
supplier. Bidders also specify the value of work the DBE will perform.

DBE Disadvantaged Owned Business Enterprise.

DBE Goals A value selected from the attached DBENOTE code table, that indicates which of
the two goals described above apply to this proposal. If you choose NONE, Trnseport will not
print goals on any report. If you choose DBE, Trnseport will only print the DBE/MBE goal and
will label it a DBE goal. If you choose BOTH, Trnseport will print both the DBE/MBE goal
(labeled as an MBE goal) and the WBE goal.

DBE Interest Flag Not in use by the Department at this time. Indicates whether an item is
often of interest to or is selected for DBW/WBE set-aside.

DBE Interest Percent to Apply A percentage indicating the average number of times this
item is selected for DBEs and the value of the item portion set aside for DBEs.

DBE/MBE Goal A percentage goal set for disadvantaged (DBE) or minority (MBE) business
enterprises for a proposal.

DBE/WBE Code A coded value (which must be in the DBETYPE code table) indicating
whether the vendor is a DBE, WBE, or MBE.

DBE/WBE Commitment A contract proposal might require that a percentage of a project be
subcontracted to MBEs. When the prime contractor submits plans to meet these requirements
(that is, what work item(s) will be subcontracted to which subcontractors), enter and track these
DBE/WBE commitments in Trnseport.

DBE/WBE Vendor Number The vendor code for the particular DBE/WBE vendor, which
must be in the VENDOR file.

DBE/WBE Vendor Set a flag for any vendor in the Vendor file to indicate that the vendor is a
DBE, a MBE, or a WBE for minority hiring.

Delete The lowest level of deleting. Usually deletes one data record from one file, so you will
only see one Delete Warning window. (See also Power Delete and Strong Delete).

Descending List order such that the first character of each successive list element has a symbol
that occurs earlier in the alphabet or number system than the preceding element. The list of
numbers 40, 20, 10 and the list of codes Z44, C11, A25 are in descending order (see Ascending).

Description Trnseport prints on most project reports. These two lines of data allow you to
enter a brief description (maximum 120 characters). When Trnseport lists projects in a scroll
window, it displays the first 28 characters of the project description with the PCN. The first 28
characters should therefore contain enough information to uniquely identify a project from all
other projects.

Designer The city, county, consultant, or squad that designed the project. Selected from the
STAFF code table.
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Detail Window Detail windows allow you to add, change, or browse information about a
selected project, category, item, and so forth.

Dialog Box A box displayed on the screen that allows you to input information. It can contain
text boxes, list boxes, command buttons, radio buttons, and check boxes.

District The district where a project or contract is located. Enter the managing district for the
project, by clicking on the list box and selecting your district.

Document Number If the state has an internal referencing number or library system for
documents, this field would hold that number. Trnseport does not use it in any Trnseport
processing.

Double-Clicking Pressing a mouse button twice in rapid succession.

Dragging Using the mouse to highlight an area of the screen that is larger than one character.
Point the mouse to the beginning of the area to highlight and click the left button. Hold down the
mouse button and drag the mouse until you have highlighted the desired area.

E&C The percentage of engineering and contingency expenses for a construction project.
Encumbrance Dedicating funds for a construction project.

Engineer A code value (that must be in the STAFF code table) indicating the engineer in
charge of the district, area office, residency or field office.

Escrow Account A bank account set up by a vendor in which the Department will deposit the
money normally retained by the Department. The account will earn interest for the vendor, but
the vendor cannot make withdrawals until the Department authorizes the bank to do so.

Estimate Comments Textual comments or remarks about the estimate.

Estimate Info The amount the contractor will receive for the estimated work performed on the
contract during a pay period. Trnseport bases the pay estimate on Item Progress and adjustments
made for various reasons. This entity also includes a breakdown of the payments.

Estimate Numerous estimates are prepared over the life of a project. Use Trnseport to produce
these three: Preliminary Detail Estimate: Also referred to as the P, S & E Estimate, this report
provides a project view of costs, including add-on percentages and funding breakdowns.
Proposal Estimate: Also referred to as the Design Estimate or Engineer's Estimate, this estimate
contains a list of proposal items and the (estimated) costs. Final Detail Estimate: Also referred
to as the Contract Agreement Estimate. This estimate uses the contractor's bid prices as the
"estimate."

Estimated Amount of Project The total estimated amount of work for a project. The default
is"0". Itis automatically filled by Trnseport PES each time the Preliminary Detailed Estimate
process is run.

Estimated Item Price The engineer's estimated unit price for an item. Trnseport uses this field
to determine an item’s cost for the Detailed Estimate. Defaults to 0.000, but you can modify the
value.

Estimated Item Quantity The estimated quantity of work for an item.
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Estimated Price Lock Indicates whether you have finalized an estimated item price and it
should therefore not be modified by users or the system.

Estimated Price The Department's estimated cost for one unit of an item. Trnseport uses this
field to determine an item's cost for the Detailed Estimate.

Estimated Quantity Used with Estimated Price to determine the cost of an item. Used in
Trnseport LAS to determine the value of bids, in Trnseport CAS to determine the authorized item
quantity, and in Trnseport BAMS/DSS to analyze construction overruns. Used with Estimated
Price to determine the cost of an item. Used in Trnseport LAS to determine the value of bids, in
Trnseport SiteManager to determine the authorized item quantity, and in Trnseport BAMS/DSS
to analyze contract overruns. Defaults to 0.000, but you can modify the value.

Estimated Unit Price The engineer’s estimated cost for one unit of an item. Trnseport uses
this field to determine an item’s cost for the Detailed Estimate. Defaults to 0.000, but modify the
value as necessary.

Exempt from Retainage Not in use by the Department at this time. Indicates whether
Trnseport should withhold retainage for work performed on a specific item.

Extended Amount from Proposal The bidder's extended price amount for a line item in the
proposal and section and proposal totals. Trnseport uses this field in production and Trnseport
BAMS/DSS models use it.

Extra A change to a contract to add additional work items.
Federal Appropriation Codes A coded value indicating the type of federal appropriation.

Federal Construction Class Describes the type of construction used for the category. The
Department can define its own codes and enter them in the FEDCCLS code table. Trnseport uses
this field to determine whether categories can be combined. For Maintenance contracts, this
field will always be “M”. When you combine categories and Items in a proposal, Trnseport adds
categories together if they have the same Federal Construction Class.

Federal Funding Mark the check box if the fund contains federal dollars. If you check the
Federal Funding box, the funding source is a participating fund, which means that the federal
government is participating in funding these category Items. If you do not check the box, the
funding source is non-participating, which means that the funding is 100% state or a combination
of state and local.

Federal Participation Indicates whether a specific fund is a federal fund.

Federal/State Project Number The federal or state project number identifying a project,
proposal, or contract. Enter N/A for all maintenance projects.

FHWA The Federal Highway Administration.

Field Book Not in use by the Department at this time. If checked, this check box indicates that
the project is maintained using a field book machine.

File An entity that stores all information associated with one Trnseport project.
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Filter A way to quickly locate records in Client/Server Trnseport list windows. You can specify
search criteria to find a group of records.

Finance Code Letters that usually precede the control section.

Fixed Price (Pre-Established Price) This indicates that the bidder is required to bid the
price specified by the Department. If you set this flag to "Y", the Estimated (or Revised) Price of
the item will appear already filled in on bidders' proposal schedules. The default value for this
field is "N".

Force Account An item of work the Department pays at the contractor's cost rather than at a
bid price. A force account includes the materials, labor and equipment the contractor actually
uses to perform the work and might include state-specified allowances for overhead and profit.
State-specified schedules usually determine labor and equipment costs rather than the
contractor's actual payments. You will typically use force account items when there is
uncertainty about the work involved for the item and you cannot bid it knowledgeably.
Examples include utilities relocation and toxic waste removal. Because you pay the item at cost,
the unit of measure is dollars. Therefore, you often estimate force account items as if they were
lump sum. Because a force account is not a bid item, Trnseport does not pass it to Trnseport
CAS or Trnseport BAMS/DSS.

Fuel Adjustment Type A coded value indicating that an item might require a fuel price
adjustment.

Fund Assign funding sources at the project, category, and item level. Typically, you specify
funding sources at the category level; however, specify default funding at the project level and
identify individual items as nonparticipating in category or project-level funding sources. The
funding defined for a category can consist of multiple sources with funding limitations and
priorities established for each source.

Fund Code A unique identifier for a funding source.

Fund Priority Order A sequence number you use to indicate the order in which you should
encumber funds when certain funds have limited participation.

Funding Description A short description of the fund.
Funding Group An identifier used to associate funds into groups.

Funding Participation Limit The maximum amount, in dollars, that a fund will pay for this
category.

Funding Participation Percent The portion of work a particular fund will pay.
Funding Prefix An alternate name for a fund.

General Description/Comment A short description or written comment about the particular
DBE/WBE vendor.

Generics Extra fields Trnseport does not use in any processing. These fields will only appear
on reports that you have customized to include them. If you use a generic field, you can redefine
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the field description (that is, the field label displayed on the window) to indicate the contents or
use of the field.

Highlight To shade an area to change its appearance. Highlight with a mouse by pointing and
clicking on the beginning of the area and dragging until you shade the desired area.

Highway Number The identifier for the highway being worked on in a project.

Highway Type A coded value indicating the type of highway (for example, asphalt, concrete,
or dirt or two-lane or four-lane limited access).

Historical Price The price that you have historically used for an item.

Icon A symbol representing an application in the Microsoft Windows operating environment.
Icons might or might not be active. An icon’s name is the same as the application it represents.

Increase/Decrease A modification of a regular/structure/sewer item's authorized quantity as
specified by a recommendation.

InspDailyRpt (Inspector's Daily Report) A written report generated every working day by
an inspector that describes the work performed on a Contract monitored by that inspector.

Invoice Number A unique identifier for a planholder invoice.

IRS Number The Federal Employer Identification (FEI) number assigned to the vendor by the
IRS.

ltem Alternate Code Different items can serve as alternates for each other, which means that a
bidder can choose to bid on either item, but not both. The first two characters of the item
alternate code specify the alternate set and the third character indicates the choice within the set.

Item Classification Function A coded value indicating the classification or category into

which the item fits. Used by Trnseport BAMS/DSS to group items into the same market share.
Caution: When you assign an item classification to an item, be sure that the item has the same unit of
measure or the same common unit of measure as the other items in the item class.

Item Material Information and factors linking a regular/structure/sewer item to the material that
comprises the item.

Item Number The Item Number from the Master Pay Item List. It is contained in the
ITEMLIST code table of Trnseport.

Item Progress The quantity of a regular/structure/sewer item performed between successive
measurements or estimates made by the Department inspectors or engineers.

Item Summary A particular, quantified part of the work in a proposal. If the work quantity is
not measurable, Trnseport sets the quantity to 1.00 for the lump sum item. An item summary
contains the dollar value of all work in a proposal.

Item The smallest unit of work identified within a project. Items can represent biddable work or
non-biddable work such as rights-of-way and force accounts. You can define groups of items to
represent alternate design possibilities and you can divide the quantity of work for an item across
multiple categories within a project.
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Item year Because Trnseport contains projects designed at different times, you may not change
the reference information about each item (such as description and unit). Doing so would change
the meaning of projects already in progress. Instead, create new reference item lists when
necessary. You may distinguish these lists by a spec year.

Last Addendum Number The last addendum number used for a proposal.

Last Description Number Filled in automatically by Trnseport when you enter long
descriptions.

Last Revision Date someone last revised the estimate. Enter in YY/MM/DD format
Latitude of Address The latitude on a map of the vendor's address.

Latitude of Midpoint The default value is 650000, and may be changed as appropriate. Enter
latitude in the form degrees, minutes, seconds.

Letting Address A description of the letting location.

Letting Call Order The order in which you will open a bid for a specified proposal during a
bid letting.

Letting Number A unique identifying number or alphanumeric for a letting. 1t may be
composed of any combination of eight numbers and letters. For lettings in the districts, allocate
two positions for the district number, two for the year, two for the month, and two for the date.
This will be in the form of #YYMMDD, where ## represents the district number. If the
occasion should arise that you will hold a second letting on the same date, you may insert a "B"
in position seven. The Central Office lettings commence with a prefix of CT.

Letting Proposal Call Order The order in which you will open a bid for a specified proposal
during a bid letting.

Letting Status of Proposal A coded value indicating the status of a proposal.

Lien/Claim A statement by an individual or company that they are owed a payment because of
conditions caused by the contractor's work or performance.

Liquidated Damages Per Day The amount to be charged, in whole dollars, for each day that
a contractor exceeds the allowed time for a contract. This has a default value of "1" and will not
be used in preparing bidding documents. Trnseport cannot handle the liquidated damages table
contained in the Standard Specifications for Road and Bridge Construction.

List Box Part of a dialog box that contains a list of choices. Select one of the choices at a time.
The list box will have a scroll bar to help you move through the list (see Radio Button and Check
Box).

List Window A list window contains a list of records relating to a particular process (for
example, Projects). From a list window, select a specific record and open a detail window that
contains the fields and data associated with the record.

Location of Bid Deposit The location at which bidders should deposit bids.

Location of Letting The location at which bids will be opened.
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Location The site where work is being performed for the proposal.

Long Description 2 A continuation of the long description of the item (maximum 60
additional characters, if needed).

Long Description A long description of the item (maximum 60 characters).
Longitude of Address The longitude on a map of the vendor's address.

Longitude of Midpoint The default value is 1650000, and may be changed as appropriate.
Enter longitude in the form degrees, minutes, seconds.

Low Cost Bid Item Flag Generated by Trnseport in the Bid Tab Edit process, this flag
indicates whether the item is a low-cost item. If the item has alternates or is an alternate, only
one of the alternates will be flagged as the low-cost item.

Lump Sum Item Units A value, selected from the attached UNITS code table, that identifies
the type of measurement used to determine the unit of one lump sum item.

Maintenance Activity Number A value selected from the attached CWRKCLS code table
that indicates the kind of work performed in the category. This code value is also used with the
Maintenance Management System (MMS).

Major Item Flag Indicates that an item is important enough to appear on the Notice to
Contractors, regardless of the dollar amounts allocated to it.

Material Any measurable, physical substance used to perform an item of work or the substance
of the completed item itself.

Maximum Capacity The maximum amount of work, in dollars, that a vendor can perform.

Maximum Contract Amount Paid A limit, expressed as a percentage of the original contract
amount, for an automatically paid item.

MBE Minority Owned Business Enterprise.
Menu A list of related commands that you open and view.

Misc Item Non-standard items added to a project, which you identify as "7000" items.
Trnseport calls these non-standard items.

Mouse Hand-held mechanical device used to position the cursor and perform actions on the
screen.

Non-Bid Item An item, such as a state-supplied item, that will be included in the project but
will not appear on any bid documents.

Non-Federal Participating Item An item in a construction project that is not eligible for
federal funding.

Non-Participating Fund Code Identifies a fund that will fund 100 percent of the work for a
project item. Trnseport will exclude the work for this item from funding for the category that
contains the item.
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Notice Publication Date The date you will notify potential bidders of the letting of a
proposal.

Notice to Proceed Written notice to the contractor to proceed with the contract work and the
contract beginning date.

Number of Days Bid In a Cost Plus Time bid, the bid time number of days bid for the
associated letting proposal’s awarded vendor for an associated proposal site.

Number of Days The number of available or calendar days that are available for completion of
a contract site. Leave this field blank if you selected Completion Date for the Type of Days field
above.

Number of Label Sets The number of sets of labels to be generated when you generate labels
for this order. You must fill in this field for Trnseport to generate labels. Valid values are zero
through nine.

Number of Pages The number of pages of the special provision.

Number of Plan Sheets The number of plan sheets purchased by a vendor.
Number of Spans The number of spans of the structure represented by a category.
Obsolete Flag Indicates whether the special provision is in effect or obsolete.

Obsolete Item Flag Indicates that an item is obsolete and should no longer be used on new
projects.

Obsolete Vendor Indicates that a vendor is obsolete and therefore should no longer be used.

Officer's Address Number The vendor address sequence number identifying the vendor
officer's address.

Ordered by The name of the person ordering the proposal plans.
Originating Date of Specification The date a special provision is effective.
OTSH One time shipping address.

Part A collection of related portions of regular/structure/sewer items in a project. In a typical
project, The Department breaks down roadway items and bridge items into separate parts.

Partial Payment Item Items for which work occurred during a voucher cycle paid according
to quantity placed (excluding substandard work).

Passed to CAS/DSS Indicates whether a contract has been passed to DSS (D), CAS (C), or
both (B).

Password A code Trnseport uses to identify you in conjunction with your user name when you
sign on to Trnseport. You must keep your password secret to prevent other people from
accessing your files without your knowledge.

Pay Adjustment Adjustments applied to contract project payments.

Pay Item Year The Department no longer creates a new pay item list each time a specification
book is issued. The current Pay Item Year is "00".
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Pay Quantity The quantity of an item for which a specific estimate will pay. It will usually be
the sum of the item progress quantities performed since the previous estimate, but it might be
different because the Department withholds payment for various reasons.

Payment Fund A fund and dollar amount that you designate to pay for part of an estimate.

Payment Voucher A record of what the payment should be to a contractor or escrow account
for a particular project. Trnseport generates this voucher for treasury and billings.

Percent Complete Basis A coded value indicating the method used to determine the current
percent of work complete.

Percent Complete Threshold A percent of item completion that determines if an item
should be paid automatically.

Percent of Project Length If there is only one county involved in the project, enter 100 in the
field. If multiple counties are involved, enter percentages for each that will total 100%.

Percent of Quantity Paid The percentage of the current item quantity to be paid to date at an
automatic payment threshold.

Percent Ownership The vendor's percentage of ownership of the affiliated company.

PES Worksheet An interactive process that allows users to add items and item level data to
projects quickly. The functionality is provided through an interactive, spreadsheet-like data
entry window. Users are able to enter project item data from scratch, input data, or modify
existing PES item data.

Phone The phone number (including area code or extension) of the district, area office, field
office, or residency.

Physical Road Number The name or number of the road where the project work is being
performed.

Planholder A vendor to whom you issue a proposal package that is valid to submit as a bid.
Courtesy planholders purchase proposal packages on which they cannot bid.

Pointing Moving the mouse until the tip of the arrow on the screen rests on a desired object.
You can place the mouse on a flat surface and slide it to the object.

Power Delete The second level of deleting. Deletes multiple records from more than one file,
so you will see two Delete Warning windows. For example, if you are deleting a bid letting
package, Power Delete will delete the letting call, bids, planholders, and proposal. (See also
Delete and Strong Delete)

Pre-Established Price Indicates that the bidder is required to bid the price specified by the
Department.

Prequalification Certification Date The date you qualify the vendor to perform the type of
work certified for the state.

Prequalification Expiration Date The date the vendor's qualification for certification for
work expires.
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Prequalification Update List Date The date you schedule to review the list of vendors who
have pre-qualified.

Previously Let As CONTID Indicates the contract ID under which a proposal was previously
let.

Price Index A coded value indicating that Trnseport should automatically adjust item prices for
inflation according to the index.

Price Lock Flag The default value for this field is "N". There is a Trns*port PES process
called Generate Bid Based Prices which may be used to fill in all the Estimated Prices. That
process uses historical bid data in the BAMS/DSS module to determine an estimated price for
each item. If you set this field to "Y', the Generate Bid Based Prices process will NOT compute
a price for this item, leaving the manually entered price in place.

Priced by Indicates the person from the attached STAFF code table who priced an estimate.

Primary DBE/WBE Code A coded value indicating the vendor’s business enterprise
certification type.

Primary District The managing district.

Prime Project Not used by the Department. A prime project generally represents all work to
be performed under a single federal project number. This work is subdivided into Trnseport
projects. Each Trnseport project represents a logical portion of the prime project one project
might contain all bid items, another preliminary engineering and rights-of-way, and another non-
biddable construction work such as force accounts.

Project Beginning Termini, Ending Termini, Beginning Station, Ending Station
These fields let you define more precisely where the project work is taking place using notation
defined by your agency. Trnseport passes this data, which Trnseport prints on some reports, to
Trnseport BAMS/DSS to pinpoint the project on maps.

Project Control Number (PCN) A unique number or alphanumeric that identifies a project.

Project Description Trnseport prints on most project reports. These two lines of data allow
you to enter a brief description (maximum 120 characters). When Trnseport lists projects in a
scroll window, it displays the first 28 characters of the project description with the PCN. The
first 28 characters should therefore contain enough information to uniquely identify a project
from all other projects.

Project Each Trnseport project represents costs associated with all or part of a construction
project. The information used to define a PROJECT generally comes from The Department's
Program Planning and Design branches.

Project Grade Not used in Trnseport processing. Trnseport prints this code on some Trnseport
reports. Values entered here must be in the GRADING code table to be legal. Each agency can
specify codes that are meaningful to the agency.

Project Item Line Number A unique sequential identifier for an item within a project. This is
a four digit number Trnseport uses to identify the item. Trnseport will automatically enter this
value when you run certain processes. When an addendum is being created, you identify an item
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to be changed by choosing a value from the attached drop down list. When you select a category
number, Trnseport fills in the Project item Line Number list with all project item line numbers
for the selected project and category.

Project Item See Item.

Project Item Sequence Number A unigue sequential identifier for an item within a project.
Project Location The location of the primary work performed in the project.

Project Number Enter the Financial Project (FINPROJ) Number.

Project Road Name The name of the primary road on which project work is being performed.
Project Sequence Number A sequential number for each event entered.

Project Type A value, selected from the attached PROJTYP table. The Department
specifies its own values for the PROJTYP table. Leave this field blank for Maintenance projects.

Project Work Type A value, selected from the attached PWRKTYP table. The Department
specifies its own values for the PWRKTYP table. Enter a value in the Project Work Type field
to run this project through the Bid-Based Prices processes. Project Work Type is one parameter
used to determine the bid-based price. Leave this field blank for Maintenance projects

Proposal Addendum Number A sequential number identifying a proposal addendum.
Trnseport enters a sequential value automatically.

Proposal Bid Total The total cost of the proposal as determined by the bidder.
Proposal Call Order The order in which you will open a bid for a specified proposal.
Proposal Class For maintenance projects enter "I" from the list box.

Proposal DBE Goals A code (which must be in the DBENOTE: code table) indicating which
of the two goals described above apply to this proposal. If you enter NONE, Trnseport will not
print goals on any report. If you enter DBE, Trnseport will only print the DBE/MBE goal and
label it a DBE goal. If you enter BOTH, Trnseport will print both the DBE/MBE goal (labeled
as an MBE goal) and the WBE goal.

Proposal Fund Type A coded value indicating the kind of funding used for the proposal.

Proposal Item Each proposal section is a collection of one or more proposal items. Each
proposal item is a bid item. Trnseport constructs proposal items from one or more project items
by combining items with the same item code from the same section. You can override this
"folding" of similar project items. Similar project items will create separate proposal bid items.

Proposal Line Number A unique sequential number that identifies a line item within a
proposal.

Proposal Location The site where work is being performed for the proposal.

Proposal Notes Available for special notes that need to be communicated to bidders. Limited
to 60 characters.
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Proposal Number Held If the state has a serial sequence number or a numbering system for
proposals, this field would hold that number. Trnseport does not use it in any Trnseport
processing.

Proposal Schedule A listing of contract items in the proposal form that show quantities and
units of measurement and have blank spaces for bid price insertion.

Proposal Section Number A unique sequential identifier for a proposal section.

Proposal Section Represents a grouping of proposal items. Trnseport creates sections by
grouping all categories with the same work class on all projects assigned to the proposal. You
can override this "folding™ of similar categories into single sections. Then similar project
categories will create separate proposal sections. Trnseport will always assign project categories
representing different alternates to different proposal sections. The description field will be the
description of the lowest MA number in the project. This description should be changed to
reflect the overall project.

Proposal The entities presented to potential contractors for bidding. You construct a proposal

from Trnseport projects. Typically, you combine multiple projects into a single proposal. (You

cannot add an individual project to more than one proposal or split it among multiple proposals.)
Proposal information generally includes contract time specifications, DBE/WBE goals, bonding
information, a detailed description of the work the contractor will perform, and an identification
of any necessary special provisions, supplemental specifications, or both.

Proposal Type A coded value indicating the location of the proposed letting. DIST or CENT.

Proposed Letting Date This field is entered from the FM system. If the date is in error, see
the Work Program office to have it corrected.

PS&E Plans, specifications, and estimates for a project.

Qualification Amount The total dollar value of contracts for which the vendor is qualified to
work.

Qualification Classes A classification of work for which a vendor is qualified.
Quantity of Complete Plans The number of complete plans purchased by a vendor.

Quantity of Complete Plans without Cross-X The number of complete plans without
cross-references purchased by a vendor.

Quantity of Proposals The number of proposals purchased by a given vendor.

Radio Button Part of a dialog box that allows you to select one option from a group of related
options. Each choice has a circular button (see List Box and Check Box).

Reason for Non- Processing A coded value indicating the reason Trnseport did not process
a proposal.

Recommendation Modification of contract items, such as extending the authorized time,
changing an item quantity, or adding a new item to a project.

Regular/Structure/Sewer Iltem A particular, quantified part of the work in a project (if the
work gquantity is not measurable, Trnseport sets the quantity to 1.00 for the lump sum item).
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Regular/structure/sewer item contains the dollar value of all work in a project. This entity
includes regular items, structure and bridge items, and sewer items.

Relation to Vendor A coded value indicating the relationship between a vendor and its
affiliate.

Retainage The amount withheld from voucher payments made to a contractor pending
completion of a contract.

Revised by A coded value indicating the person who revised an estimate.

Revised Item Price A revised price for an estimate item. If you enter a value, Trnseport will
use it instead of the original engineer’s estimated item price.

Revised Price Change the Estimated Price by filling in a new value in this field. Trnseport
will use the Revised Price instead of the Estimated Price whenever this field is non-blank, which
allows you to keep a record of the changes you have made to any of the estimated prices.

Road Name The name of the primary road associated with the prime project.

Road Section Number An identifier for the road section in which construction is taking
place.

Road Section Number, Beginning Termini, Ending Termini, Beginning Station,
Ending Station Identifiers for the road section in which construction is taking place.

Road System A coded value indicating the road system of which this highway is a part (for
example, interstate or federal, state or county highway).

Road User Cost Per Day A value used in determining the low bidder in a Cost Plus Time
bid. A value can only be entered in this field if the value in the Type of Days field is CD or AD.
A non-blank value in this field indicates the Site is a Cost Plus Time Site. The value is the cost
per day of the inconvenience of the construction.

Route Number The route number of the road affected by a project.

Sales Tax Code A coded value indicating the sales tax that applies to the vendor. The
Department does not collect sales tax.

Scroll Bar A rectangular box in list boxes or windows. The bar contains up and down scroll
arrows or left and right scroll arrows and a scroll box. The scroll bar allows mouse users to
move through text to view sections that are not currently visible. To scroll, click and drag the
scroll box or click the scroll arrows.

Scrolling Move the cursor left or right or up or down to see parts of the text that are not
currently visible (see Scroll Bar).

Section Assignment Flag telling Trnseport to assign project categories to proposal sections
automatically or do it manually by entering section numbers in the category records. The default
value is Y, which means Trnseport will automatically assign categories to sections.

Section Description A short description of the proposal section.

Section Number See Proposal Section Number.
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Section See Proposal Section Number.

Securities Account A contractor can establish an escrow account with the Department so that
the Department can hold securities in place of retainage.

Securities in Lieu of Retainage Not in use by the Department at this time. A flag indicating
whether you will allow the contractor to deposit securities with the agency to reduce the amount
of retainage withheld in payment vouchers.

Set Aside Proposal A value, selected from the attached SETASID code table that indicates
you have set aside a proposal for a particular purpose. Leave blank, this is not presently in use.

SHA State Highway Agency.

Ship-to Address Number The vendor address sequence number of a planholder's shipping
address.

Short Description A short description of the item (maximum 40 characters). When Trnseport
lists items on a scroll window, Trnseport displays the first 30 characters of the item short
description beside the item number. The first 30 characters should therefore contain enough
information to uniquely distinguish an item from all other items.

Site Number A unique identifying sequence number for each site. Each contract must have a
site 00, which represents the contract as a whole, in addition to any other sites.

Site Proposal sites represent work locations for which time charges are accrued. The default
situation is for a single site of time charges to accrue on the contract as a whole. If contractors
will construct several project entities (for example, bridges) as part of a single contract, you can
treat each project entity as a separate site to assign completion time and assess liquidated
damages.

Social Security Number The social security number of the vendor officer.

Source of Price A value, selected from the attached PRICSPR code table, that indicates the
originating source of an estimated price for an item (e.g., estimated or historical). Defaults to
“E” for estimated. You can indicate in the Source of Price field how Trnseport determined the
estimated or revised price. Trnseport sets it to E, but you can change it. This field identifies
where the estimated price came from, but does not apply to the revised price, and the source of
price field can contain an “E” for the engineer estimated the cost, “GBBA” for a bid-based
average, “GBBR” for a bid-based regression, or “H” for a historical price.

Spec Bk Year is available to indicate in Trnseport the year of the specification book that is to
govern the administration of the particular contract. The default value is 04.

Spec Book The general rules covering acceptable work and practices for contracts with an
SHA.

Spec Year See Pay Item Year. A default value of 00 has been set. Because Trnseport contains
projects designed at different times, you cannot change the reference information about each
item (such as description and unit). Doing so would change the meaning of projects already in
progress. Instead, you can create entirely new reference item lists when necessary. You can
distinguish these lists by a specification year. This field identifies the specification year item list
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used on the project. You are not required to, but you can enter information in these fields to
record additional information about a proposal.

Special Provision Code A unique identifier for a special provision. Not in use by the
Department.

Special Provision Description A short description of the special provision. Not in use by
the Department.

Special Provision Text File Name A field that identifies the library member of which the
special provision is a part. Not in use by the Department.

Special Provision Type A coded value indicating the type of special provision. Not in use by
the Department.

Special Provisions An addition or revision to the standard and supplemental specifications
covering conditions specific to an individual project. This feature is not now in use by the
Department. Flag used to tell Trnseport if you will assign special provisions to this proposal that
are print with the proposal schedule. The default value is N (you have assigned no special
provisions).

Special Start Date Available to indicate to bidders cases where a special start date will be
established.

Specialty Iltem Flag Indicates whether an item is a specialty item.

Specification Number A classification number for types of construction items as used in the
Specification Book.

Specification Year Because Trnseport contains projects designed at different times, you
cannot change the reference information about each item (such as description and unit). Doing
so would change the meaning of projects already in progress. Instead, you can create entirely
new reference item lists when necessary. See Pay Item Year for FDOT use of this field.

Specified Completion Date The projected date when the contractor will complete work for a
given site. Maintenance Contracts should indicate the contract completion date in this field, for
example June 30, 2005.

Specified Start Date The project date when the contractor will start work on a given site.
Maintenance Contracts should indicate the contract start date in this field, for example July 1,
2004.

State Mat Flag (State Furnished) The default value for this field is "N". You may have a
few non-biddable items that by all logic seem to belong grouped together with the biddable
items. You could create an artificial, non-biddable project for those items, but Trns*port allows
you to enter them in the logical place, and flag them by placing a "Y" in this field. Non-Bid items
will not appear in any bid documents, and will not be passed to SiteManager. A common use
for this field is to identify FHP use on a project.

State of Incorporation A coded value indicating the state in which the vendor company is
incorporated.
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State, Zip The two-letter state code and zip code for the district’s address.

Status A value (which must appear in the PRISTAT code table) used to indicate the status of a
project (for example, in design or ready to let) or left blank. Trnseport includes this field on
some reports, but does not use it elsewhere.

Status Date The date you entered the status.
Status of Bid A coded value indicating the status of the vendor's bid.

Status of Letting A coded value indicating the status of the letting (for example, planned,
scheduled, or postponed).

Stockpile A quantified amount of a material delivered to the contract site for use in a specific
item.

Stockpile Change Adding new material to a stockpile or removing material already in the
stockpile for placement in a regular/structure/sewer item.

Strong Delete The third level of deleting. Deletes multiple records from more than one file, so
you should see three Delete Warning windows. For example, if you are deleting a bid-letting
package, Strong Delete will delete the letting call, bids, planholders, the proposal and the
projects, items and funds (the whole tree of data). (See also Delete and Power Delete)

Structure Work Class Used by the Work Class percentage report to classify proposals into
bidding pre-qualification areas. Select a value from the attached CFEDWCLS code table.

Structure Work Type Similar to the Federal Work Category except that the FEDSUPP Code
Table is used.

Subcontract A subcontract in Trnseport describes the contract work that the prime contractor
will not perform. You may divide subcontracts into items and define subcontracted quantities.

Each subcontract item can have a partial item percentage applied to it, which indicates that the

subcontractor will perform only part of the item work.

Subcontractor An individual, firm or corporation to which the contractor sublets part of the
contract.

Subcontractor An individual, firm, or corporation to which the contractor sublets part of the
contract.

Subcontractor Payment Money paid by the contractor who holds a contract with the
Department to a vendor that might be the subject of a DBE commitment for the contract.

Supplemental Agreement A written agreement between the contracting authority and the
contractor that you execute on the prescribed form and get approved as required by law. The
supplemental agreement covers extra work, alterations, or adjustments as provided for within the
scope of the contract. The extra work or change order constitutes a modification of the contract
as originally executed and approved.

Supplemental Description 2 An additional 40 characters used for item descriptions.

Supplemental Description Used only for miscellaneous items. Not in use by the Department
at this time.
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Supplemental Item year Can be used by the agency to denote a supplemental item year in
addition to the primary item year. Trnseport does not use this field in any processing

Supplemental Proposal Description Additional project-specific descriptive information for
a project item.

Supplemental Specification Year has been renamed to Specification Book Year and is
available for projects and proposals as necessary.

Supplementary Work Code Similar to the Federal Work Category except that Trnseport uses
the FEDSUPP code table. A coded value indicating the type of federal work performed in a
category.

Supplier Only Flag Indicates that a vendor might be a supplier of materials only.

Surety Agent ID Trnseport treats surety agents as vendors for information storage. This field
holds the vendor code of the surety agent for this bid. The value entered here must appear in the
VENDOR file.

Surety Company ID Trnseport treats surety companies as vendors for storing information in
Trnseport. This field holds the vendor code of the surety company for this bid. The value
entered here must appear in the VENDOR file.

Text Box A dialog box component that accepts input you type in or copy from another file.

Time Charge Number of days worked on a particular site. Used to track contractor work time
and assess liquidated damages, if necessary.

Time Extension A modification (usually an increase) in the time a contractor can work on a
contract without incurring a penalty.

Time Method See Type of Days.
Time of Letting The time a letting will be held.
Title of Officer The title of a vendor officer.

Trnseport AASHTO's information system for managing transportation programs. A
computerized system through which a SHA can manage construction projects. Modules include
Trnseport CES, Trnseport PES, Trnseport LAS, Trnseport CAS, and Trnseport BAMS/DSS.

Type of Action The type of action (add, change or delete) to be performed by an addendum
item.

Type of Bid Received A coded value indicating the type of bid.

Type of Corporation A coded value indicating the type of business structure used by a
vendor.

Type of Days A coded value indicating whether Trnseport should base contract time on
available working days, calendar days, or a completion date. Maintenance contracts should
indicate Completion Date in this field.

Type of Item (Materials) A coded value (which must appear in the ITEMTYP code table)
identifying the material type of the item.
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Type of Line Indicates whether the proposal line is at the item (L), section (S), or proposal (P)
level.

Type of Road This field is entered from the FM system. If it is in error, see the Work Program
office to have it corrected.

Type of Vendor A coded value indicating the type of vendor.

Type of Vendor Certification A coded value indicating the type of work a vendor is
authorized to perform.

Type of Work Classification A coded value (which must appear in the VWRKCLS code
table) indicating the classification of work the vendor is qualified to perform.

Uncompleted Work The amount of work, in dollars, a vendor has outstanding.

Unit Bid Price The bidder's unit price for a line item in the proposal. Trnseport requires this
field if the Type of Line is L at the item level. Trnseport uses this field in production and
Trnseport BAMS/DSS models use it.

Unit Description The description to appear on the unit-level funding summary report for a
given unit number.

Unit Number A unique identifier for a unit. You may put whatever values you like in this
field. Unit numbers provide a way to group categories for reporting purposes on the Funding
Summary and Funding Summary by Unit reports in the Detailed Estimate. If you do not assign a
unit number, the unit number will appear as 000 on the Funding Summary report. When you
assign a unit number and project-level funding, be sure to assign a unit number to all categories,
not just the 0000 category (project-level funds). Not in use at this time. The default value is
000. Do not change this value.

Unit of Measure A coded value (which must appear in the UNITS code table) indicating the
type of measurement used to determine one unit for lump sum items.

Unit See Unit of Measure.

Unit System This field indicates whether a project will contain items designated as English
(E), metric (M), or neither (N).

Units for Lump Sum Items A coded value indicating the type of measure for the item
associated with the adjustment index.

Urban/Rural Class A value selected from the URBRUR code table that indicates whether the
project classification is rural or urban.

User Name The name by which Trnseport knows you.

User Permission A user's right to view and edit the information in a project file. Each file can
have one or more people listed as users for that file. User permission differs from owner
permission in that someone with user permission cannot view or edit the project user list for the
file.

Valid for Bidding Flag Indicates whether a planholder purchased a valid-for-bidding proposal.
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Vendor Address The vendor's address.

Vendor City The vendor's city.

Vendor Name (Long) The vendor name (long description).
Vendor Name (Short) The vendor name (short description).
Vendor Number A unique identifier for a vendor.

Vendor Officer The name of an officer for a vendor.
Vendor Phone Number The vendor's phone number.
Vendor State The vendor's state address.

Vendor Trnseport uses the Vendor file to maintain information about contractors,
subcontractors, suppliers, surety companies, surety agents, and escrow agents. You can also use
it to store information about counties (or other municipalities) and utilities that perform relevant
work. Trnseport uses information about these vendors, their affiliations, officers, addresses, and
facilities in numerous Trnseport processes.

Vendor ZIP Code The vendor's zip code.

Viewer Permission A user's right to look at the information in a project file. Each file has one
or more people listed as viewers for that file. Trnseport automatically allows whoever creates a
file to look at the file because Trnseport gives that person owner permission. The owner of a file
can also give other users viewer permission for that file.

Voucher A Trnseport voucher describes a contractor progress payment for a specific project.
Trnseport computes voucher information automatically and accounts for partial item quantities
performed, material allowances, retainage and liquidated damages. You can make other
payment adjustments manually to cover unusual circumstances. Trnseport maintains a complete
audit trail of all voucher related information, which allows Trnseport to regenerate previously
paid vouchers for review.

WBE Goal (PCT) A percentage amount indicating the goal that has been set for women
business enterprises for the proposal.

WBE Goal The dollar amount the prime contractor has actually paid to date to WBE
subcontractors and suppliers.

WBE Woman Owned Business Enterprise.

Wild Card A character that can substitute for other characters. You can use a * or ? in the Filter
window's Value field with the Like operator.

Work Mix This field is entered from the FM system. If it is in error, see the Work Program
office to have it corrected.

Work Type Code A coded value indicating the type of work a vendor is qualified to perform.
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Appendix B Control Group

The assignment of Access Control Groups is one of the principal tools available to the
Department to control access to project data. Through the plan outlined here, a hierarchy can be
established where data may be compartmentalized to restrict access to a set of people who need

visibility of a particular project and to deny visibility to those who don’t.

The use of Control Groups satisfies two concerns. The first is to reduce the volume of
information that will appear on Project List screens, and second to secure information during the
bidding and award process. The use of Control Groups allows the visibility of projects to be
moved from one person to another. An example would be a project in District 2 that might have
a Control Group of MD0296. With this Control Group assigned to the project, the District
Estimator(s), having a personal Access Control Group of MD02*, would always have visibility
of the project. Similarly, any person having an Access Control Group that is less restrictive
would also be able to see the project on his or her project list screen. For example, a user with an
Access Control Group of M* would have access to every project in the Maintenance

organization statewide.

The following table illustrates how visibility of projects to a community (Maintenance or
Production) for oversight is granted, and then to a smaller group of project or maintenance staff

for the control and management of project detail.

PES LAS
District Contracts Manager PLHH* L HH*
District Contracts Assistant A PLHEA* FLHHA*
District Contracts Assistant B 2L##B* 2L##B*
District Maintenance Engineer MD##* None
Assistant District Maintenance Engineer A MD##A* None
District Maintenance Contract Estimator MD##* MD##*
Assistant District Maintenance Contract Estimator MD##A* MD##A*
District Work Program Manager 2D#H#* None
Central Maintenance Manager M* None
Central Estimator cC* CcC*
Central Office Production Manager CcCc* None
Central Office Contracts Manager CT* CT*
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Control Group Structure:
Character position 1: M = Maintenance Project
C = Construction Project

Other characters may be assigned if desired to segment project development to other specialty
areas.

Character position 2: D = District Office processing
C = Central Office processing
T = Central Contracts Administration Office

L = District Contracts Administration Office

Character positions 3 & 4. District Number

Character position 5: The letters T, U, V, W, X, Y, and Z are reserved for Central Office and
statewide use. When a consultant firm is the designer of a project, the last four characters of the
control group will identify the consultant firm. The letters T, U, V, W, X, and Y identify
consultant firms.

A project created in the Central Office could be assigned an office code.

Character positions 6/7/8:  Organizational or subordinate breakout where desired. For
consultant firms, these three characters, in conjunction with a letter
in character position 5, identify the firm.

For those projects let through the DCP system today, Central Office staff would rarely require
access to them for control or change purposes, but may have visibility of them depending on the
Control Group structure finally developed.

The Control Group feature is a very important tool, but it has limitations:

e Itis not a code table and, therefore, will require a thorough understanding of the structure by
Application Managers and Security Coordinators.

e Control Group is not available to Letting Headers.

e When transferring a project or proposal to another user, care must be taken to ensure that all
letters in the new Control Group are capitalized, and that a valid Control Group has been
used. If these precautions are not taken, a project or proposal will be removed from the
project or proposal list screen of the previous user and will be available to no one. Under this
circumstance, a user with high-level authority such as a Security Coordinator or Application
Manager will have to find the errant project or proposal and assign a valid Control Group to
it.
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Control Group Life Cycle
A Control Group assigned to a project/proposal might evolve in the following manner:

Maintenance Contract

Receive Maintenance Project from FM MD##

District reassigns project internally MD##A (or other subset)
Create Proposal Header MD##A

Pass to Contracts Administration Office ML##

Contracts Administration Office activity ML## (or subset if desired)
Pass to "estimator” for Bid Analysis MD## (or other person)

Return record to Contracts Administration Office =~ ML##

Complete award and execute phases ML##
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Appendix C Filtering and Sorting

The Trnseport Filter

A filter provides the user with a means to limit the list of records appearing in a window. The
Filter Function is available on most LAS and PES screens. It is especially helpful in limiting an
item List. Use the filter to enter selection criteria on one or more fields applicable to the active
window.

PES and LAS are set up to support both upper and lower case characters. Fields that are
populated from the Department mainframe will be in uppercase because the mainframe stores
everything in uppercase. For instance, the Item Description is in uppercase, so when filtering on
the Short Description field, look for all uppercase characters. All code values are stored in
uppercase. When filtering on a code-based field, search for uppercase letters. Other fields, such
as the second line of the Location field on the Project Header record, can have both upper and
lower case letters in them. Be aware of

the case of a field when performing a

fllter File Edit “iew LUilties ‘wWindow Help
iBlalsl & v | 2lelmmEe|s|
To use the Trnseport filter: M Projccts _

e Click the icon that looks lik ren: proectpe
Click the Icon that looks like a 1111111 4912007P BRIDGE # 780073
funnel. T4 12345FRAN M TEST

1234FRAN A TEST
123FRAN NIfA TEST
19016913201 19016913201 STATEWIDE BRID(
19074915201 19074915201 NORTHERN TURN,
19074915209 19074915209 GUARDRAIL UPGR
19281427201 19281427201 MECHANICAL SWE
19289017201 19289017201 EMERGENCY RES
19289017202 19289017202 EMERGENCY RES
19363715201 19363715201 STATEWIDE
19363815201 19363815201 STATWIDE - DESIG
19364215201 19364215201 STATEWIDE DESIG
19418915201 19418915201 SR 29 ATF
19792415201 19792415201 SR72 FRO
20133315201 A POLK PARKWNAY
21019815201 21019815201 VILAND BCH. BRIC
010821457200 2101082145200 BEICGEE 2t w0 T2
. . iz Filter
e This screen will appear. Vihere
Column: Operator: Value:

OK I Cancel | n_mranced...l Show Al |

The list box labeled Column will list all of the fields that are available for the search. The
Operator list box contains the relationships that are available between the field that chosen in the
Column list box and the entry in the Value box. The Value contains a literal that is being
compared to the field in the Column box.

Click the Column, Operator, and Value fields to display lists of values from which to choose the
information to be filtered.
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Column The Column field contains the names of the most commonly used columns
in the table from which the list window is built. When you click the down
arrow in the column field, the list of columns to choose from will appear.
Select the column you desire.

Operator The Operator field contains the operators equal to (=), greater than (>), less
than (<), greater than or equal to (>=), less than or equal to (<=), not equal
to (<>), and Contains and Does Not (contain) to narrow the filter. Select
the operator you desire.

Value The information you type in the Value field is the filter criterion to match.

This illustrates a filter on the Projects List

Filter [ %]
window, set to select on the Federal/State Where
. . Column: Operator: Value:
Project Number column, with the operator [Federastate Projesthumi] | |- e

selected as =, and the Value set for N/A.
This value will select Maintenance
projects in this example.

0K I Cancel | n_d\ranced...l Show All |

The resulting Projects List window b
appears. 1l|elcls B vl t 2|
If the selection results in a blank window, | EEHE—
click the Filter button again, and then ik TesT
. B o 123FRAN MIA TEST
click Show All. This will restore the
complete window list, and try again with
different criteria in the operator field or a
different value.
The Advanced Filter
You may also filter information using a Name: | g
more complex set of criteria. Click the - Build Where Condition
. Column: Operator: Value:
Advanced button and Trnseport displays [ | | d ozl accent |
th.e Advanced Filter window. ThIS  selectmere
window allows you to use multiple o Column | anr ‘
. . . . . (- Name Operator Value(s) )- or
combinations of conditions to filter with
various operators, values, and logical
combinations.
Use the Advanced Filter window to build a et | R | [kt |
set of conditions for Trnseport to use to auply | [Save | Delete | Close | tew |

filter information. This set of conditions
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consists of a series of “where conditions” combined with logical options, such as And/Or, (+ and
(- Create each where condition by choosing a value in each of the Column, Operator, and Value
fields and then clicking the ACCEPT button.

Column The Column field contains the names of all the columns in the table from which
the list window is built. When you click the down arrow in the column field, the
list of columns to choose from will appear.

Operator The Operator field contains all the operators found in the basic filter plus Like and
Not Like, operators used for pattern matching.

Value The information you type in the Value field is the filter criterion you are using as
a delimiter or are trying to match.

Use "*" as a wild card to match any value or "?" to match a single character only with the LIKE
or NOT LIKE operators. To search for a value that contains the characters "*" or "?", use the
backslash character (\) just before the "*" or "?". For example, Quantity \* item would search for
Quantity * item. To search for the "\" character, put a backslash in front of the "\"; for example,
use \\job to search for \job.

Trnseport displays each where condition in the Select Where area of the Advanced Filter window
in the order in which you create them. After all of the where conditions you need for the filter
are listed, combine them into a “where clause” by clicking in the And/Or column to the right of
each condition line and selecting the appropriate option from the menu for each line. Typically,
all lines requiring Or should be combined before the lines requiring And. Use the logical options
(+ and (- to override the And/Or combinations where necessary.

To add the first row:

e Click or enter values for the Column, Operator, and Value fields at the top of the

screen.
i = Advanced Filter
e Click the Accept button.
Name: |CTIettingS |
To add another row,
i — Build Where Condition
e Click the Add Row button’ Column: Operator: alue:
Bid Letting Number j IContainsj H|CT? n_cceptl
e Click the row just added. eloctwhers
. . + *
e Click or enter values in the t]  Name |operator value(s) » | ‘or
COIUmn, Operator, and Values Bid Letting Mumber Contains |CT?
fields.
e Click the Accept button.
insert Row | adRow | Detete Row |
Add parenthesis as needed and choose aay | [Sove | vetete | ciose | teip |

either And or Or as appropriate.

Reference Manual for Maintenance Projects PES Release 5.7b Page 112 of 117



To save a filter:
e Enter a name in the Name field.
e Click the Save button.

The filter will be available for future use.

L2 Trns: port LAS

Fle Edt Yew Utities Window Hslp

This example is Bid Letting Number; [ixmas | & | ve |t @a
Contains; CT?. This filter is named CT e
- CTO21024 10024002 10:30 A M SCHD
Lettlngs. CT021030 103002 10:30AM SCHD
CT021204 120402 10:30AM SCHD
. CT030129 01/2903 1030 AM SCHD
CTO30226 0226003 1030 AM SCHD
e Click the save button to save the
- CTO30430 0430003 10:30AM SCHD
fl Iter CT030521 05/21103 10:30 AM SCHD
CTO30618 061803 1030 AM SCHD
CT030730 0730003 1030 AM SCHD
- CT030827 0827103 10:30AM SCHD
[ ] CIle APPLY CT030924 092403 10:30AM SCHD
CT030830 0973003 10:30 AM SCHD
. . CT031029 1029103 1030 AM SCHD
h I f h d d f I CT031203 12/03103 1030 AM SCHD
The results of this advanced filter appear. e
CT040225 022504 10:30AM SCHD
CcT040331 03731504 10:30AM SCHD
CT0403822 09/22104 10:00AR SCHD
CTTEST 112503 200PM SCHD
Reuse a filter.

This and other advanced filters may be re-used by:
o Click the Filter Icon.
e Click the ADVANCED button.
o Click the down arrow in the Name field.

e Click the name of the filter.

s ClickappLy.
1 ' N . I—L,
To build a filter that selects on Name: |03 Maintenance

- . . . . —Build Where Condition
Maintenance Projects in District 3, follow | cotumn: S Value:
these steps: [Contains o] 2][i accet

. . —Select Where
e Create the first where condition by B Cotumn ‘ | anar ‘
(- Name Operator Value(s) J- or

selecting values in each field

e Click the ACCEPT button.

Insert Row | AddRow | [[Deleterow |

appty | | Save | petete | | close | e |
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The information will be moved to the

.
lower section as row one, and you may Mame: |03 Maitenance 7|
select And/Or. In this case select And. [ Eualaimere Conition :
Column: Operator: Value:
IAccess Cantral Group j IComains j HIM* n_cceptl
. —Select Where
e Click the ADD ROW button. G Conmn ™S
(- : Name Operator Value(s) - or

Control Group  |Contains  |M*

e Highlight the new row.

Qr
This makes the Build Where Condition -
window active for the new row.

Insert Row | AddRow |  Delete Row |

appty | [ save | Detete | close | Hew |

e Create the second where condition
Name: |D3 Maintenance vl
a‘S ShOWﬂ here — Build Where Condition
. Column: Operator: Value:

° C“Ck the ACCEPT button. IDistrictNumber j |= j HIDB n_cceptl

Name the filter you have built. In this - Select Where
. . I Column | andi

example, the name given is D3 C Name Operator Value(s) » | or
Maintenance. The name can be up to 30 T T -
characters long. Now that the filter is
complete, click the SAVE button to save
this filter so that you may reuse it in the wsortRow | _aidRow | _psiseRow |
future. -‘\lmhf| Save I DE!etE| QI089| Help |

Click the APPLY button to see the results - -
of this two-condition filter on the Projects | & i v wiiies widon beb

List window, where it was built. LBlals| B viel tf 2lelEwE el
’

If the filter doesn’t work the first time,

ESCAMBIA SANTA ROSAPA

reopen the advanced filter, click the name | 5.zcqn
. . 22467117201 22467117200 BAY, GULF & CALHOUN TR
window to select and reopen the filter, 247517201 22475117201 GADEDEN, LEON &JEFFPA
. - 23516117201 22516117201 ORALOOSA & WALTON COF

and adJUSt condition statements that may 22517517201 22517517201 GADSDEM GOUNTY  FEN
. 22527617201 22527617201 SRE(-0  JACKSON G

be causing the prOblem. You may alwayS REFORTS004 WCTESTO04 TRAFFIC OPERATIONS WO
WCTESTO04 WCTESTOO4 TRAFFIC OPERATIONS WO

restore a full list by clicking on Show All
at the regular filter.

To use the filter again, select the filter
name from the list box.

To remove the saved filter from the database, Click DELETE.
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Sorting Information Sort

To sort information in a list window, click the
Sort button. It is located to the right of the Filter
button. Trnseport displays the Sort window.

4

(®) Asc  {_)Desc

The Column field contains the names of all

columns in the table that are used to build the list e o e e |
window. When you click the down arrow in the — - — —
column field, the list of columns to choose from will appear.

Click Asc or Desc to select an ascending (A-Z) or descending (Z-A) sort order for the selected
column. When values containing both numbers and letters are listed in ascending order, numbers
precede letters, and vice-versa for descending order.

In this example, Son
H - Column
e Click the Federal/State Project Number. H@ase  Cobese

o Click APPLY.

If you Click CANCEL, Trnseport returns to the
list window without sorting the list window.

Apphy Cancell Add | [nsertl geletel Help |

Trns=port sorts the rows in the order you

specified. The results may be seen here. Fle Edt View Udies Windom Heip |
) ) 1xBalz B vl ] 2 eHmmmEes)
Note that as in the Advanced Filter
functions, the Sort functions may also be .
- 21860815201 K SR10A (USG9
made complex. You may sort on different | Zi7zs015201 - SR77 (NOR
: s oG 23210015201 g PALM BEACH
fields and establishing a sort order. You 11 111 Karen's prajol
may add Sort Crlterla by CIICkIng the ADD 19016913201 19016913201 STATEWlDEE
190745915201 190749145201 MNORTHERM
button to add a row, and so forth. 19074915209 19074915209 GUARDRAIL |
19281427201 19281427201 MECGHAMICAL
If you Click INSERT, Trnseport inserts [ 12 el
1 1 19289017201 19289017201 EMERGERCY
another row for sort criteria before the e jcssadibd NN
Currenﬂy selected row. If you Click 19289017202 19289017202 EMERGENCY
MO1D 19289017202 EMERGEMCY
DELETE, Trnseport deletes the currently 19363715201 18363715201 STATEWIDE
. - 19364215201 19364215201 STATEWIDE [
selected row of sort criteria. 19418915201 18418915201 SR 29
19792515201 19792515201 SRT2

If you Click HELP, Trnseport displays a E— —
help window with information about sorting a list window.

One difference with Sort is that it must be set up each time you wish to use it. There is no
naming or saving feature associated with it.
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Appendix D

Printing and Saving with Citrix MetaFrame

Use of the Citrix MetaFrame Web Interface for CiTRIC
. . MetaFrame' Presentation Server .
server, requires certain setup
i i - ) Welcome
for you to save the reports to Popleatont e S e
the PC and for_printing them to o o o ?h'é“m‘tié’li“ .:‘rﬁ:"tr"?,t”wppl‘tﬁ
the network printer. e e
To set up access to the PC, e 2
Log|-n to any Trns.port ﬁ @ ugh the layout is different, the page will continue 1o hnction as belore.
application. Access the task oA -
bar on the PC. As seen at the
right. oot
e Click the "ICA 3
- " e (mll 8 K Lo ot
Connections ] © e e [T gt - B s | BBa® w2
lcon.
& O . .
&;’J CEREREUE Y ou will see that it near the clock.
§ Program Neighborhood Connection Center — |EI |i| . .
_ When you Click the ICA Icon, you will see the
ey I || 1cA connection center as seen at the left
=- Active -
g—% DOTSCOTSO1E Lo
Tl ASHTO Sitehd -\\Remote, 12 : ;
] DFS Stotus Monior \\Remate, 1254 [ Fieeen | e Click the Security button.
g Trngport LAS - \MWRemote, 128-bit 5501 Fraperties |
Trngport PES - Y\Remote, 128-bit 551
Lagaff | -
IC# Client File Security x|
Security | —
— Application Eg:lr\;ﬁé:::mi?tion iz trying to access wour
4 | _’I Tleminate |
what access should be allowed?

1 Server uzed, 4 Remote Applications

Help

" Nohccess

i

The ICA Client File Security window will open.

e In the upper box Click FuLL ACCESS
e |n the lower box Click NEVER ASK ME AGAIN FOR

ANY APPLICATION.
e Click OK.

Do you want to be asked again?

" Always ask me once per connection

+ Mever ask me again for any application

Cancel |

o]

With this choice you may access the A drive or the C drive for any Trnseport application you

work in.

e Click OK on the ICA Connections window to complete the setup and close the ICA

connection center.
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You are now ready to save a BT —— 2l

re p o rt fro m T r n S. pO rt " - ‘MbLhN’l'.. it Illl‘ﬂll:-.'ﬂ LCAHOLDA

In the Processes List window — | 7S ]SS (U

';l e TN FROPOSAL PLNIEUI!;’;"U;; AL ;‘i::wri ;I
open a report and it will appear |, . _ e

similar to the one seen here. o sorei G g, TR I

ool Tilol Executed SRUZ(NLE DLVD) B
19564615200

e Click either the Save As sl

LUSAAALERDT

Text, or Save As Rich (v e e commucrns, um.

7775 EAYMEADONS WAY, SOTTE 200 S04-739-7600
T t b tt JACKIONVILLE no 2% FAX B04-738-7801
ext putton. (*) an vt mmosmars, ¢,
510 GENE GREEN ROAD 1941) 4363600
MORONTE P 34275-3524
(Y AFAC-SOUTREAST, 1nC]
14£1 MVITLE ETREET 1404 351-£301
SARASOTA PL 34234
Ty PIOENDY. CONSTRUCTION SERVICES, INC.
1005 TEMNESSEE AVENUE B50-265-4210
LYNN EAVEN 32448 FAX 850-265-4731
(&S] ANDERION COLUMHIA CO., INC.
2 GUERDON ROAD WE-T52-1505
LAKE CITY FL 3208 FAOX 30E-75E-58E3 =
LI | o

Dane Priet... SmufsToa | Save s fch Ten |

Save File As Text
Save_\n:l@,M_\JCumpulel j P g FE-
H n N - 1] N1 1= &4 on 'Client' (A1) 2¢O _Expedite_Sys on ‘Dot
e DbIClick C$ on 'Client (V) |08l Server (C:) =C i)
=2Dell Server (D:)
@Cnmpa(t Disc (E:) Free Spac
1= 5ys on 'dobvcofp00 1 appdatalColknd? L' (O1) Capacity:
Save File As Text I=2Expedite_Sys on 'Dotwcofp001apps' (Q:)
Save_\n:l% C% on 'Client’ [v:] j &= eF B~ 4] | _'I
|1 adobe Albums Clcorel g File name:  [PLANHLOR Open I
D A0L Inskant Messenger D csextras E -
| Jacletras el C St IA” Files ("] =l L
D autoplay3s D Delorme Docs [
|1 autorunfresware [ oocuments and Settings: g - -
" Corvg 1 Clonvers C e DblClick Documents and Settings.
I i
Fil 2 PLANHLDR ]
e I ﬂl Save File As Text
. 3w - Cancel
Save as hpe: IAI\ Files (%] =l &I Sl I ‘55 Documents and Settings j . &5 B3~
Al Users
kna7 1w

e DbIClick the Userid or Name, depending on how
your PC is set up.

File name: FLANHLDFR Open
Save File s Rich Text | Gren |
= : 5 type: tE - Cancel
Save jn: I 3 William Cariror j = eF B~ S EB LR IA” Files [*.%] Ea| |
[ start Menu nkuser

DTempDrary Inkernet Files PLANHLDR.

DUserData Dluginlaljz.trace o DbICIiCk My Documents

CIwInDows Q3.DIR
NENES; Adobetveb

Clpniinks INSTALL

< | Save File As Rich Text

Filename:  [FLANHLDR Open | Saven: | FDOT =] « @ ek FE-

Save as lype: IAI\ Files %% ;I Cancel | |_JansHTOpUES [ 7rainingManualsoid Iscope change FY
|_JDBE-CFR. [C17UG 2003
|_1Dacs on the web [ Userguides2003061TT

D MinorityProgsData D UserGuideshew

You should now recognize the directory Structure On YOUr | aromtives  Cliercoiioon

PC. When you reach the folder you seek, DIT’Ei"i"gM‘“”a"’”ew | .

e Click the OPEN button to save the file. Flepame: [FLANHLDR __Deen |
Save a3 lvpe: IAI\FiIes[“] LI Cancel |
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